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Notice
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products or their manufacturers.
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User Manual
Safety Compliance

Electromagnetic Compatibility

This equipment complies with:

• CSA C22.2 No. 60950-1-07 Safety of Information Technology Equipment

• UL 60950-1 (2nd Edition) Safety of Information Technology Equipment

• IEC 60950-1 (2ndEdition) Safety of Information Technology Equipment

• K60065 Audio, video and similar electronic apparatus - Safety requirements

The power cord supplied with this equipment meets the appropriate national 
standards for the country of destination.

WARNING: An appropriately listed/certified mains power supply cord must be used 
for the connection of the equipment to the mains voltage at either 120V~ 
or 240V~.

CAUTION: These servicing instructions are for use by qualified personnel only. 
To reduce the risk of electric shock, do not perform any servicing other than that 
contained in the operating instructions unless you are qualified to do so. Refer all 
servicing to qualified service personnel.

This equipment has been tested for verification of compliance with FCC Part 15, 
Subpart B requirements for Class A digital devices.

NOTE: This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his own expense.
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Important Safeguards and Notices
This section provides important safety guidelines for operators and service personnel. Specific 
warnings and cautions appear throughout the manual where they apply. Please read and follow 
this important information, especially those instructions related to the risk of electric shock or 
injury to persons.

Restriction on Hazardous Substances (RoHS)
Miranda is in compliance with EU Directive RoHS 2002/95/EC governing the restricted use of 
certain hazardous substances and materials in products and in our manufacturing processes.

Miranda has a substantial program in place for RoHS compliance that includes significant invest-
ment in our manufacturing process, and a migration of Miranda product electronic components 
and structural materials to RoHS compliance.

It is our objective at Miranda to maintain compliance with all relevant environmental and 
product regulatory requirements. Detailed information on specific products or on the RoHS 
program at Miranda is available from Miranda Customer Support.

This equipment has been tested and found to comply with the requirements of the 
EMC directive 2004/108/CE:
• EN 55022 Conducted emissions, Class A
• EN 55022 Radiated emissions, Class A
• EN 61000-3-2 Harmonic current emission limits
• EN 61000-3-3 Voltage fluctuation and flicker limitations
• EN 61000-4-2 Electrostatic discharge immunity
• EN 61000-4-3 Radiated electromagnetic field immunity - RF
• EN 61000-4-4 EFT immunity
• EN 61000-4-5 Surge immunity
• EN 61000-4-6 Conducted immunity
• EN 61000-4-11 Voltage dips, short-interruption and voltage variation immunity

• K00022
• K00024

WARNING 

Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk 
of electric shock, do not perform any service other than that contained in 
the operating instructions unless you are qualified to do so.
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Disposal and Recycling Information
Your Miranda equipment comes with at least one lithium button battery (Li-MnO2) located on 
the main printed circuit board. The batteries are used for backup and should not need to be 
replaced during the lifetime of the equipment.

Before disposing of your Miranda equipment, please remove the battery as follows:
1  Make sure the equipment is unplugged from the power source.

2  Remove the protective cover from your equipment.

3  Gently remove the battery from its casing, using a blunt instrument such as a screwdriver for 
leverage if necessary.

4  Dispose of the battery and equipment according to your local environmental laws and 
guidelines.

For more information about recycling, please contact Miranda Technologies.

WARNING: Be careful not to short-circuit the batteries by adhering to the appropriate safe 
handling practices. Do not dispose of batteries in a fire as they may explode. 
Batteries may explode if damaged or overheated. Do not dispose of batteries 
as household waste. Do not dismantle, open or shred batteries. Keep batteries 
out of the reach of children. In the event of a bettery leak, do not allow battery 
liquid to come into contact with skin or eyes. Seek medical help immediately 
in case of ingestion, inhalation, skin or eye contact, or suspected exposure to 
the contents of an opened battery.
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General Warnings
A warning indicates a possible hazard to personnel which may cause injury or death. Observe 
the following general warnings when using or working on this equipment:

• Heed all warnings on the unit and in the operating instructions.

• Do not use this equipment in or near water.

• This equipment is grounded through the grounding conductor of the power cord. To avoid 
electrical shock, plug the power cord into a properly wired receptacle before connecting the 
equipment inputs or outputs.

• Route power cords and other cables so they are not likely to be damaged.

• Disconnect power before cleaning the equipment. Do not use liquid or aerosol cleaners; use 
only a damp cloth.

• Dangerous voltages may exist at several points in this equipment. To avoid injury, do not 
touch exposed connections and components while power is on.

• Do not wear rings or wristwatches when troubleshooting high current circuits such as the 
power supplies.

• To avoid fire hazard, use only the specified fuse(s) with the correct type number, voltage and 
current ratings as referenced in the appropriate locations in the service instructions or on 
the equipment. Always refer fuse replacements to qualified service personnel.

• There are no user-serviceable fuses in this equipment. Connection to the mains supply 
should be via a circuit breaker or by a mains plug which meets the relevant local standards in 
the country of installation.

• To avoid explosion, do not operate this equipment in an explosive atmosphere.

• Have qualified service personnel perform safety checks after any service.

• To avoid electrical shock or fire hazard, do not operate the equipment with its covers 
removed.

• To prevent equipment from overheating, provide proper ventilation.

General Cautions
A caution indicates a possible hazard to equipment that could result in equipment damage. 
Observe the following cautions when operating or working on this equipment:

• When installing this equipment, do not attach the power cord to building surfaces.

• To prevent damage to equipment when replacing fuses, locate and correct the problem that 
caused the fuse to blow before re-applying power.

• Use only the specified replacement parts.

• Follow static precautions at all times when handling this equipment.

• This product should only be powered as described in the manual. To prevent equipment 
damage, select the proper line voltage on the power supply(ies) as described in the installa-
tion documentation.

• To prevent damage to the equipment, read the instructions in the equipment manual for 
proper input voltage range selection.
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Symbols and Their Meanings

The lightning flash with arrowhead symbol within an equilateral triangle alerts the 
user to the presence of dangerous voltages within the product’s enclosure that 
may be of sufficient magnitude to constitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle alerts the user to the presence 
of important operating and maintenance/service instructions.

The ground symbol represents a protective grounding terminal. Such a terminal 
must be connected to earth ground prior to making any other connections to the 
equipment.

The fuse symbol indicates that the fuse referenced in the text must be replaced 
with one having the ratings indicated.

The presence of this symbol in or on Miranda equipment means that it has been 
designed, tested and certified as complying with applicable Underwriter’s Labora-
tory (USA) regulations and recommendations.

The presence of this symbol in or on Miranda equipment means that it has been 
designed, tested and certified as essentially complying with all applicable Euro-
pean Union (CE) regulations and recommendations.

When shipped into member countries of the European Community, this equipment 
is accompanied by authentic copies of original Declarations of Conformance on file 
in Miranda Technologies Inc. offices in Montreal, Canada.
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Chapter Structure 
This guide provides installation guidelines for Miranda’s Imagestore 750 systems. It includes the 
following chapters: 

• Chapter 1, Preface (this chapter) outlines effective ways to use this guide, presents an over-
view of the user manual. 

• Chapter 2, Introduction, is a brief introduction to the Imagestore 750.

• Chapter 3, Applications, describes typical applications of the Imagestore 750.

• Chapter 4, Features, presents important characteristics and functions of the Imagestore 750.

• Chapter 5, Master Control, provides information regarding the Imagestore 750’s master con-
trol option and its use in the iMC master control system.

• Chapter 6, Advanced Audio, provides information about optional Dolby and up-mix mod-
ules, Audio Description (AD), silence detection and audio delays.

• Chapter 7, Control and Monitoring, provides information about controlling the Imagestore 
750 and monitoring its status.

• Chapter 8, Imagestore 750 Configurator, describes the Imagestore 750’s configuration soft-
ware.

• Chapter 9, Web Interface, provides information regarding the Imagestore 750’s web inter-
face.

• Chapter 10, FTP Interface, provides information about transferring media to the Imagestore 
750 via FTP

• Chapter 11, Options, briefly presents the Imagestore 750’s purchase options.

• Chapter 12, Installation, provides information about connecting the Imagestore 750.

• Chapter 13, Specifications, presents a few basic specifications for the Imagestore 750.

• Appendix A, Front Panel Menu, presents a complete list of front panel menu items.

• Appendix B, GPI Event Types, provides a complete list of GPI events.
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Preface
The PDF Document
• Appendix C, Imagestore 750 Hardware Revisions, is a brief statement about Imagestore 750 
versions.

• Appendix D is a Glossary.

• An Index is also provided.

The PDF Document 
This manual is provided in PDF format, allowing you to use Acrobat’s “bookmarks” to navigate to 
any desired location when you are reading it on your computer. You can also easily print a hard-
copy. Please note:

• Use the Table of Contents bookmarks to jump to any desired section. 

• Many hyperlinks are provided within the chapters.

• Use the Index to jump to specific topics within a chapter. Each page number in the index is a 
hyperlink.

• Use Acrobat’s ‘Go to Previous View’ and ‘Return to Next View’ buttons to retrace your com-
plete navigational path. 

• Use the ‘First Page’, ‘Previous Page’, ‘Next Page’, and ‘Last Page’ buttons to go to the first, pre-
vious, next, or last page within a PDF file. 

• Use Acrobat’s extensive search capabilities, such as the ‘Find’ tool and ‘Search’ tool to per-
form comprehensive searches as required. 

Terms, Conventions and Abbreviations 
The following conventions are used throughout this manual: 

• The symbol  denotes a note, an example, a warning, or a special message.

• Entries written in a bold font, in Capital Letters, or enclosed in single quotation marks (‘  ’) 
denote the names of menus, buttons, commands, and knobs: 

Click ‘Apply’ to . . . 

Press Transition to . . .

• Double quotation marks (“  ”) denote colloquial or informal language. Single quotes and dou-
ble quotes do not have the same meaning.

• Entries written in a monospaced font denote pathnames, parts of your file system, or items 
that you must select or enter: 

C:\Program Files\Miranda\Master Control\...    

or
Operate > Clean Output

• The term “MC” is an abbreviation for “master control.” 

• The terms “panel” and “control panel” refer to master control panels, either hardware or soft-
ware. 

Other terms, used occasionally, include the following:

Note To display the Acrobat navigation buttons, right-click the Tool Bar area, and 
check ‘Navigation’.
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• Intuition XG is a single- or dual-channel graphics processor. The term “Intuition XG” can 
encompass all the hardware and software involved in the Intuition XG component of master 
control.

• XMedia is a term that includes different software applications that create and manage 
images, keyers, logos, etc. used by Intuition XG.

• Xplay and the XG Dashboard are software applications under XMedia. Both of these are used 
to configure the Intuition XG processor.

• Oxtel identifies a Miranda automation protocol used by the Imagestore 750.

Scope of the Manual 
This user manual includes all the information required to install, configure, and operate an 
Imagestore 750.

This user manual addresses the Imagestore 750 in three contexts: 

• A non-master control environment, 

• A Presmaster master control environment, 

• An iMC master control environment. 

The manual addresses the Imagestore 750 in a general way and is suitable for all contexts.

Note: Chapter 5, Master Control, describes the Imagestore 750 as it is used in an iMC master 
control environment. 

The serial automation control protocols used by the Imagestore 750 are outside the scope of 
this manual. Details of this protocol and other related topics are found in the documents listed 
under Applicable Publications and Tools, following. 

Applicable Publications and Tools 

Publications
Electronic copies of these documents are available from the Miranda website at 

http://www.miranda.com/support

As an alternative, you may contact Miranda Customer Support to obtain the latest documents. 
The documents and their part numbers (ordering codes) are listed here:

• Automation

Oxtel Series Automation Protocol 01035-16 
Presmaster Automation Protocol 01235-14

• Imagestore 750 

Imagestore 750 User Manual 872-99M00-301 
Imagestore 750 Quick Start Guide 872-54M05-200

• Intuition XG

Intuition XG Installation and Quick Start Guide 
Intuition XG Configuration Guide v.4.50

• NV9000 
3
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Applicable Publications and Tools
NV9000 Quickstart Guide QG0005-xx 
NV9000-SE Utilities Users Guide UG0007-xx

• iMC Master Control 

iMC-Panel-GUI Operators Guide for IS750 UG0053-xx 
iMC-Panel-100 Operators Guide for IS750 UG0069-xx 
iMC-Panel-200 Operators Guide for IS750 UG0054-xx 
iMC-Panel-300 Operators Guide for IS750 UG0055-xx 
iMC-Panel-GUI Operators Guide for MCEs UG0057-xx 
iMC-Panel-100 Operators Guide for MCEs UG0070-xx 
iMC-Panel-200 Operators Guide for MCEs UG0058-xx 
iMC-Panel-300 Operators Guide for MCEs UG0059-xx 
MasterConfig Users Guide UG0061-xx 
MasterDiag Users Guide UG0062-xx 
MasterLogo Users Guide UG0063-xx 
iMC Installation Guide UG0064-xx 
iMC Reference Manual UG0065-xx 
MCS Panel Configuration Editor Users Guide UG0066-xx

• Presmaster

Presmaster User Manual 01232-10 
PresStation User Manual 03251-06 
Presmaster Integration Guide 01234-05

• Tools

Vertigo After Effects1 Plug-in User Manual 4.60 
Text Builder 2 Software User Manual 02760-03 
Media Conversion Software User Manual 01033-14

Software Tools 
Electronic copies of these tools are available from the Miranda website at 

http://www.miranda.com/support   

As an alternative, you may contact Miranda Customer Support to obtain the latest versions of 
these tools: 

• Imagestore 750 Configurator 1.5

• After Effects Plugin 5.60

• Media Conversion Suite

Animation Builder 5.11 
Clock Builder 5.11 
Audio Builder 5.11 
DVE Editor 5.11 
Text Builder (Easytext) 2.08

1. After Effects is a digital motion graphics and compositing software package published by Adobe Sys-
tems. Its main purpose is for film and video post-production.
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Introduction 
Chapter 2 is a brief introduction to the Imagestore 750. 

Topics
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 5
Functional Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 6
Architectural Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 9
Physical Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 11

Overview 
The Imagestore 750 is a master control and branding processor for highly automated specialty 
channels, capable of inserting up to four layers of graphics into HD or SD. The graphics layers 
can be fed by an external graphics device such as an Intuition XG or from internally stored stills 
and animations. The Imagestore 750 also offers character generation and clock insertion. It is 
ideal for downstream banding or master control switching applications.

Its integrated audio engine provides multi-channel mixing and voice-overs. Audio is accepted 
either as embedded SDI or from 16 AES input connectors. The Imagestore 750 provides 16-
channel audio mixing and playout with dynamic shuffling and gain control. Background audio is 
automatically “ducked” during voice-overs. It supports multi-channel audio clip storage and 
playback of up to 16 channels in four audio streams. Playback of stored audio clips is called Easy-
play 2. Advanced audio options include audio description (AD), stereo-to-5.1 up-mixing, and 
Dolby processing with up to 4 Dolby decoders or encoders and sophisticated metadata 
processing. 

An extensive range of options and upgrades are available for the Imagestore 750, including 
video A/B mixing, audio mixing, Emergency Alert System (EAS) and a temperature probe. Its 
high-performance graphics capability includes dual-window 2D DVEs on both program and 
preview outputs. See figures 2-1 and 2-2.

A template-based character generator (called Easytext) can insert crawl layers or static text 
layers that are dynamically updated. High quality characters are output with 256 level anti-
aliasing, with easy control over drop shadows and transparency. Unicode characters in TrueType 
fonts are available from 6 to 600 pixels, in any RGB color.

The Imagestore 750 has a master control option. This option turns the Imagestore 750 into a 
powerful master control switching and branding channel designed for automated, multi-
channel environments. The option provides multi-channel arbitration for multiple panels, 
channel branding (through Intuition XG or internal stores), video and audio switching and a 
robust and scalable control system. The master control option is typically used in conjunction 
with other associated devices such as automation, the NV9000 Router Control System, Intuition 
XG, iMC control panels and monitor walls such as Kaleido-X. Automation drives upstream 
content from video servers and causes the channel to synchronize router switches with appro-
priate video/audio mixing, graphics keying events, DVE moves, audio switches, and so on. The 
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Functional Features
Imagestore 750 transition engine synchronizes the overall transition by driving the NV9000 
Router Control System to make router switches at appropriate times, driving the Intuition XG 
graphics output, and performing its own internal transitions as required. Panel operators may 
use any iMC control panel to acquire ownership of the channel manually to preview channel 
states, override automation, and adjust a number of other channel settings related to transi-
tions, media loading or system configuration.

The Imagestore 750 can be used with the Xmedia Suite’s work order management, graphics 
preparation, asset management, data interfacing and playout automation workflow tools. The 
Xmedia Suite streamlines graphics operations in localized and distributed environments, and 
contributes to lower costs, faster delivery, and greater creativity. 

The Imagestore 750 provides SNMP support for system monitoring and diagnostics, and 
provides configurable alarms and traps.

Functional Features 
This is a summary of the Imagestore 750’s features:

Multi-level Branding Graphics
• High-impact multi-level channel branding.

• Easy selection of video format.

• Four independent keying layers.

• Preview output.

• SD and HD video standards. (SD is 525i or 625i; HD is 720p or 1080i at 50 Hz and 59.94 Hz.)

• Integral flash-based storage for more than 4000 HD or SD images, animations, and text.

Maximum animation playout memory size (2 GB) requires the IS-750-MEM-2GB option.1 

• Dual fill and key inputs that allow operation with an Intuition XG graphics co-processor.

• Emergency Alert System (EAS) crawls and audio messages (in the USA). 

This is available with the IS-750-EAS option. 

• Digital or analog clock insertion with a “bugclock” option. 

This is available with the IS-750-Clock option. 

• “Easytext” template-based, automated character generator option for data-driven graphics, 
such as in-show promos.

This is available with the IS-750-ET option. 

• Temperature probe for dynamic display of temperature in Celsius or Fahrenheit. The probe is 
typically located on or near the studio building. 

This is available with the IS-750-TEMP option. 

• Full compatibility with Vertigo graphics automation and asset management.

1. See Chapter 11 for a complete list of Imagestore 750 options.
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Advanced Audio Mixing and Processing
• 16-channel audio mixing from embedded audio and 16 external AES pairs. Support for 5.1 

audio and multi-lingual audio.

• Versatile multi-channel audio clip playback, with simultaneous playout of up to four clips on 
up to 16 channels. This is called Easyplay 2. 

This is available with the IS-750-EP16 option. 

• Up to 4 Dolby decoders and encoders. 

These are available with the various IS-750-DOLBY-xxxx options. 

• 5.1 up-mixing using Linear Acoustic’s AutoMAX-IITM technology. 

This is available with the IS-750-UMX or IS-750-UMX-UPG options. 

• Advanced metadata processor with support for embedded metadata, metadata switching, 
metadata generation, dynamic metadata modification, metadata pass-through and meta-
data delay.

• Audio description (AD) — automated mixing of commentary track, e.g. for the visually 
impaired. 

This is available with the IS-750-AD-1 option. 

• Silence detection to automate control of multiple independent voice-overs fed from the 
same wide Easyplay clip.

• Multiple voice-overs with background audio automatically ducked during voice-overs.

• Dynamic control of shuffle, gain level, trim, phase, and mute for each channel.

• Dynamic selection of audio preview points and metering.

• Fades to silence and configurable audio delays.

• Graphical audio configuration tool (in the Imagestore 750 Configurator) for creating, view-
ing, and editing audio routing. 

Video Mixing
• A/B mixing of video sources for cuts, V-fades, U-fades, X-fades, and arbitrary asymmetric 

V-fade transitions.

• Variable rates: fast, medium, slow, and automation.

• Independent clean feed and auxiliary outputs.

• Single- or dual-window 2D DVE options (SD and HD) for squeeze-and-reveal and picture-in-
picture effects, using 10-bit processing, advanced interpolation, sub-pixel motion and scal-
ing calculations. 

These are available with the IS-750-DVE and IS-750-DVE-DUAL options. 

• The Imagestore 750’s C and D inputs are available to feed the DVEs. They can also be used as 
extra fill and key inputs. See figures 2-1 and 2-2.
7
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Master Control
• The master control option is suitable for automated, multi-channel environments. 

This is available with the IS-750-Master-Control option.2 

• Control of router switching through the NV9000 router control system.

• Configuration of router sources, source groups and salvos for each channel.

• Automatic retrieval of source names from the NV9000 router control system, with channel-
specific source name overrides.

• Selectable router sources for program, preset and aux buses. 

• Hot-cut transitions on the program bus for video source, keyers, DVE moves, voice-overs and 
macros. 

• Armable transitions for A/B mixing, keyer cuts and fades, DVE moves, voice-overs, and mac-
ros.

• Arm and take capability for synchronizing an overall transition, with preview of the upcom-
ing video and audio on the preset bus.

• Full integration with Intuition XG., allowing advanced graphics effects.

• Configurable wide-audio shuffles and per-channel gains saved on a per-source basis.

• The iMC master control panels allow manual preview and override of channels with an 
acquisition time of under 3 seconds. 

• Configurable channel acquisition privileges/permissions for different panel users. 

• The iMC master control panels control channel settings including automation on/off, source 
selection (on the program, preset, and aux buses), hot-cuts, arm/take transitions, browsing 
of media files using thumbnail proxies, source group editing, and audio configuration.

• The iMC master control panels can show the current source regardless of whether the source 
is in the active source group. 

• A globally active source group can be shared among panels.

• Dynamic monitor wall updates on channel changes.

• Support for Presmaster automation protocol.

Automated and Manual Control
• Full automation control using the widely supported Oxtel protocol (serial, Ethernet) and GPI.

• Manual control alternatively provided by the branding panel, PresStation, or Vertigo Xpanel.

Robust Design
• Compact flash memory for graphics storage.

• Robust, real-time Linux operating system.

• Redundant, hot-swappable power supplies.

• Mechanical bypass of program input to program output.

• Dedicated GPI support for 16 GPI signals (inputs or outputs).

2. See Chapter 11 for a complete list of Imagestore 750 options.
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• Built-in web server providing front panel control, system information, message logs and 
diagnostics, media management, audio templates, system backup and restore, and software 
upgrades.

• Front panel diagnostics for configuration, temperature, power supplies, and PLL.

• SNMP support for system monitoring and diagnostics.

• Configuration tool (the Imagestore 750 Configurator) for system setup and graphical audio 
route management.

Architectural Summary 
The following block diagrams shows the functions of the Imagestore 750:  

Fig. 2-1: Simplified Functional Diagram of the Imagestore 750 (Video)

Fig. 2-2: Simplified Functional Diagram of the Imagestore 750 (Audio)
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Architectural Summary
The Imagestore 750 has 8 video inputs, HD or SD. Each SDI video input feeds the internal video 
buses (program, preview, monitor, and clean-feed) and one parallel audio-processing block. The 
Imagestore 750 has line FIFOs for all 8 SDI inputs for timing adjustment. Embedded audio can 
be de-embedded from any 4 of the 8 inputs, and then be manipulated as required by the 
Imagestore 750’s audio engine. 

The program video bus (PGM) has an A/B mixer, four keying layers and an optional dual-window 
2D DVE. The A/B mixer allows the PGM output to be transitioned between two SDI video 
streams. Each of the keying layers may be fed graphics content from its own dedicated store or 
any of the three available external fill and key pairs, and then keyed over the background video. 
The stores can be loaded with a still image, animation, Easytext template, analog/digital clock, 
or Emergency Alert System (EAS) crawl. All available media files are stored in the media library 
(compact flash or hard disk, depending upon the option purchased) and then loaded into the 
internal stores on demand. The dual-window 2D DVE is used to create picture-in-picture 
squeeze effects which can be dynamically positioned between different keying layers on the 
program video bus.

The preview video bus (PVW) has four keying layers and an optional dual-window 2D DVE. Each 
keying layer shares graphics content with the corresponding program keying layer, but can be 
controlled independently in order to preview graphics before they are viewed on-air. Similarly 
the dual-window 2D DVE can be used to preview DVE moves before they are played on-air.

The clean-feed (CLN) and monitor (MON) video outputs allow a number of different internal 
points within the video system to be sampled and viewed for partial branding or monitoring 
purposes. For example, the CLN output can take its output from DSK3 of the program bus to 
show a partially branded version of the program output, without a station logo. 

A fail-safe mechanical video relay bypass connects the A video source to the program output 
directly and connects the C video input to the preview output (PVW) directly when a power 
supply problem occurs. The bypass mechanism is shown in Figure 2-1. 

The Imagestore 750’s audio engine accepts audio inputs from four embedded SDI feeds, 16 AES 
pairs, and from the multi-channel Easyplay2 audio clip player, which gives simultaneous playout 
of up to four audio clips sharing a total of 16 channels. The audio engine provides 16-channel A/
B mixing and multiple voice-overs. During voice-overs, background audio is automatically 
ducked. Silence detection automates control of multiple independent voice-overs fed from the 
same Easyplay clip. (Silence detection is typically used in a multi-language broadcast 
environment.) 

Optional audio modules can be added that provide integrated support for Dolby encoding and 
decoding, and stereo-to-5.1 up-mixing. The audio engine complements Dolby and up-mixing 
with advanced metadata processing. Audio description (AD) allows a background commentary 
track to be mixed with the background audio for people who are visually impaired. 

One of up to 16 possible tap points from the audio engine can then be dynamically assigned to 
each of the available unit outputs, to the four embedded outputs (PGM, PVW, CLN, MON), to the 
external AES outputs, and to the level metering.

 The audio engine is configured using the ‘Audio Graph’ page of the Imagestore 750 
Configurator.

An Ethernet interface provides rapid transfer of images and animations using Media Conversion 
Software (MCS) and other third-party media management applications. This interface also 
allows the transfer of images between a PC and the Imagestore 750 using Miranda’s Vertigo 
Xplorer. 
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The Media Conversion Software (MCS) and its documentation is available on a CD and includes: 

• Audio Builder

• Clip Builder

• Clock Builder

• Batch Converter

• Animation Builder

• DVE Editor

Miranda’s Vertigo Xplorer provides for the transfer and management of still images and anima-
tions. See the Xplorer User Guide for details regarding Xplorer.

Files may also be transferred between a PC workstation and the Imagestore 750 using a secure 
FTP program, DOS-formatted USB device, or the Imagestore 750’s web page. (The files must be 
in an appropriate format.) Miranda’s Media Conversion Suite (MCS) applications are designed for 
this purpose and ship with each Imagestore 750.

Physical Features
The Imagestore 750 is a 1RU master control and branding processor. 

Fig. 2-3: Imagestore 750

It has a small control panel and a USB port at the front, and a number of connectors at the rear. 
11
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screws (2)

 (2)
The front panel’s fascia is removable. Turn the thumbscrews to remove or replace it: 

Fig. 2-4: Imagestore 750 front panel

Behind the fascia are bays for two removable power supply modules and a USB port: 

Fig. 2-5: Imagestore 750 front panel with fascia removed

The USB port can be used for loading new license options, load and saving configurations, 
saving device diagnostics, copying image, animation, and audio files to the Imagestore 750, and 
booting the Imagestore 750 from USB for software upgrades.

The rear panel connections are arranged as shown: 

Fig. 2-6: Imagestore 750 rear panel

The AES connector provides 16 AES input pairs and 16 AES output pairs.

The GPIO connector provides 16 GPIs (individually configurable as an input or output), LTC 
terminals, and 4 RS-485 ports. 

The COM ports (RJ45) can be configured as RS-422 or RS-232. 

The LAN ports (RJ45) are for Ethernet connections. These are either “bonded” to the same IP 
address for networking redundancy, or un-bonded on independent IP addresses to separate 
media management from automation control. 

The video inputs are A, B, C/Fill-3, D/Key-3, Fill-1, Key-1, Fill-2, and Key-2, supporting HD and SD 
video formats. See Video Frame Rates on page 212 for details.

(C and D inputs can be used as fill and key inputs if the Imagestore 750 is so configured.)

The video outputs are PGM Out, PVW Out, CLN Out, and MON Out, supporting HD and SD video 
formats. 

ThumbJoystickLCD

USB Port (Hidden by Fascia)

Power Supplies (2) JoystickLCD

USB Port (Hidden by Fascia)

AC ConnectorsGPIO ConnectorAES Connector 
COM Ports (4)

LAN Ports (2)Video Ref. Video Inputs and Outputs
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The Front Panel 
The front panel has a 16×2 alphanumeric display which is used for status and for configuration. 
It is used in connection with a 4-position joystick: 

Fig. 2-7: Imagestore 750 front panel display and joystick

Using the joystick, an operator can navigate efficiently through a fairly large menu system. The 
menu system is hierarchical. See Appendix A for a complete description of the menu.

Moving the joystick down has two functions, depending on the current position in the menu 
system.

• It accesses the first item in the list of items belonging to the menu currently displayed. 

• If the current menu item has no list of items (i.e., it is a leaf node in the menu tree), the item is 
an operand and moving the joystick down selects the value of the operand as the current 
value of the parameter it represents. 

Moving the joystick up causes the display to go up one level in the menu tree. At the top level, 
moving the joystick up has no effect.

Moving the joystick left or right selects the previous, or next, item in the list of items at the 
current menu level. 

Symbols and Conventions 
Where this user manual discusses joystick input, it represents the 4 positions of the joystick with 
the terms ‘[esc]’, ‘[enter]’ or the arrow icons  and .

At times, additional symbols are shown on the top line of the display, at the right hand edge. 
These highlight the state of either the A/B Mixer (video or audio) or the keyers. These symbols 
represent:

Joystick

A Source A

B Source B

– Intermediate state, transition being processed.

↑ Image/voice-over keyed up (to air)

↓ Image/voice-over keyed down (from air)

B Fade to black

S Fade to silence
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Applications 
Chapter 3 presents several applications of the Imagestore 750. 

Topics
Three Scenarios  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 15 
Agile Audio Handling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 19 

Three Scenarios

Downstream Branding 
In many specialty channels, branding is performed downstream of a dedicated video server. In 
this scenario, an Imagestore 750 provides a combination of logo insertion, animations, basic 
text crawls and picture-in-picture DVE squeeze effects. Moreover, advanced graphics can be 
achieved using an Intuition XG, advanced audio processing (Dolby decode/encode, up-mix, AD). 
Voice-over mixing can also be applied to the background signal. In this scenario, everything is 
under control of automation, but an RCP-BR control panel can also be used for branding control. 

Fig. 3-1: Downstream Branding
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Master Control Switching 
The Imagestore 750 can be used as a traditional master control switcher. Automation controls 
arm-and-take transitions involving router sources for A/B mixing, keyer control, DVE squeezes, 
voice-overs and Intuition XG graphics. iMC panel operators can take manual control of the 
channel processor whenever it is required to override automation. Output from the channel 
processor is fed back to the station router for distribution to the outside world; media servers, 
local monitor walls, and so on. Sources are grouped to make it easier to manage multiple 
sources.

The Imagestore 750 is the hub of this control system, managing routing through an NV9000 
router control system and using the advanced graphics of an Intuition XG. If the Imagestore 750 
ever fails, it can be quickly bypassed using a redundant backup channel. 

Fig. 3-2: Master Control Switching

See Chapter 5, Master Control, for details regarding the iMC master control system.
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Branding Insertion Options for Intuition XG 
Advanced branding from the Intuition XG (including audio embedded in the fill signal) can be 
inserted into the program output in several different ways. 

Fill/Key Branding Insertion 
This example feeds the video source into the Imagestore 750, which performs A/B mixing, DVE 
squeezes and basic branding. The Intuition XG’s fill and key outputs also feed rich multi-layered 
graphics into one of the Imagestore 750 keying layers, contributing to the final program output. 
All audio mixing and processing is performed by the Imagestore 750, although the Intuition XG 
can supply voice-overs in its fill signal. 

Fig. 3-3: Fill/Key Branding Insertion

A benefit of fill/key branding insertion is that the graphics device is not in the direct signal path 
and will not affect output in the event of a failure. Also both devices can be controlled as a single 
“channel processor” by automation and iMC control panels. The main disadvantage is that it is 
difficult to synchronize Intuition XG graphics with DVE squeezes.

Downstream Branding Insertion 
This example feeds the video source to the Imagestore 750, which performs A/B mixing of video 
and audio plus performs advanced audio processing such as Dolby decoding or up-mix. Output 
from the Imagestore 750 is then passed downstream into the Intuition XG which performs DVE 
squeezes and applies rich multi-layered graphics to give the final program output. The Intuition 
XG can also play out and mix audio clips with the program output as embedded audio. 
17
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Fig. 3-4: Downstream Branding Insertion

A benefit of downstream branding insertion is that the DVE and branding are performed by the 
same device, which is much simpler to configure and automate. Also AFD data can be used for 
graphics positioning. Dolby E and Dolby Digital (AC-3) can be passed through the Intuition XG, 
but cannot be manipulated. The main disadvantage is that the graphics device is in the direct 
signal path. In addition, this scenario is not supported by the master control option.

In-Stream Branding Insertion 
This example feeds the video source to the Imagestore 750, which starts by performing A/B 
mixing of video and of audio. Output from the A/B mixer is then routed into the Intuition XG, 
which performs DVE squeezes and applies rich multi-layered graphics to the video signal. The fill 
output of the Intuition XG then feeds one of the Imagestore 750’s keying layers to provide the 
final program video output. Advanced audio mixing and processing (Dolby decode/encode, up-
mix, AD) is performed by the Imagestore 750 in parallel with video through the Intuition XG. The 
Intuition XG can play out and mix audio clips with its output as embedded audio to be used by 
the Imagestore 750 as a voice-over. Although simple processing of PCM background audio 
could be performed by the Intuition XG, there are better monitoring possibilities if it is always 
done by the Imagestore 750. Further, there will be no inconsistencies in audio output if the Intu-
ition XG is ever removed from the signal path.
18
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Fig. 3-5: In-Stream Branding

This scenario combines the advantages of both “fill/key branding insertion” and “downstream 
branding insertion.” The Imagestore 750 acts as a robust bypass for the Intuition XG. If the Intu-
ition XG ever fails, the Imagestore 750 keyer receiving Intuition XG graphics is cut down and an 
unbranded (or lightly-branded) version of the original video source will continue to be output 
without any break in signal integrity.

Agile Audio Handling 
Video sources feeding the Imagestore 750 can have different input audio configurations, some 
including Dolby data and others, PCM audio. To maintain a constant output audio mapping as 
the A and B inputs switch between different router sources (or sources change audio format 
dynamically), the Imagestore 750 mixes between different audio configurations by selectively 
using Dolby decode, up-mix and Dolby encode audio modules.

Example 1
In this example, sources that feed the Imagestore 750 inputs will always be in one of two 
possible audio formats: 5.1 PCM + 2.0 PCM and 5.1 Dolby E + 2.0 PCM. 

The two input audio streams are passed into Dolby E decoders which dynamically convert audio 
to a format suitable for A/B mixing (5.1 PCM + 2.0 PCM). The audio A/B mixer then transitions 
(fades or cuts) between sources, a voice-over can be mixed, and the output is encoded back into 
the required Dolby E configuration (5.1 Dolby E + 2.0 PCM). 

Fig. 3-6: Agile Audio Handling - 2 Dolby Decodes and an Encode
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Three of a possible four audio module slots are used.

Example 2
In this example below, sources that feed the Imagestore 750 inputs will always be in one of three 
possible audio formats: 

• 5.1 PCM + 2.0 PCM

• 5.1 Dolby E + 2.0 PCM

• 2.0 PCM + 2.0 PCM. 

The two input audio streams are passed into Dolby E decoders and 5.1 up-mix modules which 
dynamically convert audio into a fixed format suitable for A/B mixing (5.1 PCM + 2.0 PCM). The 
audio A/B mixer then transitions (fades or cuts) between the sources, and a voice-over can be 
mixed into the output in the required configuration (5.1 PCM + 2.0 PCM). 

Fig. 3-7: Agile Audio Handling - 2 Dolby Decodes and 2 UpMixes

All four audio module slots are used in this case
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Features 
Chapter 4 presents the important characteristics and functions of an Imagestore 750 in detail. 

Topics
Video Standards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 21 
Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 22 
Audio Processing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 25 
Video A/B Mixing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 31
Store Memory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 32
Keying Graphics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 32
DVE (for Program and Preview)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 41
Video Frame Delays  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 43
Preview Output . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 43
Clean-Feed Output  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 45
Monitor Output  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 46
General Purpose Interface (GPI)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 47
Macros . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 50
Graphics Co-Processors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 52
Closed Captions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 56
Timecode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 56
Message Logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 57
System Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 58
Video Bypass  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 58

Major features of the Imagestore 750, including master control and advanced audio, are covered 
in their own chapters.

Video Standards 

Output 
The Imagestore 750 can receive and transmit the following SDI video standards:

See Video Frame Rates on page 212 for additional detail. 

525i / 59.94 Hz SMPTE 259M-1997 270 Mb/s

625i / 50 Hz SMPTE 259M-1997 270 Mb/s

1920 x 1080i / 59.94 Hz SMPTE 274M-1998 1.485 Gb/s

1920 x 1080i / 50 Hz SMPTE 274M-1998 1.485 Gb/s

1280 x 720 / 59.94 Hz SMPTE 296M-2001 1.485 Gb/s

1280 x 720 / 50 Hz SMPTE 296M-2001 1.485 Gb/s
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Propagation Delay 
With the DVE in circuit, the delay through the Imagestore 750 is 2 interlaced fields or 2 progres-
sive frames depending on the video standard. See DVE (for Program and Preview) on page 41 for 
more information. 

Without the DVE in circuit, the delay through the Imagestore 750 can be up to 1 line. The delay 
consists of input line’s FIFO depth delay (which depends on the adjustment of the reference 
timing) plus a minimum video processing propagation delay. 

The video propagation delay for the Imagestore 750 is as follows:

Embedded audio delays are different from those of video. Embedding and de-embedding 
circuits are required by SMPTE standards to buffer many samples before processing. The 
Imagestore 750’s audio “through-path” propagation delay is measured in audio samples (~20 μs 
per audio sample at 48 kHz). Because audio sample duration is significant compared to video 
line duration, embedded audio samples present on input video line L will be processed, then 
output, on video line L + N, where N is variable and depends on both the video standard and 
line L. As a rough guide, N is generally 5 to 12 lines.

Reference 

Reference Types 
The Imagestore 750 locks to one of the following inputs, in order of priority: 

Otherwise the Imagestore 750 will free-run.

Video Standard Propagation Delay

525i / 59.94 Hz 5.4 ms

625i / 50 Hz 5.4 ms

1920 × 1080i / 59.94 Hz 2.6 ms

1920 × 1080i / 50 Hz 2.6 ms

1280 × 720p / 59.94 Hz 2.6 ms

1280 × 720p / 50 Hz 2.6 ms

Table 4-1: Video Standard Propagation Delay

REF IN Analog reference input, if present and compatible

PGM IN If present and at the correct video standard
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The compatibility matrix between REF IN type and output video format is shown here: 

Adjusting Reference Timing 
 Always adjust reference timing off-air because it can result in a loss of picture in downstream 

equipment. Errors can occur in the SDI stream as the adjustment is taking place.

The Imagestore 750 has one FIFO on each input for simplified system timing. You can modify the 
reference offset using the front panel menu. Select Setup > Reference > Offset. 

Then choose either:

Lines/Samples   
Lines/uS  

Use the front panel arrows to increase or decrease the offset value. For any video standard, the 
factory default reference timing is 0 lines plus half the length of a video line. This setting buffers 
about half a video line for inputs that are timed to a reference offset of + 0 lines + 0 samples (or 
+ 0 lines + 0 ms).

Reference adjustment affects the line number marking of the output stream. The reference 
must be adjusted to match the input signal timing of the local facility. Ancillary data such as 
timecode, captions and audio metadata may be missed by downstream equipment if they are 
not present on the same line on which they were input. If the output reference timing is not set 
correctly, problems might be seen such as:

• Loss of timecode.

• Loss of closed captions.

• Errors in embedded audio.

• Errors in Dolby E streams.

Note that reference adjustment affects the line number marking of the output stream. The refer-
ence must be adjusted to match the input signal timing of the local facility. 

An SDI data analyzer is needed to monitor the timing of the SDI input sources and the outputs 
with respect to the facility reference. 

REF IN Type
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Clean switching between the inputs is made possible by buffering the input FIFOs to co-time 
them before processing. The reference timing adjusts the active depth of the FIFOs to accom-
modate small timing differences between the input signals. 

The shortest video processing delay from any input through the Imagestore 750 to the program 
output occurs when the input FIFO depth is at its minimum. By increasing the output reference 
timing with respect to PGM IN, the FIFO depth is lengthened, up to its maximum of 1 line.

 To be valid, the input timing value must be negative. If the value is not negative, the refer-
ence offset must be adjusted so that the input timing value is negative. 

HD Example (1080i) 
Timing is dependent on the relative phase between the SDI input and the reference. The 
following example illustrates how to set up HD signals with a tri-level sync to achieve the 
minimum delay through the unit:

• Assume that the HD input arrives 3 μs later than the associated tri-level sync (+0 line +3 ms). 

• Assume that the minimum processing delay is about 2.6 ms for HD.

Example: Because PGM IN is 3 ms later than the tri-level sync and PGM OUT is at least 2.6 ms 
later than PGM IN, the minimum starting point at which to set the reference timing is (0 line 
+3ms) + 2.6 ms= 0 line + 5.6ms.

The reference timing must now be increased so that some data is buffered in the line FIFOs. In 
this example, the line FIFO is almost empty. This is a very undesirable timing point because the 
FIFO is on the threshold of going from empty to full if the input timing changes slightly, 
resulting in a 1-line vertical shift. Furthermore, the whole video picture may show corruption 
precisely at the FIFO empty point. 

Adding half a video line to the above reference timing provides enough buffering to accommo-
date the largest timing differences when the input is switched to a source that is not correctly 
co-timed. Co-timed inputs will then have approximately half a line buffered in their FIFOs. Any 
sources that arrive earlier or later will increase or reduce the FIFO depth respectively. 

The following table shows line lengths of the SDI standards: 

Half a line at 1080i / 59.94 is approximately 15 ms. To buffer half a line of 1080i / 59.94, increase 
the reference timing (in the example) to 0 line + 5.6 ms (+ 15 ms) = 0 line + 20.6 ms.

 Note: If the path delays of the SDI input sources are such that they are all offset from refer-
ence by several lines then adjust the reference by the same number of lines to align the 
output to the unusual input timing. Then add 10 to 20 microseconds to give some buffering 
in the line FIFOs.

Video Standard Line Length Samples

525i / 59.94 Hz 63.5 ms 1716

625i / 50 Hz 64.0 ms 1728

1920 x 1080i / 59.94 Hz 29.6 ms 2200

1920 x 1080i / 50 Hz 35.5 ms 2640

1280 x 720p / 59.94 Hz 22.2 ms 1650

1280 x 720p / 50 Hz 26.7 ms 1980

Table 4-3: Video Line Duration
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Audio Processing 
Audio processing requires the IS-750-Audio6 or IS-750-Audio16 audio option to be enabled.

The audio engine has the following characteristics:

• Input selection from embedded SDI (4 feeds having 16 channels) or external AES (32 chan-
nels).

• A/B mixing of multi-channel audio sources for cuts and variable rate fades (1–48 channels).

• Multi-channel voice-overs for program and preview with background automatically ducked 
during voice-over (1–48 channels).

• Easyplay clip storage and playout of four streams sharing 16 audio channels.

• Ability to associate Easyplay audio files automatically with video image/animation files. 

• “Wide” shuffles and control of gain level, trim, phase, and mute for each channel (1–48 chan-
nels).

• Dolby E and Dolby Digital (AC-3) decoding and encoding.

• 5.1 Up-mixing using Linear Acoustic’s AutoMAX-IITM technology.

• Advanced metadata processor with support for embedded metadata, metadata switching, 
metadata generation, dynamic metadata modification, metadata pass-through, and meta-
data delay. 

• Audio description (AD) with automated mixing of commentary track for the visually 
impaired.

• Silence detection that automates the control of multiple independent voice-overs fed from 
the same Easyplay clip.

• Fade-to-silence (1–48 channels).

• Configurable audio delays (48 channels shared between 6 delay banks).

• Output re-embedded onto PGM, PVW, CLN and MON outputs (16 channels) or external AES 
(32 channels).

• Audio level metering (48 channels).

• Dynamic selection of audio preview points and metering through output multiplexors (1–48 
channels, 16 sources).

• All internal processing is 24-bit at 48 kHz.

• Graphical configuration tool (the ‘Audio Graph’ page of the Imagestore 750 Configurator) for 
creating, viewing, and editing audio routing. 
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The following inputs and outputs are available to the audio engine:

Audio Graph 
To set up audio routing in the Imagestore 750 Configurator, drag audio blocks onto the ‘Audio 
Graph’ view. Then connect appropriate pins between input and output blocks. 

 Please see Chapter 8, Imagestore 750 Configurator, for detailed information about the 
Imagestore 750 Configurator. 

 Please see Audio Graph on page 161 for more details of the various audio blocks which are 
available for the Imagestore 750. 

Figure 4-1, following, shows a sample of the ‘Audio Graph’ page. 

In Figure 4-1, the 16 channels of two embedded SDI feeds are mixed at the A/B mixer. An AES 
voice-over is then applied before the audio is sent to SDI PGM output. This example does not 
incorporate typical control blocks for features such as input gain, input shuffling, fade to silence, 
output gain, preview and meter multiplexing or meters.

Audio Inputs Channels Audio Outputs Channels

SDI Feed 1 (embedded) 16 SDI PGM (embedded) 16

SDI Feed 2 (embedded) 16 SDI PVW (embedded) 16

SDI Feed 3 (embedded) 16 SDI CLN (embedded) 16

SDI Feed 4 (embedded) 16 SDI MON (embedded) 16

AES Inputs 32 AES Outputs 32 

Easyplay2 16 Level Meters 48

Silence 1

Test Tone 1

Table 4-4: Audio Engine Inputs and Outputs
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Fig. 4-1: Imagestore 750 Configurator - Audio Graph view

Some audio blocks are controlled by automation, and others can be set up to follow other 
system states automatically. For example, audio A/B mixing might follow video A/B mixing and 
Easyplay clips might drive voice-overs or follow the up/down state of keying layers on program 
or preview.

Sample Audio Graph Templates 
The Imagestore 750 Configurator provides many different ‘Audio Graph’ templates so that you 
can build custom audio setups. These are the templates:

• AB Mixer

16-channel embedded A/B mix.

16-channel embedded A/B mix with 2 channel AES voice-over (EAS).
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16-channel embedded A/B mix with 16 channel AES voice-over.

• AB Mixer with Easyplay

16-channel embedded A/B mix with 16 channel AES voice-over and 16 channel Easyplay 
voice-over.

16-channel embedded A/B mix with 16 channel AES voice-over and multilingual Easyplay 
setup (independent automatic duck control of Easyplay channels 6-6-2-2).

16-channel embedded A/B mix with 16 channel AES voice-over and 8 channel Easyplay 
voice-over (independent control of voice-overs on PGM and PST).

16-channel embedded A/B mix with 16 channel AES voice-over and 8 channel Easyplay 
voice-over (independent control of voice-overs on PGM and PST, Easyplay follows video 
stores and keyers).

• Pass-through (non-A/B mix)

16-channel embedded pass-through with 2 channel AES voice-over (EAS).

16-channel embedded pass-through with 16 channel AES voice-over.

• Pass-through (non-A/B mix) with Easyplay

16-channel embedded pass-through with 16 channel AES voice-over and 16 channel Easy-
play voice-over.

16-channel embedded pass-through with 16 channel AES voice-over and multilingual Easy-
play setup (independent automatic duck control of Easyplay channels 6-6-2-2).

• Dolby AB Mixer

Dolby E in (Dolby E out) embedded AB mix with 8 channel AES voice-over.

Dolby E/PCM in (Dolby E out) embedded AB mix with 8 channel AES voice-over.

Dolby E/PCM/up-mix in (PCM out) embedded AB mix with 8 channel AES voice-over.

Dolby E/PCM/up-mix in (PCM out) embedded AB mix with 8 channel AES voice-over and 
Easyplay voice-over.

• Dolby Pass-through (non AB mix)

Dolby E/PCM in (Dolby E out) with 8 channel AES voice-over.

Dolby E/PCM/up-mix in (Dolby E out) with 8 channel AES voice-over.

Dolby E/PCM/up-mix in (Dolby E out) with 8 channel AES voice-over and Easyplay voice-
over.

• Test Setups

Test tone to all outputs.

• Each template is described in the Imagestore 750’s web page, listing the following details:

• Functional description

• Inputs

• Outputs

• Preview modes
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To select a template upon which to build, choose ‘Import Audio Graph’ from the Imagestore 750 
Configurator’s ‘File’ menu. Then choose ‘From Device Template . . .’ in the submenu and select 
the appropriate filename in the dialog that appears subsequently: 

Fig. 4-2: Import Audio Graph dialog

(See Audio Templates on page 182 for more information.)

Embedded SDI Audio 
Embedded audio processing requires the IS-750-Audio6 or IS-750-Audio16 audio option to be 
enabled. 

Audio can be de-embedded from 4 of the 8 available SDI inputs and re-embedded in the 4 SDI 
outputs. The IS-750-Audio6 option provides 4 channels of de-embedding for each feed, and the 
IS-750-Audio16 option provides 16 channels of de-embedding for each feed. 

External AES Audio 
There are 16 AES pairs (32 discrete channels) available for both audio input and audio output. 
The AES inputs and outputs are presented on a 68-pin SCSI D-connector to enable wiring of 
mating connectors to a 1RU breakout box. (The order codes for those products are ABT-32-32-
D110 and ABT-32-32-D75.) All AES inputs and outputs are sampled at 48 kHz and locked to 
video.

Audio A/B Mixing 
Audio A/B mixing requires that the video A/B mixing option be enabled. It is not available for 
the IS-750-LOGO.

The Imagestore 750 allows A/B mixing of multi-channel audio sources for cuts and variable rate 
fades with mixes being up to 48 channels wide. Audio can be configured to follow the video A/B 
mixer position automatically, or it can be controlled independently for lead/lag or breakaways. 
Depending on the type of video A/B mix, audio mixes pass through either silence (V-fades) or a 
50% mix of the A and B sources (X-fades).
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Voice-Overs 
Voice-overs adjust the combined levels of the background audio and incoming voice-over so 
the audio level does not exceed the original background volume. The diagram shows how the 
‘duck’ and voice-over presets adjust the actual audio levels. 

Fig. 4-3: Audio level during Voice-Over - duck and voice-over preset

The duck value is the amount by which the background audio level is attenuated when the 
voice-over is fully on. The voice-over preset value is the level of the voice-over audio when the 
voice-over is fully on. Both values are given in decibels.

The Imagestore 750 Configurator’s ‘Audio Graph’ page allows you to define 8 independent 
voice-overs for use on the program bus. There are also 8 preview voice-overs for the preview 
bus which can be set to cut up or down automatically based on the arm state of the corre-
sponding program voice-over. (See Audio Mix Blocks on page 165 for more information.)

Easyplay 
 Easyplay2 requires the IS-750-EP16 option to be enabled.

 Note: In software versions 3.1 and later, 16 channels of audio clip playout are also enabled by 
IS-750-EP2 and IS-750-EP8 options.

The Easyplay feature allows digital audio clip storage and playout of up to four independent 
streams sharing a total of sixteen audio channels. Many variations are possible, such as:

Easyplay audio clips are often associated with one of the 16 available voice-overs on PGM and 
PVW. The associated voice-over may be configured to fade up automatically when the Easyplay 
stream starts playing, and fade down automatically when the Easyplay stream stops. Alterna-
tively, the Easyplay stream can be configured to start or stop playing when its associated voice-
over is faded up or down.

You can place Easyplay in a mode in which it follows video layers cuts, fades, loads and unloads 
automatically. In this mode, audio clips are loaded by association with image file names, and the 
audio clips play out (or stop) automatically when the keyer associated to the media file is cut up 
(or down). The association may be made with either program or preview keyers.
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Name Description Streams Channels

16 One stream playing out the widest possible audio clips 1 16

2.0 + 5.1 One language with two streams of different width 2 8

2.0 + 5.1 + 2.0 + 5.1 Two languages each with two streams of different 
widths

4 16

2.0 + 2.0 Two stereo streams under independent control 2 4

2.0 + 2.0 + 2.0 + 2.0 Four stereo streams under independent control 4 8 

Table 4-5: Example Easyplay2 streams and channels possibilities
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The Imagestore 750 supports the following Easyplay audio clip file formats: 

All audio clips must be generated at 48 kHz (48,000 samples per second). You can generate WAV 
files with 16 bits or 24 bits per sample. WAV files of 24 bits are preferred.

Switching Dolby E Signals 
When it is operating in a progressive video standard (720p at 50 or 59.94 Hz) and switching 
Dolby E signals, the Imagestore 750 must be given an interlaced reference input — such as 1080i 
tri-level or SD bi-level analog reference — and the Dolby E data must be aligned to this refer-
ence. That is because Dolby E data are locked to the interlaced frame. 

• 720p at 59.94 Hz = 59.94 Hz frame rate

• 1080i at 59.94 Hz = 29.97 Hz frame rate

This requirement applies to all Imagestore 750s that receive Dolby audio data, regardless of 
whether any Dolby decode/encode options are enabled. Imagestore 750s without enabled 
Dolby options can cut-switch between Dolby data streams, with the transition occurring at the 
mid-point of an A/B mix. 

Advanced Audio 
Chapter 6, Advanced Audio, discusses advanced audio features available in the Imagestore 750. 
Please reference these sections:

• Dolby page 105

• Dolby Metadata page 120

• Up-Mix page 133

• Audio Description (AD) page 140

• Silence Detection page 143

• Audio Delays page 146

Video A/B Mixing 
The Imagestore 750’s video A/B mixer is fed by any of its input sources or by an external router. 
The mixer’s output provides the background video source for the PGM keyers. The mixer can be 
dynamically configured either to cut or to fade the video. The Imagestore 750 supports cross-
fades, cut-fades, fade-cuts, V-fades and U-fades over variable durations, with V-fades transi-
tioning through a predefined color field. You can define the profile of each fade type.

You can configure the audio mix to follow the video mix automatically. Choose Setup > 
Audio Setup > Follow Video > A/B Mix at the Imagestore 750’s front panel. Alter-
natively, you can configure the audio mix to be completely independent of the video. 

.wav Multi-channel WAV files. (This is the preferred format.)

.oxw 2-channel clips created with Audio Builder (available on the MCS CD).

.oxe Multi-channel Imagestore 750 audio file created with Audio Builder.
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Store Memory 
The entry-level Imagestore 750 (either an IS-750 or an IS-750-LOGO) provides storage shared 
between the 4 keying layers for up to 512 MB of images or animations with their associated 
keys. The IS-750-MEM-2GB upgrade expands this storage to 2 GB total. 

The percentage of total store memory allocated to each of the four stores can be configured. 
This is useful if you want to assign one keying layer to long animations, and other layers for 
smaller logos or external fill/key. There are two ways to change the allocation:

• At the front panel: use ‘Setup > Stores > Stores Memory’.

• In the Imagestore 750 Configurator: choose the ‘Store Manager’ tab under ‘Configuration 
Mode’. See Store Manager on page 161. 

You should always load media files into the store memory before they are keyed over back-
ground video. Stored images and animations can be taken to air by fade or cut transitions. An 
automation pre-load capability (command R7) allows the next animation to be loaded in 
advance while another animation is on-air, provided there is sufficient memory, to avoid playout 
delays on-air. However, it is preferable to use two keying layers to switch between different 
media whenever possible.

It is recommended that a media management system is used to transfer media to the Images-
tore 750. It is possible to load media using Miranda’s Media Conversion Software (or other 
Miranda tools), from a USB device or via an FTP transfer (see the FTP Interface section for more 
information).

Keying Graphics 
Keying is the process of inserting one video signal (a fill signal) into another video signal (the 
background signal) according to a third signal (the key signal). The key signal governs the trans-
parency of the fill signal.

Fill and key signals can be obtained from the following sources:

• An external graphics playout device, such as the Intuition XG, fed into a fill and key input.

• Internal media files loaded into store memory.

You can control the following keying parameters:

• Source

• Clip, gain and transparency

• Type 

• Sense 

• Masking 

External Graphics 
You can connect an external graphics device or CG to the Imagestore 750’s BNC pairs (Fill-1, 
Key-1), (Fill-2, Key-2) or (Fill-3, Key-3). The fill and key signals may then be fed to any of the 
supported keying layers and keyed up, or down, as required.

See Keying Parameters on page 39 for a description of the various keying parameters. 
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Internal Media 
The following internal image file types can be cut or faded onto any keying layer with an associ-
ated store:

See Keying Parameters on page 39 for a description of the various keying parameters. The 
images may be any size up to full-screen. Stored images and their associated keys are processed 
at 10-bit resolution (unless the image is stored without a key to save space in which case it is 
stored at 8-bit resolution).

Images 
Logos and full-frame still images are defined within .oxt image files. The image file embeds 
information such as the on-screen position, keying source and keying type. The image’s trans-
parency can be defined in a key image, so effects such as soft edges can be applied. 

(See Keying Parameters on page 39 for more information.) 

You can generate .oxt image files using one of the following applications:

• Xplorer 

• Animation Builder (available on the MCS CD).

Animations 
Cell animations are defined in .oxa animation files. The animation file embeds information such 
as the on-screen position (for each field or frame of the animation if necessary), keying source 
and keying type. The transparency of each frame may be defined in a sequence of key images, 
so effects such as soft edges and dynamic fades can be applied. You can define any of the 
following loop modes:

• Single shot

• Cycle

• In-loop-out

• Linear control

• Ping-pong

• Multiple loop

(See Keying Parameters on page 39 for more information.) 

The maximum length of a cell animation is limited by the available store memory, as determined 
by the installed memory and the amount of memory allocated to the associated keyer, in combi-
nation with the screen area of the animation. The duration of larger animations, up to full 
screen, is reduced proportionally to the area used. Because areas are evaluated at each frame, 
animations can change in size with no penalty.

 If the last animation frame is completely transparent, then the keyer stays cut up after the 
last animation frame. If the last animation frame is small (2×2) then the keyer cuts down after 
the last animation frame.

Images .oxt 

Animations .oxa 

Easytext .oxa 

Bugclock .oxa 
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With 128 MB of playout memory per store, a logo that is 1/64 of the screen size can be animated 
for just over half a minute. Larger screen sizes or smaller playout memory sizes affect the 
maximum animation duration pro rata. This table shows the duration for animations at 1080i. 
The frame rate is 29.97 frames per second and the size of a frame is 7.91 MB: 

The animation’s load time (into storage) depends on the total size of the animation file.

You can generate .oxa animation files using one of the following applications:

• Xplorer 

• Animation Builder (available on the MCS CD)

• Miranda’s Adobe After Effects1 Plug-in (available on the MCS CD)

Component images can also be imported into the animation builder from 32-bit Targa image 
files, allowing components to originate from almost any computer graphics system.

Easytext 
 Easytext requires the IS-750-ET option.

CG text effects, including static text and simple crawls, are defined in .oxa Easytext files, or 
templates. The templates can comprise many text and image elements, all of which can be 
updated dynamically through automation. Data sources can also be defined within text 
elements to help achieve dynamic data-driven updates including timers, date, stopwatch, 
countdown, and custom data. 

You can generate .oxa Easytext files using one of the following applications:

• XStudioLT. 

• TextBuilder2 (available on the MCS CD).

Bugclocks 
 “Bugclocks” require the IS-750-Clock option.

Analog or digital clocks are defined within .oxa Bugclock files. The Bugclock file defines the 
properties of the clock, such as hand and face styles, and whether it shows hours, minutes, and 
seconds. Digital clocks can be 12 or 24 hour style. A bugclock can be locked to a station’s LTC or 
VITC timecode. Clocks are loaded, previewed, positioned, keyed and controlled through GPIs 
and automation, as are animations and static logos.

Memory Allocated (MB)

128 256 512 1024

Animation size Maximum Duration

Full frame 16.1 f 32.2 f 64.4 f 128.8 f

1/16 frame 8.6 s 17.2 s 34.4 s 68.8 s

1/64 frame 34.3 s 68.8 s 137.6 s 275.2 s

Table 4-6: Animation size, duration for allocated Styores Memory

1.  After Effects is a digital motion graphics and compositing software package published by Adobe Sys-
tems. Its main purpose is film and video post-production.
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You can generate .oxa Bugclock files using the Clock Builder application (available on the MCS 
CD).

‘Emergency to Air’ and ‘Emergency from Air’ 
If a background video failure occurs, an emergency image message can be brought to air using 
the ‘Emergency to Air’ feature. The message can be triggered by automation, a GPI event, from a 
control panel, or from the Imagestore 750’s front panel.

When ‘Emergency To Air’ is selected, the most downstream keyer that is associated with a store 
(on the program output channel) fades down over 25 fields. Image V000.oxt is then loaded and 
faded up over a further 25 fields.

When ‘Emergency from Air’ is selected, the most downstream keyer that is associated with a 
store (on the program output channel) fades down over 25 fields and the previous image is 
restored, but not faded up.

 Note: The emergency image must be stored in the image library under filename V000.oxt.

Emergency Alert System (EAS) 
 The Emergency Alert System feature requires the IS-750-EAS option.

The Emergency Alert System (EAS) is a national warning system in the United States that notifies 
the general public of pending or imminent situations such as weather emergencies. It can also 
be used by the President of the United States to deliver a message. All television stations in the 
USA are required to transmit EAS messages. Cable head-ends are also required to transmit EAS 
messages on all programmed channels. For more information on EAS, see the FCC website or 
the websites of the EAS receiver manufacturers.

A televised EAS alert consists of two components:

• An on-screen crawl displaying the nature of the emergency and the regions affected in the 
broadcast area.

• An audio message up to two minutes in length.

The EAS option provides a mechanism for the Imagestore 750 to receive information from an 
external EAS receiver and then generate the required video crawl and audio voice-over. The 
Imagestore 750 provides flexible branding capabilities for the video crawl, using an Easytext 
template, such as adjustable font type, size, and color, additional images or text, etc. It provides 
full GPI macro programmability and enforces keyer control so that the crawl is shown for the 
duration of the alert.

 Note: For EAS messages (a.k.a straps) to appear correctly on DSK 4, the fourth store must be 
allocated sufficient memory. See Setup > Stores > Stores Memory on the Images-
tore 750’s front panel.

EAS Receivers and Interfacing 
The Imagestore 750 supports the following EAS receivers:

• Sage ENDEC Model 1822.

• TFT EAS 911.

Select the EAS receiver model and Baud rate in the Imagestore 750 Configurator or at the 
Imagestore 750’s front panel. Choose Setup > Serial Comms > Serial Ports > Com 
x > Protocol / Baud Rate. 
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The following external interfaces to the Imagestore 750 are required:

• Serial input

The EAS receiver connects to the Imagestore 750 over an RS-232 serial connection. This con-
nection provides the EAS alert data including the alert level and crawl text data. 

EAS messages can be up to 1990 characters long.

• GPI input

A GPI trigger on the Imagestore 750 is used to initiate, and then terminate, the EAS alert. This 
GPI can come directly from the EAS receiver, from automation, or from a manually initiated 
trigger. 

The GPI trigger drives separate ‘EAS On’ and ‘EAS Off’ macros that allow you to build a cus-
tom branding event around the EAS crawl. The macro usually includes triggering of an AES 
voice-over (which will duck the background audio) but can play a pre-recorded Easyplay 
audio clip instead.

• Voice-over input 

Audio voice-over input is fed into an external AES pair on the Imagestore 750. The EAS audio 
message is up to two minutes duration and stored in the receiver until the alert is triggered. 

Because most receivers have analog audio outputs, the audio must first be converted to AES 
using an external converter (such as the Miranda ADC-1711 or ASD-771p). The AES audio is 
then fed to the Imagestore 750 through an external AES input pair and the audio is mixed 
with the background through a voice-over: 

Fig. 4-4: EAS Receiver interfacing

EAS Crawl Templates 
The Imagestore 750 monitors its COM ports for a serial string from an EAS receiver. When a 
message is received, its priority (high, medium, low, or none) is established and the text is 
updated in one of the following default Easytext crawl templates. 

For each video standard, there is a standard set of files that correspond to the appropriate EAS 
alert level with the appropriate background color. 
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Filename Priority Video Standards

EASHigh.oxa  1 (high) 525i / 59.94, 625i / 50

EASHighHD1080.oxa  1 (high) 1080i / 59.94, 1080i / 50

EASHighHD720.oxa  1 (high) 720p / 59.94, 720p / 50

EASMed.oxa  2 (medium) 525i / 59.94, 625i / 50

EASMedHD1080.oxa  2 (medium) 1080i / 59.94, 1080i / 50

EASMedHD720.oxa  2 (medium) 720p / 59.94, 720p / 50

Table 4-7: Standard EAS alert crawl template Filenames
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Each default EAS template file can be copied (from /etc/eas/ into /home/images/) and 
then modified to suit your requirements in the TextBuilder application (available on the Media 
Conversion Suite CD). You can customize background color, crawl speed, font, size, shadow, and 
positioning. You can also add additional elements to the crawl such as another text field or a 
logo or graphical element. 

Note the following considerations relating to EAS template files:

• The EAS template filename should not be changed. Otherwise, the EAS option will not be 
able to find the template.

• Always use Text Builder to transfer modified files to the Imagestore 750 so that all fonts asso-
ciated with the template are also transferred.

• The datasource name “EAS_TEXT” is associated with the text crawl element in an EAS tem-
plate. Ensure that its datasource value is not inadvertently adjusted by automation because 
doing so can affect the EAS message on-air.

• If no text has been received from the EAS receiver, blank text will be seen in the EAS tem-
plate. Either leave this blank, or pre-set the data-source to something harmless such as 
“Stand by for an important EAS alert.”

EAS Triggering 
 Note: EAS messages are displayed on-air following appropriate GPI triggers or automation 

commands. Refer to General Purpose Interface (GPI) on page 47 for information about 
setting up the relevant GPI. For automation commands, refer to the automation publications 
listed under Applicable Publications and Tools on page 3.

When an EAS alert is triggered ‘on’ by GPI or by automation, the following internal events occur:

• The ‘EAS Layer’, which is the most downstream keyer, is cut down. Its prior keyer state and 
the image loaded (if any) are saved for later use.

• The appropriate EAS crawl template is loaded into the ‘EAS Layer’. The selected crawl file is 
determined by the alert level in the crawl data and the video standard. The crawl data must 
be received before the EAS alert is initiated, otherwise stale data will be displayed.

• The ‘EAS Layer’ is cut up to reveal the EAS alert (in the video foreground).

When an EAS alert is triggered ‘off’ by GPI or automation, the following internal events occur:

• The current EAS crawl will complete, after which the ‘EAS Layer’ cuts down.

• The previous image (if any) is reloaded into the ‘EAS Layer’.

• The ‘EAS Layer’ is restored to its prior state.

EASLow.oxa  3 (low) 525i / 59.94, 625i / 50

EASLowHD1080.oxa  3 (low) 1080i / 59.94, 1080i / 50

EASLowHD720.oxa  3 (low) 720p / 59.94, 720p / 50

EASNone.oxa  None 525i / 59.94, 625i / 50

EASNoneHD1080.oxa  None 1080i / 59.94, 1080i / 50

EASNoneHD720.oxa  None 720p / 59.94, 720p / 50

Table 4-7: Standard EAS alert crawl template Filenames
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• Any remaining events in the EAS alert ‘off’ GPI macro are processed. These macro events are 
suspended until the preceding events complete.

Additional commands can be added to the GPI macros to provide other EAS actions. At a 
minimum, these events must include a ‘Voiceover On’ and ‘Voiceover Off’ command and appro-
priate delays to ensure that the data for the crawl is received. Such GPI macros are outside the 
scope of this manual, but can be discussed with Miranda Support.

Because the Imagestore 750 retains the last EAS text message received, the EASNone.oxa crawl 
will be seen only when the EAS mode is activated with no alert level. When verbose logging is 
enabled, all EAS transactions are recorded in the standard Imagestore 750 log files. 

Temperature Probe 
 The temperature probe feature requires the IS-750-TEMP option.

This option provides a low-cost temperature sensor (Sensorsoft ST6154J) for measuring the 
local temperature, typically from the roof of the building. The temperature can be recorded in 
Celsius or Fahrenheit, and can be displayed (and continually updated) on a keying layer of the 
Imagestore 750 using an Easytext template. 

The thermometer connects by cable to an RS-232 serial port of the Imagestore 750 and can be 
located up to 1000 feet away without the need for a battery or external power adapter. It has an 
external stainless steel probe, suitable for outdoor applications or where liquids are present. 

More information is found on the temperature probe option’s instruction sheet. That is Miranda 
document M987-9805-101.

Temperature Probe Parts 
This table lists the probe parts: 

 Note: For pin-outs to be correct at the Imagestore 750, the parts must be connected in the 
order listed in the table above.

Temperature Probe Serial Port Settings 
Set the probe’s serial port protocol and Baud rate to the following values at the Imagestore 750’s 
front panel or in the Imagestore 750 Configurator: 

Protocol ST61XX Thermometer

Baud rate 1200

Temperature Probe Easytext Templates 
When the Easytext option is enabled, you can use the special temperature probe datasource 
names (show in the table below) for text boxes within any Easytext template used on the 

Miranda Part Number Description

4100-0041-0 Sensorsoft ST6154J RS-232 temperature sensor with external probe 

3503-0024-0 Sensorsoft C2000 cable, DB9-to-RJ45, 20 feet

1897-1700-100 Miranda adapter, RJ45-to-DB9 for RS-232 DTE

0702-1400-100 Ethernet cable, RJ45-to-RJ45 CAT5 UTP, flex 10 feet

Table 4-8: Temperature Probe Parts
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system. When the Easytext option is not enabled, a special template name temperature.oxa is 
reserved for displaying the special temperature probe datasources. This is the only Easytext file 
that can be displayed on such a system. 

After an Easytext template has been generated containing one or more of the temperature 
probe datasource names, you can load it into a keying layer, and cut up, to display the tempera-
ture on-air.

Keying Parameters 
You can configure the following keying parameters for both internal and external graphics.

• Source

The key source (actually the keying method) may be chosen from the following:

• Clip, gain and transparency

After the key source is selected, the key signal is processed with clip, gain, and transparency 
to alter the mapping from key input luminance to key output values. Transparency modifies 
the maximum key value as follows: 

Fig. 4-5: Keying Parameters - Clip, Gain, Transparency

• Type

After the key output is generated, the type controls the combining of the background and 
fill video signals. The Imagestore 750 supports both linear and full keying types.

Temperature Probe Datasource Name Displays Accuracy 

TEMPERATURE_CELSIUS   Celsius Rounds to nearest integer

TEMPERATURE_CELSIUS_TENTHS   Celsius Rounds to one decimal place

TEMPERATURE_FAHRENHEIT   Fahrenheit Rounds to nearest integer

TEMPERATURE_FAHRENHEIT_TENTHS  Fahrenheit Rounds to one decimal place

Table 4-9: Temperature Probe Easytext Template files

Separate Key The key values are derived from the luminance content (Y value) of the 
separate key.

Self Key The key values are derived from the luminance content (Y value) of the fill 
signal itself.

None The key for an image is set to white so that there is no image transparency.
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Linear keying is where the fill signal has been pre-computed to match the key signal. In this 
case, the fill has already been cut by its own key independently of the Imagestore 750. The 
keyer computes (1 – key) and uses this to “cut a hole” in the background signal. The fill is 
then simply added to this. 

Fig. 4-6: Linear Keying (pre-cut Fill)

Full keying is where the fill signal must be multiplied by the key signal prior to being added 
to the modified background signal. In this case, the fill has not already been cut by its key. 
The keyer cuts a hole in the fill with the key values and cuts a hole in the background with 
computed (1 – key) values. The cut fill and cut background are then added. Full Keying

Fig. 4-7:  (both Fill and Background cut by Key)

• Sense

Key inversion switches the key value with the (1 – key), thereby inverting the sense of the 
key signal.

The Imagestore 750 supports normal and invert sense. 

• Normal

A black key level causes the fill pixel to be fully transparent.

A white key level causes the fill pixel to be fully opaque.

Intermediate keying levels produce a pro rata transparency effect.

• Invert

This is the reverse of the normal sense.

A white key level causes the fill pixel to be fully transparent.

A black key level causes the fill pixel to be fully opaque.

Intermediate keying levels produce a pro rata transparency effect.

• Masking

The Imagestore 750 allows a rectangular masking area to be defined for each of the 4 keyers. 
This mask applies to any signals received by the keyer; whether they are external fill and key 
signals or the output from internal stores. 

For internal images, the area range of the mask is determined by the width and height of the 
image in pixels, and is limited by the selected video standard. To maintain correct YUV val-
ues, the pixel count increments by 2. 

For external fill and key signals, the area range of the mask is limited by the selected video 
standard. Here too, the pixel count increments by 2. 
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One situation where masking an external fill and key signal is useful is when output from an 
external graphics device must be split between two keying layers in different regions of 
screen area.

DVE (for Program and Preview) 
The Imagestore 750 digital video effects (DVE) options provide visual effects giving comprehen-
sive video image manipulation, including picture-in-picture squeeze transitions over a 
background. The main DVE features include:

• Single or dual 2D (rectangular) squeezes over a background.

• Independent control of DVE squeezes on the program and preview buses.

• Cropping and masking of squeezes, including soft edges and colored borders.

• Adjustable layering of dual DVEs, to bring new content to the front.

• Editor for creating and modifying DVE sequences to move between different squeeze posi-
tions.

• Up to 97 different DVE sequences stored on the Imagestore 750.

• Compensating video delays, post-A/B-mix on program and preview.

The following DVE options are available for the Imagestore 750:

IS-750-DVE Enables a single DVE window on PGM and PVW.

IS-750-DVE-DUAL Enabled two DVE windows on PGM and PVW.

The DVE processors provide digital video effects on any of the input video streams or A/B mixer 
output. Digital video effects are suitable for picture-in-picture applications such as over the 
shoulder news transitions, as well as squeezes for credits, news flashes, sports results, and 
schedules. 

You can create and manage DVE sequences using the DVE Editor (available on the Media 
Conversion Suite CD). Using the DVE editor software, you can upload up to 97 sequences onto 
the Imagestore 750 for later playback. 

The DVE delay is exactly 2 interlaced fields or 2 progressive frames. For 59.94 Hz standards, the 
delay is 2 / 59.94 s and for 50 Hz, standards the delay is 2 / 50 s. Any non-active picture data in the 
DVE input stream is also delayed while the video is resized. 

Note: It is important for video and audio (including metadata) to maintain a constant and 
unchanging delay through the Imagestore 750. To compensate for any potential DVE 
processing, matching delays must be applied to the background video (after the A/B mix), and 
to the audio/metadata paths defined within the audio engine.

You can set the DVE mode to ‘enabled’ or ‘disabled’ for the program and preview buses indepen-
dently. When the DVE is enabled, DVE picture insertion takes place with the DVE window(s) 
being keyed at the position defined by the DVE configuration. When the DVE is disabled, DVE 
picture insertion is taken out of circuit to reveal the background video coming from the A/B 
mixer. In both cases, a DVE delay is experienced at the Imagestore 750’s output.

The DVE configuration menu option of the Imagestore 750’s front panel (Operate > DVE 
Config) and the Imagestore 750 Configurator allows the position of the DVE picture insertion 
within the video path to be one of the following. 

• DVE inserted before all keyers
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• DVE inserted after keyer 1

• DVE inserted after keyer 2 

This diagram illustrates the 3 DVE configuration options: 

Fig. 4-8: DVE insert positions:- before keyers; after keyer 1; after Keyer 2

Each heavy (red) line represents a fill/key signal from one of the DVE scalers, which is then keyed 
over the background video at a position that depends on the current DVE configuration.

When DVE mode is enabled, the DVE keyer will often present full-screen video (normally routed 
from the A/B mixer). Any DSKs that are upstream of the DVE keyer will be lost. However, it is 
normal to have at least one DSK upstream of the DVE keyer so that full-screen media graphics 
can be used to hide the background video coming through the compensating delay. These 
graphics will also be revealed when the DVE squeezes back from full screen. 

Note: The relative positioning of DVE1 and DVE2 scalers can also be modified using the DVE 
sequence editing software.

When DVE mode is disabled, the background video continues to pass through the compen-
sating video delay. The compensating delay must be set to match the delay through the DVE 
scalers exactly. That way, when DVE mode is re-enabled, there will be no glitch in the video 
output.

Fig. 4-9: DVE video compensating delay
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Video Frame Delays 
It is very important for video and audio (including Dolby metadata) to maintain a constant and 
unchanging delay through the Imagestore 750 system to avoid lip-sync problems. To help 
achieve this, the Imagestore 750 provides the following video frame delays: 

You can configure these delays in the Imagestore 750 Configurator using

System Settings > Video > Video Frame Delays.

The ‘post A/B-mix’ delays are primarily used to compensate for the DVE and any in-stream 
branding insertion. The ‘output’ delays are primarily used to compensate for the audio delay 
through Dolby decode and encode modules. 

Other aspects that affect the configuration of system delays are discussed in the following 
sections:

• DVE delays — DVE (for Program and Preview), page 41

• In-stream branding — In-Stream Branding Insertion, page 18

• Dolby delays and decode / encode modules—Dolby Processing Times on page 117; Dolby 
Delays on page 146

• Metadata delays—Metadata Delays on page 148

• Up-mix modules—Up-Mix Processing Times on page 136

• Audio delay blocks—Audio Delay Blocks on page 148

Note: There is no video frame delay associated with the monitor output. Such delay is seen at 
the monitor output only if it is selected to monitor either of the program, preview or clean-feed 
outputs.

Preview Output 
The preview output selection defines the SDI output to be viewed at PVW OUT. It can be set to 
one of the following values at the front panel menu using Operate > Preview Output:

Name Bus Position Compensates For Delays From . . . Range

Program post-AB mix frame 
delay

PGM Post A/B-mix DVE, in-stream branding insertion, 
audio modules

0–8

Preview post-AB mix frame 
delay

PVW Post A/B-mix DVE, in-stream branding insertion, 
audio modules

0–8

Program output frame delay PGM Output Audio modules 0–16

Preview output frame delay PVW Output Audio modules 0–16

Clean feed output frame delay CLN Output Audio modules 0–16

Table 4-10: Imagestore750 Video frame delays

Selection Description

Preview o/p  Selects default preview output

Program o/p  Selects a copy of PGM OUT as the preview output

PGM AB Mix  Selects output from PGM A/B Mixer as the preview output

Table 4-11: Preview output options
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The Imagestore 750’s default preview output selection is used typically for previewing A/B mixer 
transitions, keyer graphics transitions, DVE moves, and voice-overs prior to bringing them to air 
on program output. In the master control environment, you can preview exactly what will 
happen on the program output when the next transition is taken to air. 

The video output that is presented for ‘Preview O/P’ depends on the following settings:

• A/B mixer sources the from upstream router.

• PGM A/B mixer B input, or PGM A/B mixer position and arm state (‘active preview AB mixer’).

• DSK sources from internal stores or external fill/key.

• PVW DSK positions, or PGM DSK positions and arm states (‘active preview keyers’)

• PVW DVE router mode, inputs, sequence and sequence action.

• PGM DVE position and arm state.

• DVE configuration.

• PST voice-over sources from internal Easyplay or external AES.

• PGM voice-over positions and arm states.

Note that the clean-feed and monitor outputs allow additional tap-off points for monitoring 
and testing, selectable at the front panel using Operate > Clean Output and Operate 
> Monitor Output.

Active Preview AB Mixer 
When ‘Active Preview AB Mixer’ is enabled, the preview background video depends on both the 
position of the program A/B mixer and its arm state. When there is no A/B mix armed, the 
preview background video follows program. If an A/B mix is then armed, the preview back-
ground video shows the transition state that will occur on program after the next “Take” 
transition.

You can set this option in the Imagestore 750 Configurator using Video > Preview > 
Preview > Active Preview AB Mixer.

When ‘Active Preview AB Mixer’ is disabled, the preview background video is controlled inde-
pendently of the program A/B mixer and its arm state. The preview A/B mixer angle is normally 
configured and remains in the ‘B channel’ position in the Imagestore 750 Configurator (Video 
> Preview > Preview > Preview AB Mixer Angle).

Active Preview Keyers 
When ‘Active Preview Keyers’ is enabled, preview keyer position depends on both the position 
of the equivalent program keyer and its arm state. Whenever a keyer is disarmed, the position of 

PGM DVE o/p  Selects output from PGM DVE as the preview output

PGM DSK1 o/p  Selects output from PGM DSK1 as the preview output

PGM DSK2 o/p  Selects output from PGM DSK2 as the preview output

PGM DSK3 o/p  Selects output from PGM DSK3 as the preview output

Selection Description

Table 4-11: Preview output options
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the equivalent preview keyer follows program. If a keyer is then armed, the preview keyer shows 
the transition state that will occur on program after the next “Take” transition. 

Note: Keyers can be armed for cuts or fades from a Miranda iMC panel, an RCP-BR / Xpanel or 
through Presmaster automation. This table shows how active preview keyers are driven based 
on the equivalent program keyer position and arm state:

You can set this option in the Imagestore 750 Configurator using Video > Preview > 
Preview Keyer Position > Active Preview Keyers, or at the front panel 
(Setup > Miscellaneous > Active Preview).

When ‘Active Preview Keyers’ is disabled, the keyers on preview are controlled independently of 
the program keyers and their arm states. Preview keyers are normally configured and remain in 
the ‘keyer up’ position in the Imagestore 750 Configurator (Video > Preview > Preview 
Keyer Position > DSK x Preview Keyer Position).

Clean-Feed Output 
You can select the video signal to view at the clean-feed output (CLN OUT). Use one of the 
following values in the front panel menu Operate > Clean Output: 

Action on PGM DSK Program Keyer Preview Keyer

Disarm DOWN DOWN

Arm to cut or fade UP DOWN UP

Take UP UP

Arm to cut or fade DOWN UP DOWN

Take DOWN DOWN

Arm to cut or fade UP DOWN UP

Disarm DOWN DOWN

Table 4-12: Active Preview Keyer behaviour

Selection Description

Programo/p Selects a copy of PGM OUT as the Clean Feed Output

SDI A Selects a copy of SDI A input as the Clean Feed Output

SDI B Selects a copy of SDI B input as the Clean Feed Output

SDI C Selects a copy of SDI C input as the Clean Feed Output

SDI D Selects a copy of SDI D input as the Clean Feed Output

PGM AB Mix Selects output from PGM A/B Mixer as the Clean Feed Output

PGM DVE o/p Selects output from PGM DVE as the Clean Feed Output

PGM DSK1 o/p Selects output from PGM DSK1 as the Clean Feed Output

PGM DSK2 o/p Selects output from PGM DSK2 as the Clean Feed Output

PGM DSK3 o/p Selects output from PGM DSK3 as the Clean Feed Output

Store 1 Fill Selects outputs from Store 1 Fill as the Clean Feed Output

Store 1 Key Selects outputs from Store 1 Key as the Clean Feed Output

Table 4-13: Clean Feed output options
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The Imagestore 750’s clean-feed output is used typically for outputting unbranded or partially-
branded version of the PGM output, which can then be redirected to other networks. It can also 
be used for monitoring video at a number of different points within the Imagestore 750, or for 
taking a copy of PGM OUT with a different audio mix. (See ‘Audio Output Cleanfeed Multiplexor’ 
in Audio Mix Blocks on page 165.) 

Monitor Output 
You can select the video signal to view at the monitor output (MON OUT). Use one of the 
following values at the front panel menu Operate > Monitor Output: 

Store 2 Fill Selects outputs from Store 2 Fill as the Clean Feed Output

Store 2 Key Selects outputs from Store 2 Key as the Clean Feed Output

Store 3 Fill Selects outputs from Store 3 Fill as the Clean Feed Output

Store 3 Key Selects outputs from Store 3 Key as the Clean Feed Output

Store 4 Fill Selects outputs from Store 4 Fill as the Clean Feed Output

Store 4 Key Selects outputs from Store 4 Key as the Clean Feed Output

SDI Fill-1 Selects a copy of SDI Fill-1 input as the Clean Feed Output

SDI Key-1 Selects a copy of SDI Key-1 input as the Clean Feed Output

SDI Fill-2 Selects a copy of SDI Fill-2 input as the Clean Feed Output

SDI Key-2 Selects a copy of SDI Key-2 input as the Clean Feed Output

Selection Description

Table 4-13: Clean Feed output options

Selection Description

Program o/p Selects a copy of PGM OUT as the Monitor Output

Preview o/p Selects a copy of PVW OUT as the Monitor Output

SDI A Selects a copy of SDI A input as the Monitor Output

SDI B Selects a copy of SDI B input as the Monitor Output

SDI C Selects a copy of SDI C input as the Monitor Output

SDI D Selects a copy of SDI D input as the Monitor Output

PGM AB Mix Selects output from PGM A/B Mixer as the Monitor Output

PVW AB Mix Selects output from PVW A/B Mixer as the Monitor Output

PGM DVE o/p Selects output from PGM DVE as the Monitor Output

PGM DSK1 o/p Selects output from PGM DSK1 as the Monitor Output

PGM DSK2 o/p Selects output from PGM DSK2 as the Monitor Output

PGM DSK3 o/p Selects output from PGM DSK3 as the Monitor Output

Store 1 Fill Selects outputs from Store 1 Fill as the Monitor Output

Store 1 Key Selects outputs from Store 1 Key as the Monitor Output

Store 2 Fill Selects outputs from Store 2 Fill as the Monitor Output

Table 4-14: Monitor output options
46



Imagestore 750
User Manual
The Imagestore 750’s monitor output is used typically for monitoring video at a number of 
different points within the Imagestore 750. The monitor output audio mix can also be changed 
dynamically using ‘Audio Output Monitor Multiplexor’. (See Audio Mix Blocks on page 165.) 

General Purpose Interface (GPI) 
The ports of the dedicated general-purpose interface (GPI) can be used either to trigger the 
execution of a series of internal pre-programmed commands (input) or to monitor the status of 
the Imagestore 750 (output). The Imagestore 750’s GPI has 16 input/output ports. 

 GPI numbering is zero-based for pinouts, automation, and the front panel. Use GPIs 
numbered 0–15.

When used as an input, a GPI input is activated as follows:
GPI On When the GPI pin is connected to 0V.
GPI Off When a GPI pin is not connected. (The GPI signal pin gets pulled high.)

When used as an output, a GPI output is as follows:
GPI Active(On) The GPI output pin is internally driven to ground by a Darlington 

transistor (Active low is represented by +0.7V or less.)
GPI Inactive(Off) The GPI output pin is internally pulled high.

Lamps or relays attached to a GPI output port can use the GP_+5V fused supply (pin 7) but the 
maximum current drawn should not exceed 500mA.

Store 2 Key Selects outputs from Store 2 Key as the Monitor Output

Store 3 Fill Selects outputs from Store 3 Fill as the Monitor Output

Store 3 Key Selects outputs from Store 3 Key as the Monitor Output

Store 4 Fill Selects outputs from Store 4 Fill as the Monitor Output

Store 4 Key Selects outputs from Store 4 Key as the Monitor Output

SDI Fill-1 Selects a copy of SDI Fill-1 input as the Monitor Output

SDI Key-1 Selects a copy of SDI Key-1 input as the Monitor Output

SDI Fill-2 Selects a copy of SDI Fill-2 input as the Monitor Output

SDI Key-2 Selects a copy of SDI Key-2 input as the Monitor Output

Colour 1 Selects a copy of Color Field 1 as the Monitor Output

Colour 2 Selects a copy of Color Field 2 as the Monitor Output

Colour 3 Selects a copy of Color Field 3 as the Monitor Output

Colour 4 Selects a copy of the V-fade color as the Monitor Output

Pattern 1 Selects a copy of Test Pattern 1 as the Monitor Output

Pattern 2 Selects a copy of Test Pattern 2 as the Monitor Output

PGM DVE1 Selects a copy of PGM DVE Input 1 as the Monitor Output

PGM DVE2 Selects a copy of PGM DVE Input 2 as the Monitor Output

PVW DVE1 Selects a copy of PVW DVE Input 1 as the Monitor Output

PVW DVE2 Selects a copy of PVW DVE Input 2 as the Monitor Output

Selection Description

Table 4-14: Monitor output options
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Where a GPI output is used to drive a relay coil, you should incorporate reverse voltage 
protection diodes in the external circuit to protect the Imagestore 750 from voltage transients.

See GPIO / LTC on page 207 for details of the GPI connector pinouts. 

The GPI ports can be used as inputs to execute a series of internal pre-programmed commands, 
or GPI ON/OFF macros. The GPI ports can also be triggered either on or off by a pre-defined tran-
sition state defined for the Imagestore 750. See GPI Inputs and Macros on page 48 and GPI 
Outputs and Events on page 50 for a description of how GPI inputs and outputs are configured. 

 Because GPI ports are shared between inputs and outputs (bi-directional), it is a common 
practice to reserve some GPI ports solely as inputs and others solely as outputs. However, 
GPI input macros can be configured to be driven from GPI output events on the same port if 
this is required. An example might be to cut up a voice-over automatically through a macro 
(input) when a DSK starts fading up (output).

GPI macros, described in the following section, are directly associated with the GPI connections 
and limited to a maximum of 32 macros (fewer when GPI outputs are defined). 

 Note that GPI macros are difficult to compose and are limited to actions that can be selected 
from the front panel’s ‘Operate’ menu. 

You can find a more versatile, extensible, and friendly way of creating macros in the Images-
tore 750 Configurator under ‘Macro Mode’. Up to 65,536 macros can be created, each of 
which can be named to help the iMC control panel meaningfully represent macros to a 
panel operator. 

Macros consist of a list of Oxtel automation commands, with delays being inserted using the 
‘Xd’ automation command. See Macros on page 50 for details. For complete details of the 
Oxtel automation protocol, see the automation publications listed under Applicable Publi-
cations and Tools on page 3. 

GPI Inputs and Macros 
Any GPI input can have two associated macros: 

• One macro associated with the GPI port transitioning on. 

• One macro associated with the GPI port transitioning off. 

Each macro can contain up to 2048 bytes of Oxtel command data. (That is approximately 200 
commands.) When the GPI is triggered, the commands within the macro are executed sequen-
tially. Pauses may be defined within the macro if they are required. The macro associated with a 
GPI input can also be set to trigger a macro that was defined in the Imagestore 750 Configurator. 

See Macros on page 50 for more details. 

To create a GPI macro from the Imagestore 750’s front panel:

• Select the appropriate GPI input event.

• Select Setup > GPI > GPI Inputs. Then choose GPI In x On or GPI In x Off. 
Here “x” represents the GPI number, from 0 to 15.

• ON macros are triggered when the appropriate GPI input is triggered on.

• OFF macros are triggered when the appropriate GPI input is triggered off.

• Press the joystick down [enter] to enter the macro editor.

• If the GPI is unused, the display shows ‘> Empty <‘.
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• Press [enter] again to access the sub-menus.

• Use the joystick arrows [] and [] to locate the first command to be added to the macro and 
press [enter].

• The front panel display returns to the macro list. One command is listed at this time.

To add a second command to the GPI macro:

1  Press [enter] and select whether to Insert Before or Insert After the selected 
command.

2  Press [enter] again to access the Operate sub-menus.

3  Use the joystick arrows [] and [] to locate the next command to be added to the macro 
and press [enter].

4  The front panel display returns to the macro command list. Now two commands are listed.

To add subsequent commands to the GPI macro:

1  Use the joystick arrows [] and [] to select the list position to which the next command 
should be adjacent.

2  Press [enter] and select whether to Insert Before or Insert After the selected 
command.

3  Press [enter] again to access the Operate sub-menus.

4  Use the joystick arrows [] and [] to locate the next command to be added to the macro 
and press [enter].

5  The front panel display returns to the macro list.

Repeat this process until the required macro is completely defined. You can add delays using the 
menu Miscellaneous > GPI Delay. The delays are defined in terms of fields (interlaced) 
or frames (progressive).

To delete a command from a GPI macro:

1  Select the appropriate GPI input event.

2  Select Setup > GPI > GPI Inputs. Then choose GPI In x On or GPI In x 
Off, where “x” represents the GPI number from 0 to 15.

3  Use the joystick arrows [] and [] to select the command to delete.

4  Press [enter] and then select Delete.

5  Press [enter] again to return to the macro command list. The command selected will have 
been removed from the list.

The appropriate macro is activated either when the connection is made (GPI On), or when it is 
switched off (GPI Off ) relative to the ground pin on the GPI connector.

To trigger a macro associated with GPI In 1 On (for example), make an electrical connection 
between pins GPI 1 and GPI GND. To trigger a macro associated with GPI In 1 Off, break the elec-
trical connection between pins GPI 1 and GPI GND.

See GPIO / LTC on page 207 for the connector pinout.

The GPI input macros defined for an Imagestore 750 are stored in /home/params/gpi.xml.
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GPI Outputs and Events 
A GPI output port can be used as an output to signal any external device according to the occur-
rence of an event within the Imagestore 750. The active status (on) is defined by the output 
being internally pulled to ground. 

To configure the events that trigger GPI outputs on or off, use the Imagestore 750’s front panel:

1  Select the GPI Output (ON or OFF) to configure:

2  Select Setup > GPI > GPI Outputs. Then choose GPI Out x On or GPI Out 
x Off, where “x” represents the GPI number from 0 to 15.

3  If the GPI is unused, the display shows ‘> None <’.

4  Use the joystick arrows [] and [] to select the event to control the GPI output port.

Events triggers can be set to a number of different good and bad states relating to:

• External reference signal.

• SDI video inputs.

• Temperature.

• Voltages.

• Power supplies.

• Fans.

• Slave connection.

• Router connection (if IS-750-Master-Control option is enabled).

• Network interface.

• Disk usage.

• A/B mixer.

• DSK fader position and fade-to-black position.

• DSK timers.

• Store loading.

• DVE modes, playing or stopped.

• EAS running or stopped.

• Audio mixing, fade to silence, voice-overs, and follow FTB setting.

• Audio loss or type change (embedded or external AES).

 Note: Appendix B presents a full list of event types. 

You can also set GPI outputs on or off using the Operate > GPI Output front panel menu. 
Automation can set GPI outputs too. 

The GPI output events defined for the Imagestore 750 are stored in /home/params/gpi.xml.

Macros 
The GPI macros, introduced in General Purpose Interface (GPI) on page 47, are directly associ-
ated with the GPI connections and limited to a maximum of 32 macros (or fewer, when GPI 
outputs are defined). 

GPI macros are also difficult to compose and are limited to actions that can be selected from the 
front panel’s ‘Operate’ menu. You can find a more versatile, extensible, and user-friendly way of 
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creating macros in the Imagestore 750 Configurator under ‘Macro Mode’. Up to 65,536 macros 
can be created, each of which can be named to help the iMC control panel represent macros 
meaningfully to a panel operator. Macros consist of a list of Oxtel automation commands, with 
delays being inserted using ‘Xd’ automation commands.

 For details of the Oxtel automation protocol, see the automation publications listed under 
Applicable Publications and Tools on page 3. 

Adding Macros 
Go to the drop-down list at the top right corner of the Imagestore 750 Configurator and select 
‘Macro Mode’ to view, edit, or create a macro. 

Choose File > New or File > Open to create or edit a macro file. Right-click the panel on 
the left side of the Imagestore 750 Configurator below the list of macros: 

Fig. 4-10: Configurator - Macro commands

The commands are as follows: 

You can also modify the macro name and ID in the right-hand panel of the Imagestore 750 
Configurator. A macro ID must be a unique integer from 0x0 to 0xFFFF.

To edit a macro, select the macro you wish to edit from the list on the left-hand side of the 
Imagestore 750 Configurator. Right-click over the central (grey) panel: 

Fig. 4-11: Configurator - Macro edit commands

Choose one of the following commands.

• Add command.

• Move commands up — available only when one or more commands are selected.

• Move commands down — available only when one or more commands are selected.

• Delete command — available only when one or more commands are selected.

Add Oxtel automation commands in the “command” column. You can add descriptive 
comments to the “comments” column. Comments do not affect operation.

After all required macros have been created, save the file to the Imagestore 750. Use the 
command

New... Create a new macro. A prompt will request a name for this macro.

Modify ID Change a macro’s unique ID.

Rename Rename a macro.

Delete Remove a macro from the list.
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File > Save As > To Device... 

and specify the file name (‹macro preset filename›.xml).

Next, adjust the Imagestore 750’s active configuration to make use of the newly created macro 
preset file. In the drop-down list at the top right corner of the Imagestore 750 Configurator, 
select ‘Configuration Mode’. Re-load the active configuration if required (File > Open > 
From Device... > Active Configuration). Under the ‘System Settings’ tab, choose: 

Miscellaneous > Macro  

Select the newly created macro preset file name from the ‘macro preset file’ list box and then 
save and apply the updated configuration file (File > Save and Apply Configuration). After the 
Imagestore 750 has restarted, all macros within the selected macro preset file will be available 
for use.

Triggering Macros 
You can trigger macros directly in these ways: 

• At the front panel using Operate > Trigger Macro.

• Setting a GPI input to trigger a macro. (See GPI Inputs and Macros on page 48.)

• Through automation.

• Through an iMC control panel (if the Imagestore 750 has the master control option).

Graphics Co-Processors 
The Imagestore 750 can be configured for use with Miranda’s Intuition XG (a single-channel 
advanced HD/SD graphics co-processor).

The Intuition XG can be regarded as a co-processor. It can generate complex output incorpo-
rating multiple objects (animations, clips, images, and text) on numerous “virtual” keying layers. 
These scenes can then be composited into one signal that is fed into the Imagestore 750 
through the fill and key inputs and keyed as a ‘Load Live’ signal on any of the available keying 
layers. When this signal includes embedded audio, it can provide background audio or voice-
over input to the Imagestore 750.

An Imagestore 750 with an Intuition XG co-processor is often called a “channel” or “channel 
processor” because it collectively manages all of the video signals, effects, graphics and audio 
processing that are output from the Imagestore 750.

When such a “channel” is being driven by Oxtel-protocol automation, it is generally recom-
mended that the Imagestore 750 and Intuition XG co-processor to be controlled from 
independent serial automation links. However, the Imagestore 750 can also be placed in a mode 
where it receives all commands on a single automation link and then forwards selected layer-
based commands to the Intuition XG co-processor over a serial or network link. This is described 
in more detail under Oxtel Command Forwarding to a Co-Processor, following.

When such a “channel” is being driven by Presmaster-protocol automation, there is only one 
serial link from automation to the Imagestore 750. Any automation commands intended for the 
Intuition XG co-processor are sent as “pass-through” commands. 
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Oxtel Command Forwarding to a Co-Processor 
Refer to Serial Connection to Intuition XG on page 207 for information on connecting the 
Imagestore 750 and Intuition XG for command forwarding over a serial connection.

The keying layer parameter in the Oxtel automation protocol is always represented by a single 
zero-based ASCII character in hexadecimal. The character can range from 0x0 to 0xF. The 
numbers for the four   keying layers are reserved. The higher numbers are then used to address 
layers on the associated graphics co-processor according to the following table: 

For example, if an Imagestore 750 receives a command to load a graphic into layer 0x4, it will 
forward this command to the co-processor to load the graphic into the first keying layer. To do 
this the Imagestore 750 subtracts 4 from the layer value before relaying the command. 

Commands forwarded by the Imagestore 750 can potentially address up to 12 keying layers on 
the co-processor. However, the usable range is 0x0 to 0xB because Intuition XG supports a 
maximum of 8 keying layers.

Command forwarding is supported for the following Oxtel automation commands: 

Layer Number Co-Processor Layer Number Co-Processor

0x0 (DSK 1) 0x8  0x4  

0x1 (DSK 2) 0x9  0x5  

0x2 (DSK 3) 0xA  0x6  

0x3 (DSK 4)  0xB  0x7  

0x4  0x0  0xC  unused

0x5  0x1  0xD  unused

0x6  0x2  0xE  unused

0x7  0x3  0xF  unused

Table 4-15: Oxtel Command Keying layer forwarding to a Co-Processor

Cmd Description Cmd Description

0  Fade To/From Black  Z2  Change Text Font and Color

1  Fade Keyer Up/Down Z3  Render Box

2  Cut To/From Black Z4  Change Image

3  Cut Keyer Up/Down Z5  Run Strap

@  Set Fader Angle Z6  Set Text Background to Matte

B  Set Transition Duration Z7  Set Text Background to Gradient

8  Load Image From Library Z8  Set Text Background to Clear

A  Erase Store Z9  Set Text Drop Shadow

O  Enquire Loaded Image Status ZA  Set Transparency

F  Set Clip Gain Transparency ZB  Set Text Tracking

R0  Load Image ZC  Set Strap Speed

R1  Save Image ZD  Set Template Background

Table 4-16: Oxtel Commands supported by Command Forwarding
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 Note: Some of the commands listed above are not supported by the Intuition XG, but are 
included to support alternative (legacy) slave devices. 

To configure an Imagestore 750 to forward commands onto a graphics co-processor, connect a 
serial link between the Imagestore 750 and the co-processor. Set the protocol and Baud rate for 
the serial port as follows:

• Setup > Serial Comms > Serial Ports > COM x > Protocol > Oxtel Slave 

• Setup > Serial Comms > Serial Ports > COM x > Baud Rate > 19200  
(e.g., for Intuition-XG). 

For the Imagestore 750 to know what is on the Intuition XG’s program and cue, the Imagestore 
750 must be set to get the “correct” tallies from the Intuition XG. To do this, configure:

Setup > Slave > Slave Type > Int-XG

Note that the Imagestore 750 also has the ability to control a co-processor over a network. This 
can be set up in the ‘slave’ section of the Imagestore 750 Configurator or using the Imagestore 
750’s front panel Setup menu.

Automatic Keyer Management 
Automatic keyer management options can be used in conjunction with command forwarding 
to simplify the control of Imagestore 750 and graphics co-processor keying layers. 

Whenever the Imagestore 750 receives a command from automation to cut up a layer on the co-
processor, the automatic keyer management options permit a ‘Load Live’ to occur with the asso-
ciated keying layer on the Imagestore 750 being cut up automatically. Also, if automation cuts 
down all co-processor layers, the Imagestore 750 can cut down the associated keying layer and 
turn off ‘Load Live’.

Set up the automatic keyer management options in the Imagestore 750 Configurator or using 
the following front panel menu options:

• Setup > Slave > Keyer Assign 

Assigns automatic keyer management to one keying layer of the Imagestore 750.
• Setup > Slave > Keyer Follow Up 

R3  Enquire File Information ZE  Set Text Alignment

Rm  Image Load Mode ZF  Set Text Wrapping

RA  Validate template Zd  Text Box Update

S0  Start Animation Ze  Image Update

S1  Stop Animation Zg  Pause/Restart Animation

S2  Select Animation Frame m0  Set Global Datasource Value

S4  Restart Animation m1  Delete Global Datasource

Y6  Enable Video Tallies m2  Set Layer-Specific Datasource Value

Z0  Update Text Field m3  Delete Layer-Specific Datasource

Z1  Change Box Size and Position m8  Delete All Datasources

Cmd Description Cmd Description

Table 4-16: Oxtel Commands supported by Command Forwarding
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Defines whether the assigned keyer of the Imagestore 750 is cut up automatically when 
there is some keyer activity on the co-processor layers.

• Setup > Slave > Keyer Follow Down 

Defines whether the assigned keyer of the Imagestore 750 is cut down automatically when 
there is no keyer activity on the co-processor layers.

• Setup > Slave > Fill&Key Input 

Determines which external fill and key pair is routed to the assigned keyer for automatic 
keyer management.

The status of the co-processor layers controlled by command forwarding can be monitored 
from the Setup > Slave > Keyer Status front panel menu.

 Note: Automatic keyer management works correctly only when used in conjunction with 
command forwarding. This is because the Imagestore 750 maintains the layer status 
(including keyer arm states) of the graphics co-processor based on the automation 
commands it forwards to the co-processor and the tallies that it receives from the co-
processor as the status of its layers changes. The Imagestore 750 always uses tallies from the 
co-processor to determine exactly when slave layers cut down because they often contain 
out-transitions of indeterminate duration.

In the master control environment, we recommend that ‘Keyer Follow Up’ be disabled so that 
Intuition XG graphics can be previewed by iMC panel users without automatically appearing on-
air. Automation then must be responsible for cutting up the appropriate assigned DSK with 
Intuition XG layers.

Example 
Following is an example of automation cutting up two layers on a graphics co-processor by 
using command forwarding through an Imagestore 750 with the following settings:

1  Cut up one co-processor layer ‘34 1’.

The Imagestore 750 maps the command ‘34 1’ to ‘30 1’ and forwards it to the co-processor.

The co-processor cuts up its first layer.

The Imagestore 750 performs ‘Load Live’ on DSK 1 using Fill-1/Key-1.

The Imagestore 750 cuts up its own DSK 1.

The co-processor output is now visible.

2  Cut up another co-processor layer ‘36 1’.

The Imagestore 750 maps the command ‘36 1’ to ‘32 1’ and forwards it to the co-processor.

The co-processor cuts up its third layer.

The Imagestore 750 does nothing with its own keying layers.

3  Cut down one of the co-processor layers ‘34 0’.

The Imagestore 750 maps the command ‘34 0’ to ‘30 0’ and forwards it to the co-processor.

Default Keyer Assign   DSK 1 (which is initially cut down)

Keyer Follow Up   Enabled

Keyer Follow Down   Enabled

Fill & Key Input   Fill-1/Key-1
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The co-processor completes any out-transitions and then cuts down its first layer.

The Imagestore 750 receives a ‘30 0’ tally command from the co-processor, but does nothing 
with its own keying layers because there is still one co-processor layer active.

4  Cut down the final visible layer of the co-processor ‘36 0’.

The Imagestore 750 maps the command ‘6 0’ to ‘32 0’ and forwards it to the co-processor.

The co-processor completes any out-transitions and then cuts down its third layer.

The Imagestore 750 receives a ‘32 0’ tally command from the co-processor, and then cuts 
down DSK 1 because there are no co-processor layers active.

Note that ‘Default Keyer Assign’ can be cut down (or up) at any point to override the automatic 
keyer management.

 In the master control environment, we recommend that ‘Keyer Follow Up’ be disabled so 
that Intuition XG graphics can be previewed by iMC panel users without automatically 
appearing on-air. Automation then must be responsible for cutting up the assigned DSK 
with Intuition XG layers.

Closed Captions 
Closed caption information is usually passed through the Imagestore 750 regardless of what the 
closed caption option is. The reason for the option is that when the standard is set as NTSC (525), 
closed caption information is found within the active picture (lines 20 and 21), and it will be 
destroyed when graphics are keyed over these lines. 

When the closed caption option is enabled (Setup > Miscellaneous > Closed Cap at the 
front panel menu), the Imagestore 750 ensures that the close caption information is preserved 
regardless of keyed graphics being present on lines 20 and 21. Disabling the option instructs the 
keyers and mixers to treat these lines as part of the active picture so that they may be mixed 
with the key.

For HD, closed caption information is contained in vertical ancillary data (VANC) on line 9, which 
is outside the active picture. Because this information is never processed by the keyers, the 
closed caption information is preserved, regardless of the option selected.

Please note that when an SDI picture is routed to a DVE, the closed caption information might 
be visible at the top of the DVE window. To avoid this problem, we recommend that all DVE 
sequences be cropped by 2.5% at the top to remove this undesirable effect.

Timecode 
The following timecode formats are supported by the Imagestore 750:

• Linear (or longitudinal) timecode (LTC).

Received on the GPI/LTC port (or its 44-pin terminal block adaptor). (See GPIO / LTC on 
page 207.) 

Supports dropframe and non-dropframe.

Supports forward and backward directions.

• Vertical interval timecode (VITC).

Received from the external reference.

Supports dropframe and non-dropframe.
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When it is physically connected and activated, the LTC or VITC timecode source is used to adjust 
the internal clock once per minute. When a timecode source is not connected, an NTP server can 
be used to update the system clock periodically. Alternatively, the internal clock will free run. 

Timecode source, timecode status, and clock time can be viewed using the Setup > Timecode 
front panel menu.

Message Logging 
The Imagestore 750 generates message logs to record warnings and errors during operation, 
and (optionally) to record commands received from automation. The message log file can help 
diagnose a range of different issues, from invalid parameters in automation commands to hard-
ware faults. 

The Imagestore 750 maintains two message log files:

• The file messages records log messages since the Imagestore 750 was powered on. 

• The file messages.old records log messages for the previous powered session, in case the 
Imagestore 750 was restarted after a failure.

Message logs can be downloaded from the Imagestore 750 web page as described in System 
Information on page 179. 

Logging Level 
Set the logging level using Setup > Logging > Logging Level at the front panel 
menu. The possible options are: 

External Logging 
Set the IP address of an external logging server using Setup > Logging > Logging 
Server at the front panel menu. This allows a remote syslog2 server to be set up, permitting 
log files to be logged externally. 

Setting up a syslog server is well-documented on the Internet; however Miranda Customer 
Support can also provide details. 

Logging Level Description

Errors Only  Reports errors, including automation commands that were invalid when received. 
No valid automation commands are logged in this mode.  

Media/Keying  Records all valid media and keying activity (in addition to errors). This provides a 
full audit of graphics that have appeared on-air.

Verbose  Provides a full record of all automation commands received by the Imagestore 
750, whether valid or not.

Verbose+OxSox  Provides a full record of all Oxtel automation and OxSox commands received by 
the Imagestore 750, whether valid or not.

Table 4-17: Imagestore 750 Logging Levels

2.  “Syslog” is a standard for forwarding log messages in an IP network.
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Local Logging 
You can enable or disable local logging to the hard disk or solid-state data storage using Setup 
> Logging > Local Logging at the front panel menu. Disabling local logging writes the 
message log to a (volatile) RAM disk thereby reducing wear to the internal hard disk or solid-
state storage. When the Imagestore 750 is restarted or shut down safely from the front panel, 
the volatile message log is automatically copied into physical storage for future reference. 

Note: When local logging is disabled, the message log will be lost if you restart the Imagestore 
750 by pulling out the power cable. 

System Configuration 
 See Chapter 8 for complete details regarding the Imagestore 750 Configurator.

Different Imagestore 750 system configurations can be created for different applications. For 
example, the Imagestore 750 can be switched between different video standards if you create 
two configurations and then import the appropriate configuration file when a change is 
required. You can use the Imagestore 750 Configurator, or the front panel’s ‘User Presets’ menu 
to do this. 

 Note: A device restart is required after a new configuration is imported, so updates cannot 
be made while on-air.

System configurations may also be transferred between Imagestore 750’s during commis-
sioning to ensure consistency of state between them. This is most easily achieved using the 
Imagestore 750 Configurator. After an import, all settings within the selected configuration file 
are validated against the capabilities of the new Imagestore 750 to ensure that differences in 
hardware or options are handled correctly.

Please refer to the following sections for more information on the main system configuration:

Configuration Mode page 156

Saving a Configuration page 175

Importing a Configuration page 175

Video Bypass 
In the event of power loss to the Imagestore 750, or failure of both internal power supplies, the 
mechanical video relay bypass routes ‘A In’ (as a background signal) directly to the program 
output (PGM OUT) and routes ‘C In’ to preview output (PVW OUT). 

(The relays switch to the bypass position when powered off.)

This feature is an emergency failsafe and is completely non-synchronous in operation. During 
boot-up, the bypass is maintained until the Imagestore 750 is fully operational. At switch-over, a 
glitch in the video is to be expected. (A jump in video and audio might also occur if delays are 
applied under normal operation.)
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Chapter 5 presents information regarding the Imagestore 750’s master control option. 

Topics
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 59 
Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 61
Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 61
Imagestore 750 Configuration Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 62
Hardware Connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 67
Software Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 70

Overview 
Miranda’s iMC master control system has many modular parts and provides many options. You 
can order a master control system that is optimal for your facility. It can change with your needs. 

The Imagestore 750’s master control option (IS-750-Master-Control) gives you a powerful master 
control switching and branding system designed specifically for automated, multi-channel envi-
ronments. The Imagestore 750 controls upstream router switching through a Miranda NV9000 
router control system, and interfaces with Miranda’s iMC control panels which allow manual 
preview and override of channels. 

At the heart of a master control system are transition processors: MCEs and Imagestore 750s. 
MCEs reside in NV5100MC frames; the Imagestore 750 stands by itself as a 1RU processor. The 
iMC system can be composed 3 ways: 

1  Imagestore 750s transition processors (a.k.a. “channel branding processors”), an NV9000 
router control system, and iMC control panels.

The Imagestore 750s can be used with Intuition XG graphics processors for advanced graph-
ics effects.

2  MCEs (master control engines) residing in NV5100MC frames, control panels, and optionally 
an NV9000 router control system.

The MCEs can also be used with Intuition XG graphics processors for advanced graphics 
effects.

3  A combination of 1 and 2.

Each channel processor provides the output for a single broadcast channel (or backup channel) 
by taking video (with embedded audio) signals from an upstream router, mixing signals and 
superimposing graphics that brand the channel.

Imagestore 750s always control the upstream router sources through an NV9000 router control 
system and the router(s) in turn provides the video and audio inputs to the Imagestore 750s. 
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Panel users can acquire and control both Imagestore 750s or MCEs with an iMC control panel. 
Existing broadcast facilities equipped with MCEs can be expanded by adding Imagestore 750s 
to create a hybrid master control system.

The following iMC control panels support Imagestore 750s and MCEs:

• iMC-Panel-300

A large panel with a large touchscreen, function buttons, control knobs and joystick. 

Its main function buttons rows have 24 buttons.

• iMC-Panel-200

A medium-size panel with a large touchscreen, function buttons, control knobs and joystick. 

Its main function buttons rows have 16 buttons.

• iMC-Panel-100 (supported in later IS-750 software version)

A two-part panel with large touchscreen, function buttons, and control knobs. 

One part is a slim, light-weight, 3RU rack-mountable button panel. The other part is a VGA 
monitor. The VGA monitor can be a touchscreen. If it is not, it is operated with a mouse.

Its function buttons rows are 16 buttons wide.

• iMC-Panel-GUI

A software panel (i.e., GUI) with large menu area, function buttons, and other controls.

It emulates the iMC-Panel-200.

For more information, please refer to any of the iMC panel user’s guides listed under Applicable 
Publications and Tools on page 3.

 Note: MCE-based channel processors are outside the scope of this manual. Please refer to 
the MCE publications Applicable Publications and Tools on page 3 for details of the MCE 
features, configuration and operation. 
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Devices 
Without further consideration of MCEs, these are the components of a master control system 
that incorporates Imagestore 750s. Here, the NV9000 system is a requirement: 

Fig. 5-1: Master Control Devices diagram

he Imagestore 750s communicate with the following devices:

• Miranda iMC master control panels over an Ethernet LAN.

• Miranda NV9000 router controller over an Ethernet LAN.

• Automation. 

The automation connection can use Miranda’s Presmaster serial protocol or it can use 
Miranda’s Oxtel protocol serially or over Ethernet.

• Miranda Intuition XG serially or over Ethernet.

Features 
A master control system includes:

• Router control system.

An NV9000 router control system that switches a router as required by the Imagestore 750.

Configuration of router sources, source groups and salvos for each channel.

Automatic retrieval of source names from the NV9000 system with channel-specific source 
name overrides.

Selectable router sources for program, preset and aux buses.

• Transition processor(s).

Switching and mixing of input sources to contribute to the broadcast channel’s output.

Hot-cut transitions on the program bus for video source, keyers, DVE moves, voice-overs and 
macros.
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Armable transitions for A/B mixing, keyer cuts/fades, DVE moves, voice-overs and macros.

Arm and take capability for synchronizing an overall transition, with preview of the upcom-
ing video and audio on preset (a.k.a. preview) output.

Configurable wide-audio shuffles with individual channel gains saved for each source.

• Channel branding.

Full integration with Intuition XG to provide advanced graphics effects.

Internal graphics generation on four keying layers for still images, animations, text “straps” 
and clocks.

Single- or dual-window 2D DVEs for squeeze-and-reveal and picture-in-picture effects.

Independent control of graphics keying and DVE moves on program and preview.

• Control panels. 

iMC control panels that allow manual preview and override of channels with an acquisition 
time of under 3 seconds.

Support for multiple panel users using a mixture of hardware and software control panels.

Configurable channel acquisition privileges (permissions) for different panel users.

Panels that control channel settings including automation on/off, source selection (on the 
program, preset, and aux buses), hot-cuts, and arm/take transitions.

Browsing of graphics and audio files using thumbnail proxies, editing of source groups and 
audio configuration.

Option to show the current source at all times (even when the source selection is not in the 
active source group).

Globally active source group shared between panels.

• Monitoring.

Audio level metering.

Selectable video and audio outputs on preview, clean-feed, and monitor outputs.

Dynamic monitor wall updates on channel changes for viewing all channel inputs and out-
puts.

• Automation.

Support for Presmaster automation protocol.

Support for Oxtel automation protocol.

Imagestore 750 Configuration Overview 
The Imagestore 750’s master control option adds additional capabilities to the Imagestore 750’s 
software architecture which must be configured correctly if all of the devices in the master 
control system are to communicate with one another successfully. 

These are the aspects of Imagestore 750 configuration that relate specifically to master control:

• NV9000’s IP address.

• Channel sources

• Source groups.

• Router salvos
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• Router destinations

• Router sources.

• Intuition XG graphics co-processor providing fill and key signals.

• Channel acquisition and ownership.

• Monitor wall (optional).

Version 1.5, or later, of the Imagestore 750 Configurator is required if you are to support these 
features. 

Configuration of the Imagestore 750’s master control option is described in the following 
sections and partially involves other components of the iMC master control system (e.g., the 
NV9000 router control system and the iMC panels). These other components are mentioned 
where they are part of the steps of Imagestore 750 configuration.

NV9000’s IP Address 
The IP address of the NV9000 router control system is an essential part of the Imagestore 750 
configuration. Without it, the software cannot configure the sources, destinations and salvos for 
the router and the Imagestore 750 cannot function in the master control system. The IP address 
may be a physical IP address (if you have a stand-alone NV9000 system controller), or a “virtual” 
IP address (when you have a redundant pair of NV9000s).

Note: This document does not address the configuration of the NV9000 router control system. 
Please refer to the NV9000 documentation, specifically the NV9000-SE Utilities Users Guide, listed 
under Applicable Publications and Tools on page 3.

Channel Sources 
Routers come in many different sizes, from a very few to thousands of sources and destinations. 

A channel processor might require access to video signals from all of the available router 
sources, or (for large routers) a subset of them. The Imagestore 750’s master control configura-
tion allows the required router sources to be included in a list known as the channel sources. 
These sources are made available for the channel processor to use. 

The names (e.g., VTR 23) of channel sources are automatically retrieved from the NV9000 router 
control system. The NV9000’s source name can be overridden (mapped) in the Imagestore 750 
master control configuration by locally defined names. These source names allow iMC control 
panels to represent router sources in human-readable form on button legends.

 The names of channel sources must be ASCII. 

Within the master control configuration, you can define audio gain and audio shuffle presets for 
each channel source. These allow each source to be independently gain-adjusted or shuffle-
adjusted to compensate for any upstream audio faults or peculiarities. 

Channel sources are updated dynamically following any changes to the router sources in the 
NV9000 router control system. When the name of a router source changes in the NV9000, the 
equivalent channel source name is automatically updated on an iMC panel (assuming it was not 
overridden with a locally defined name). When a router source is deleted from the NV9000, it is 
still visible on the iMC panel but can no longer be selected. If new router sources are added to 
the NV9000, they will not be seen at the iMC panel because they are not available in one of the 
pre-defined source groups.
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Source Groups 
A source group is a set of sources chosen from all of the available channel sources. They allow 
iMC panel operators to select between different groups of sources using ‘Group Select’ buttons. 
When a source group button is pressed, the sources included in that group are mapped onto 
the program, preset, and aux buttons of the panel. 

The Imagestore 750’s master control configuration allows the definition of any number of 
source groups. The number of entries in each source group is generally chosen to equal the 
number of panel buttons allocated for sources on the iMC control panel. When a broadcast 
facility has a mixture of different panel sizes, you can configure source groups of different sizes 
for use with the appropriate panels. (A source group can have up to 24 entries because the 
maximum number of source buttons on any panel is 24.) 

Sources can be included multiple times within a source group, and the same source can also be 
used in multiple source groups. For example, the main network feeds can be placed on the left-
most 2 buttons of every source group to make them easier to select in an emergency. There can 
also be gaps within source groups. Where a source group has gaps in it, the source buttons on 
the iMC panel are disabled and darkened. Pressing a disabled source button does nothing.

 The names of source groups must be ASCII. 

Router Salvos 
A salvo is a sequence of router control commands — defined in the NV9000 router control 
system — that will execute, in order, when the salvo is invoked either by a button press or a 
channel change at a panel. Salvos can be used by iMC panels during a channel acquisition to 
route the Imagestore 750’s outputs to a monitor wall, or to perform other custom monitoring 
tasks when the user presses a ‘Salvo’ button on the iMC panel.

Note: Salvos must be defined in the NV9000 configuration software, which is outside the scope 
of this document. Please refer to the NV9000 documentation, specifically the NV9000-SE Utilities 
Users Guide, listed under Applicable Publications and Tools on page 3.

Router Destinations (Feeding Program and Preset Inputs) 
In the iMC master control system, a router destination is synonymous with an output (from the 
router) and a router source is synonymous with an input (to the router).

Router destinations and sources are set up during configuration of the NV9000 Router 
Controller and each may comprise one or more feeds.

A router’s function is to connect its sources to its destinations. 

The Imagestore 750’s settings for router destinations identify the NV9000’s router destinations 
that feed its program and preset inputs. The program bus receives input at the A IN connector. 
The preset (a.k.a. preview) bus receives input at the B IN connector. The settings represent phys-
ical connections between the router and the Imagestore 750.

As a panel operator selects a video source on the program or preset bus of the panel, the 
Imagestore 750 issues commands to the NV9000 system controller to perform appropriate 
source switches. Pressing a program source button performs a “hot-cut” of the video source on 
the channel processor’s program bus. Pressing a preset source button changes the video source 
on the channel processor’s preset bus showing the source to which the A/B mixer will next tran-
sition. All source switches in the router are tallied back to all iMC control panels that own the 
channel.
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Router Destination (Feeding AUX) 
This is a setting that identifies the NV9000 router destination that feeds an auxiliary device such 
as a waveform monitor. The setting represents a physical connection between the router and 
the auxiliary device.

As a panel operator selects a video source on the aux bus, the Imagestore 750 issues commands 
to the NV9000 system controller to perform appropriate auxiliary source switches. In that way, 
the panel operator controlling an Imagestore 750 has an “extra” set of controls (i.e., the aux 
buttons) with which to view sources on a monitor, or to route sources to some other device for 
another purpose. All source switches are tallied back to all iMC control panels that own the 
channel.

Router Sources (Fed by PGM, PST, CLN, and MON Outputs) 
 Note: See the definitions of router sources and definitions under Router Destinations 

(Feeding Program and Preset Inputs) above. 

These settings identify the NV9000 router sources that are fed by the Imagestore 750’s program, 
preview, clean-feed, and monitor outputs. Connections to these sources allow the NV9000 
system to route the Imagestore 750’s outputs to a local monitor wall.

These settings represent physical connections between the Imagestore 750 and router. Conse-
quently unique sets of sources must be defined for every Imagestore 750 within the Master 
Control system.

Router Source (Fed by BLACK/SILENCE) 
This setting identifies the NV9000 router source that corresponds to black/silence in a video 
standard that is appropriate for this channel processor. The source allows the NV9000 system to 
route black/silence to the local monitor wall when gaps appear within the current source group. 

Router Source (Fed by USER 1-20) 
These 20 settings identify the NV9000 router sources corresponding to custom-defined sources 
for this Imagestore 750. Such sources can be used to route outputs from a backup channel 
processor to the local monitor wall, or to view “mirrored” HD/SD channel processors in parallel. 

Graphics Co-Processor Feeding Fill and Key 
The Intuition XG co-processor (also known as the “slave” device) provides advanced graphics to 
the Imagestore 750 using one of the 3 available external fill and key inputs. The graphics are 
then keyed onto the video background signal using any of the 4 available keyers (DSKs). The fill 
provides the graphics signal, and the key provides the transparency.

You can use the Imagestore 750 configurator to identify which external fill and key inputs 
receive signals from the Intuition XG. The configuration also specifies to which DSK layer 
external graphics are assigned and specifies the automatic keying behavior of the assigned DSK 
as Intuition XG layers cut up and down. 

You should also configure the system to allow slave layer states and other system information to 
be communicated between the Imagestore 750 and the Intuition XG. This can be done over an 
RS-232 serial connection or over Ethernet. 
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Channel Acquisition and Ownership 
A typical broadcast environment will include multiple channel processors and multiple iMC 
panels. 

Sometimes each channel processor has a dedicated control panel, perhaps with a “super-user” 
panel operator who is able to take over control of channels in emergencies. Alternatively, panel 
operators may be responsible for monitoring and controlling several different channels. Flexible 
arbitration of channel ownership between different panels is therefore provided for master 
control environments.

The iMC panels have 4 channel acquisition methods (grab, drop, kick, share) to establish owner-
ship of Imagestore 750 channel processors:

• “Grab” — acquire ownership of a channel. A grab can succeed only if the channel is not 
already owned by another panel or shared by other panels.

• “Drop” — release ownership of a channel. This method places the panel in a “no channel” 
state.

• “Kick” — force the current channel owner(s) to drop a channel. The success of this command 
depends on relative panel permissions and the ‘allow kick’ setting of the owning panel.

• “Share” — acquire joint ownership of a channel that is already owned by one or more panels. 
The success of this command depends on the ‘allows sharing’ settings of the panels.

Channels can be owned by one panel, or shared by multiple panels if channel sharing is 
enabled. When a panel already has ownership of a channel, other panels can attempt to kick-off 
the owning panel to gain sole ownership for themselves. Alternatively, they can attempt to 
share ownership with the current owner.

A flexible set of panel and channel ownership privileges and permissions allow for the many 
possible permutations of panel setups at different broadcast facilities. 

Each iMC panel is configured with (1) an ownership permission level, (2) rules for being kicked 
and (3) rules for allowing channel sharing with other panels. Imagestore 750s can also impose 
kick and share behavior on panels that want to control them based on relative permission levels. 
This gives a flexible mixture of channel ownership models for different users.

Please see Panel Permissions Configuration on page 91 for further details on channel ownership 
permissions and other settings. 

Monitor Wall 
Usually there is a dedicated monitor wall for every iMC panel. This monitor wall is used to view 
the sources and the channel outputs that are relevant to the local panel.

When a panel acquires a channel, it causes the NV9000 system to make the appropriate router 
switches so that its local monitor wall shows the appropriate Imagestore 750 outputs (program, 
preset, clean-feed, and monitor), the current aux bus selection, and all of the sources within the 
panel’s currently selected source group. This gives the panel operator a complete view of the 
on-air channel output, any upcoming transitions, and all alternative sources.

Use the MCS Panel Configuration Editor to identify the router destinations that feed the local 
monitor wall. The router destinations physically connected to the monitor wall.

Monitoring of the channel outputs (program, preset, clean-feed, and monitor) can be achieved 
in two different ways:
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• When a panel acquires a channel, it causes the NV9000 system to make appropriate router 
switches from the sources being fed by the channel outputs to the monitor wall destina-
tions. 

This is the preferred method despite its requiring configuration of both the Imagestore 750 
and iMC panel(s). (See Router Sources on page 85 and Monitor Wall Configuration on 
page 95.) 

• When a panel acquires a channel, it can fire a “channel acquisition salvo” for the channel/
panel combination to make the appropriate router switches for the monitor wall. The disad-
vantage with using salvos is that every existing panel configuration must be updated when 
new channels are added to the broadcast facility. 

See Applicable Publications and Tools on page 3 for information about software tools.

Hardware Connections 
Installing the Imagestore 750 and configuring it to operate with an NV9000 system and iMC 
control panels is relatively simple if you complete a few specific (and simple) tasks.

Cable Connections 
Installing the Imagestore 750 master control system involves making cable connections and 
describing those connections in NV9000-SE Utilities, in the Imagestore 750 Configurator, and in 
various iMC control panel configurations. These are the basic connections: 

Fig. 5-2: Master Control System - Cable Connections

The NV9000 system controls an NVISION series digital video router (such as an NV8576 or 
CR3232-HD). The router provides signals that are controlled by the Imagestore 750. The Images-
tore 750 receives commands from automation and master control panels and relays those 
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commands to the NV9000 whereupon the NV9000 switches sources to the destinations of 
interest.

Two of the router destinations must connect directly to the Imagestore 750. The other destina-
tions related to the Imagestore 750 connect to other equipment. 

Cable connections are required for each of the following system components:

• Digital video router (with support for embedded audio).

• NV9000 router control system.

• Imagestore 750 with optional Intuition XG graphics co-processor.

• Automation.

• iMC panel(s).

• Monitor wall(s).

• Configuration PC.

Note: When you are cabling a channel, please refer to individual documentation for these 
system components. 

Video Connections 
Note: the Imagestore 750’s video connectors are 75W BNCs.

The following video connections must be made when configuring a master control system:

• Connect two of the router’s destinations directly to the Imagestore 750, one to the A input 
and one to the B input. A third router destination connects to an auxiliary device. 

It is possible to connect the router’s aux destination directly to the Imagestore 750’s C input 
which is directed internally to the Imagestore 750’s clean feed or monitor output, if extra 
audio processing is required. However, doing this prevents multiple Imagestore 750s from 
sharing an auxiliary device.

• If multiple Imagestore 750s are to share a monitor wall, feed the Imagestore 750’s program, 
preset, clean-feed, and monitor outputs into the router, as sources, so that they can be used 
by the monitor wall.

• Make video connections between the router and monitor wall(s). The number of connec-
tions depends on your system monitoring requirements, the number of monitor walls, and 
the number of control panels. There will normally be 4 for the outputs of each Imagestore 
750, plus the a number of connections equal to the size of the largest source group for all 
panels. An additional connection would be required if you want aux output to appear on the 
monitor wall. 

It is typical for a master control system to have one monitor wall for each control panel. That 
is not a requirement. In any case, the number of connections to any single monitor wall 
remains fixed no matter how many channels or panels are present in the system.

• If your Imagestore 750 uses an Intuition XG co-processor, connect the Intuition XG’s fill and 
key outputs to one of the fill/key input pairs of the Imagestore 750.

Network Connections 
Follow these steps to make network connections: 
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NV9000
1  Using the NV9000’s master control network port, connect the NV9000 to the master control 

network switch. Assign an IP address to the NV9000’s master control network port. (See 
Applicable Publications and Tools on page 3.)

The default IP address is 192.168.7.201 for the primary NV9000’s master control network and 
192.168.7.202 for the secondary’s. 

If you prefer not to change the NV9000’s master control address, make all other IP addresses 
on the master control network part of the 192.168.7.xxx subnet. 

 Your NV9000 might have been defined with a virtual IP address. It is preferable to use the 
virtual IP address if it has one.

Imagestore 750
2  Connect the Imagestore 750 to master control’s Ethernet switch using Ethernet cable. You 

can use either of the two LAN ports on the Imagestore 750.

3  Assign an IP address to the Imagestore 750. 

Use the front panel menu (Setup > Network > IP Address).

The IP address must belong to the master control subnet. If necessary assign a gateway 
address using the front panel menu (Setup > Network > Gateway Add).

4 Repeat steps 2 to 4 for additional Imagestore 750s. 

Intuition XG
5  Connect the Intuition XG to the master control Ethernet switch using Ethernet cable.

Assign an IP address to the Intuition XG. (Refer to the Intuition XG publications listed under 
Applicable Publications and Tools on page 3.) 

The IP address must belong to the master control subnet. If necessary, assign a gateway 
address.

Repeat this step for additional Intuition XG co-processors, always selecting unique IP 
addresses.

iMC Panels
6  Connect the iMC panel to the master control Ethernet switch using Ethernet cable. 

Assign an IP address to the iMC panel using its touch screen (Panel Settings > IP 
Setup > Change IP). The IP address must belong to the master control subnet. If neces-
sary, assign a gateway address.

Repeat this step for additional iMC panels, always selecting unique IP addresses.

Configuration PC
7  Connect a configuration PC to the master control switch and give it an appropriate IP 

address on the master control subnet. Also connect a configuration PC to the NV9000 at its 
house network port (again with an appropriate IP address). You can use the same PC for 
both networks.

At this point, if you have the requisite configuration software installed, it is possible to configure 
the Imagestore 750(s), the NV9000, and your control panels. 
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There are various network-related settings that must be configured for master control. These are 
covered in following sections.

Serial Connections 
Note: It is important for serial port settings to be correct at both ends of a serial connection.

Serial Connection to Automation 
The Imagestore 750 connects to automation (Presmaster protocol) using an RS-422 serial cable. 
The Imagestore 750 requires an RJ45 connector at its chosen serial port (COM1– COM4). The 
following serial port settings are normally recommended between automation and the Images-
tore 750:

Baud rate 57600 
Serial protocol Presmaster automation 
Serial standard RS-422 
Serial port parity True

Please refer to the automation system’s installation guide for information about configuring its 
serial ports. See Applicable Publications and Tools on page 3.

Serial Connection to Intuition XG 
Imagestore 750 normally controls the Intuition XG graphics co-processor using an RS-232 serial 
cable (although Ethernet control can be used if there are no available serial ports). The following 
serial port settings are normally recommended between the Imagestore 750 and Intuition XG 
for command forwarding:

Baud rate 19200 
Serial protocol Oxtel slave 
Serial standard RS-232

Note: Refer to Serial Connection to Intuition XG on page 207 for details of how to connect RS-
232 serial between Imagestore 750 and Intuition XG. Note: Please refer to Applicable Publica-
tions and Tools on page 3 for information on how to configure the Intuition XG serial port 

Software Configuration 
 The IS-750-Master-Control licence option must be enabled for the Imagestore 750 to 

operate in the iMC master control system.

 The master control software configuration described in this section should be carried out in 
the order presented. 

 Imagestore 750 configuration settings should be applied using the Imagestore 750 Configu-
rator, unless otherwise stated. All changes made within the Imagestore 750 Configurator 
must be applied by selecting File > Save and Apply Configuration.... 

The Imagestore 750 must be restarted before your settings take effect. See Managing Con-
figurations on page 175 for how to restart the Imagestore 750.
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Software Versions 
The following software versions are required for the hardware devices: 

The following software versions are required for the configuration applications: 

The Imagestore 750 configuration steps in the following sections refer to the respective hard-
ware device’s configuration applications, as required.

Router Connections 
Please see Imagestore 750 Configuration Overview on page 62 for an introduction. 

First, an NV9000 router controller must already have been set up with valid sources and destina-
tions appropriate for your master control system. Please refer to the NV9000-SE Utilities Guide 
and to the iMC Master Control Installation Guide. (See Applicable Publications and Tools on 
page 3.)

Next, establish a network connection to the NV9000 using the Imagestore 750 Configurator.

Open the Imagestore 750 Configurator, and either create a new configuration or open an 
existing configuration as described in Configuration Mode on page 156. 

Hardware Device Software Version

Imagestore 750 4.4.0

NV9000 6.0.9

iMC panels 7.2.0.0

Table 5-1: Master Control - Hardware Devices Software Versions

Application Software Version

Imagestore 750 Configurator 1.5

NV9000-SE Utilities 6.0.9

MCS Panel Configuration Editor 7.1.0.0

Table 5-2: Master Control - Configuration Applications
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Choose ‘Configuration Mode’ in the top right drop-down menu. Then, choose the ‘System 
Settings’ tab and open the ‘Master Control’ branch of the navigation tree at the left: 

Fig. 5-3: Imagestore Configurator - Master Control section

1  Specify the router type as NV9000.

2  Enter the IP address on the ‘router address’ field. 

This can be a physical IP address (if you have a stand-alone NV9000 system), or a “virtual” IP 
address (when you have a redundant NV9000 system). Refer to the NV9000-SE Utilities Users 
Guide. 

3  Leave the ‘router port’ field as its default.

4  Save and apply the configuration, and wait for the Imagestore 750 to restart.

5  During restart, the Imagestore 750 reads pertinent configuration data from the NV9000.

6  Choose File > Open and select the Imagestore 750 by its IP address.

7  From the list of all Imagestore 750 configurations, select ‘Active Configuration’ and click OK.

8  Master Control system settings (from the NV9000) are now available to the Imagestore 750 
Configurator 

It is important to complete these steps before proceeding with other configuration tasks. 
The configurator cannot perform certain functions without knowing the NV9000’s IP 
address. 

Master Control Configuration 
 Please see Channel Sources on page 63 and Source Groups on page 64 for an overview. 

 Before a master control configuration file can be created, router sources must have been 
defined on the NV9000. Please refer to the NV9000-SE Utilities Users Guide. (See Applicable 
Publications and Tools on page 3.) 

The master control configuration file defines channel sources and source groups that the 
channel processor will be able to control and the owning iMC panel(s) will be able to represent 
72



Imagestore 750
User Manual
on the PGM, PST and AUX buses. The file is stored on the Imagestore 750 separately to the main 
Imagestore 750 configuration, but is referenced by it. 

The following sections describe how to create and edit a master control configuration. You can 
reopen existing master control configurations to revise them at any time using ‘File > Open > 
From Device…’.

Note: The master control configuration file can be shared between different Imagestore 750 
devices if the same sources and source groups are common to each channel processor.

Channel Sources Configuration 
Choose ‘Master Control Mode’ in the top right drop-down menu: 

Fig. 5-4: Imagestore Configurator - Master Control Mode

Then choose ‘New’ from the ‘File’ menu. Specify the IP address of the Imagestore 750: 

Fig. 5-5: Imagestore Configurator - Specify IP address

When you have done so, a list of NV9000 sources appears: 

Fig. 5-6: Imagestore Configurator - Available NV9000 sources
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Select some or all of the sources that apply to this Imagestore 750. You can revise the list at any 
later time.

Save the configuration using the ‘Save’ or ‘Save As’ command from the ‘File’ menu.

The chosen sources now appear in the ‘Channel Sources’ view: 

Fig. 5-7: Imagestore Configurator - Channel Sources view

Source names allow iMC panels to represent the router sources in human-readable form on 
their LCD buttons. Initially, the name of each source is automatically retrieved from the NV9000 
router control system, but you can override names as required:

1  Select the channel source ID to modify.

2  In the right-hand panel, type the source name that you want in the ‘Name’ field.

3  The ‘Name Generator’ field should automatically change from ‘Use name from router’ to 
‘User defined name’.

You can select audio gain and audio shuffle presets for each channel source. (See Gain Mode on 
page 170 and Shuffle Mode on page 171.) They allow each source to be gain-adjusted or 
shuffle-adjusted independently to compensate for any upstream audio faults or peculiarities. 

Once you have completed all changes needed for the master control configuration, save it onto 
the Imagestore 750 using the ‘Save As > To Device…’ in the ‘File’ menu. 

Channel Source Templates 
When you want to apply audio gain and shuffle presets repeatedly to different sources, you can 
simplify repetitive channel source configuration by using channel source templates. 
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Begin by choosing non-default gain and shuffle presets (as you require) in one of the channel 
sources. In the following example, the source is attenuated by -3dB, and a stereo swap shuffle is 
applied.

Fig. 5-8: Imagestore Configurator - Channel Soure template

Right-click on the modified source (highlighted, in the center pane) and choose ‘Copy settings 
to source template…’: 

Fig. 5-9: Imagestore Configurator - Copy Settings

Name the source template accordingly:

Fig. 5-10: Imagestore Configurator - Naming Source Template
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This new source template now appears in the ‘Source Templates’ list in the left-hand panel. The 
template’s audio parameters, name, and color scheme can be adjusted in the right-hand panel: 

Fig. 5-11: Imagestore Configurator - Source Templates

Select the sources to which you want to apply this template, then right-click a source and 
choose ‘Assign source template’:

Fig. 5-12: Imagestore Configurator - Apply Source Template

The sources selected above now shows the template name in the ‘Source Template’ column, 
and the template color scheme also helps identification. Notice that the audio parameters are 
greyed out because  they follow the source template:

Fig. 5-13: Audio parameters greyed out, follow Source Template
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When the source template is adjusted later, all channel sources using the template will be 
updated to match. This can be very useful if hundreds of sources require the same audio 
adjustment. 

To revert to prior audio parameters, select the channel source(s), right-click a source, and select 
‘Break association with source template…’: 

Fig. 5-14: Imagestore Configurator - Break Association with Source Template

A confirmation dialog appears: 

Fig. 5-15: Imagestore Configurator - Break Association with Source Template - Confirmation dialog

Click ‘Yes’ to confirm a break in association with the source template, or ‘No’ to keep the 
template association.

Source Groups Configuration 
Although source groups are defined in the Imagestore 750 configuration, they are for the use of 
iMC panels.

Create source groups by right-clicking within the ‘Source Groups’ tab in the left-hand panel 
under ‘Master Control Mode’. There are two options; ‘New…’ and ‘Auto assign…’: 

Fig. 5-16: Imagestore Configurator - Create New Source Group
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The ‘New…’ option asks you to enter a name and the number of entries for the new source 
group: 

Fig. 5-17: Imagestore Configurator - Source Group Name (ASCII)

When the group is created, you will see a list of sources and “slots” for sources at the bottom of 
the window. The slots correspond to iMC panel source buttons. 

To assign sources to the buttons, click-and-drag sources from the list to the slots. You can drag 
multiple sources into contiguous slots: 

Fig. 5-18: Imagestore Configurator - Source Groups

It is acceptable to leave some slots unassigned, creating gaps. It is also acceptable to have the 
same source in more than one slot. 

The ‘Auto Assign…’ option generates a series of sources groups that cover all available sources. 
When you choose this option, a dialog asks you to enter a name prefix and the number of 
sources in the source groups that will be generated: 

Fig. 5-19: Imagestore Configurator - Source Groups Prefix
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You will then be informed how many source groups will be generated. This is a sample: 

Fig. 5-20: Imagestore Configurator - Source Groups Created

In the example above, two source groups (Group 1and Group 2) were automatically created 
using sources 1–16 and 17–19. The source group mappings can then be modified.

Source group dependencies between the Imagestore 750 configuration and the iMC panel 
configurations must be considered. When panels that have different numbers of source buttons 
are to be supported by the same channel, a mixture of source group sizes can be defined 
accordingly.

For example, 32 sources might require 6 source groups when an iMC-Panel-300 and an iMC-
Panel-200 are used to control the same channel:

Two 16-entry source groups (1–16, 17–32) for the (larger) iMC-Panel-300.

Four 10-entry source groups (1–10, 11–20, 21–30, 31–32) for the (smaller) iMC-Panel-200.

Panels then must be configured to use the appropriate sized source groups.

After you have completed all changes needed for the master control configuration, save the 
configuration in the Imagestore 750 using the File > Save As > To Device.... 
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Master Control Configuration Cross-Reference 
To use a master control configuration, the main Imagestore 750 configuration must make refer-
ence to it.

Choose ‘Configuration Mode’ in the top right drop-down menu. From the ‘System Settings’ tab, 
select Master Control > Master Control Configuration: 

Fig. 5-21: Imagestore Configurator - Configuration Mode

Then select the required master control configuration file from the drop-down list at the right. 

Save and apply the configuration, and wait for the Imagestore 750 to restart. The channel 
sources and source groups will now be available for the channel processor to use.

Salvo Configuration 
Please see Router Salvos on page 64 for an introduction. 

 Before a salvo configuration file can be created, at least one system salvo must have been 
defined in the NV9000 configuration. Please refer to the NV9000-SE Utilities Users Guide. (See 
Applicable Publications and Tools on page 3.) 

A salvo configuration file identifies the router salvos that the Imagestore 750 can use. The salvo 
configuration file is stored in the Imagestore 750 separately from the main configuration, which 
references it. 

The following sections describe how to create and edit the Imagestore 750’s salvo configuration.

The salvo configuration file can be shared among different Imagestore 750s.
80



Imagestore 750
User Manual
Choose ‘Salvo Mode’ in the top right drop-down menu: 

Fig. 5-22: Imagestore Configurator - Salvo Mode

Then choose ‘New’ from the ‘File’ menu. Specify the IP address of the Imagestore 750: 

Fig. 5-23: Specify Imagestore 750 IP Address

After doing so, a list of NV9000 salvos appears: 

Fig. 5-24: Imagestore Configurator - Available NV9000 Salvos

Select some or all that apply to this Imagestore 750. You can revise the list at any later time.

Save the configuration using the ‘Save’ or ‘Save As’ command from the ‘File’ menu.
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The selected salvos now appear in the ‘Router Salvos’ view. 

Fig. 5-25: Imagestore Configurator - Selected Salvos

Salvo names allow iMC panels to represent the router salvos in human-readable form on LCD 
buttons. The name of each salvo is initially retrieved from the NV9000 router control system, but 
you can override names as required: 

1  Select the salvo to modify.

2  In the right-hand panel, type the salvo name that you want in the ‘Name’ field.

3  The ‘Name Generator’ field should automatically change from ‘Use name from router’ to 
‘User defined name’.

Performing a right-click on the left pane allows you to perform the following actions:

Add salvo(s) Add one or more salvos from the salvo list in the connected 
NV9000 router control system. 

Reassign router salvo(s) This allows you to reassign the selected Imagestore 750 salvo ID(s) 
to a different router salvo(s). 

Modify ID(s) This allows you to change the IDs of the selected salvo(s), as used 
by automation. 

Rename This allows you to rename the salvo(s). Multiple salvos can be 
renamed with a number appended to differentiate them. You can 
choose the router salvo name or generate names of your own 
choosing. 

Delete This allows you to delete salvo(s). 

Once you have completed all changes needed for the salvo configuration, save it onto the 
Imagestore 750 using ‘Save As > To Device…’ in the ‘File’ menu. 
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Salvo Configuration Cross-Reference 
To use a salvo configuration, the main Imagestore 750 configuration must make reference to it.

Choose ‘Configuration Mode’ in the top right drop-down menu. From System Settings, select 
‘Master Control > Master Control Configuration’: 

Fig. 5-26: Imagestore Configurator - Configuration Mode, Master Control Configuration

Then select the required salvo configuration file from the drop-down list at the right., 

Save and apply the configuration, and wait for the Imagestore 750 to restart. The salvos will now 
be available for the Imagestore 750 to use.

You can reopen existing salvo configuration files to revise them at any time using File > 
Open > From Device... under ‘Salvo Mode’.

Router Destinations 
 Please see Router Destinations (Feeding Program and Preset Inputs) on page 64 and Router 

Destination (Feeding AUX) on page 65 for an overview. 

In the Imagestore 750 Configurator, select the router destinations that feed:

• Program bus (the A Input)

• Preset (a.k.a. preview) bus (the B Input)

• Aux bus (auxiliary monitoring device)
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In the Imagestore 750 Configurator, choose the ‘System Settings’ tab under ‘Configuration 
Mode’ and open the ‘Master Control > Router Destinations’ branch of the navigation tree at the 
left. 

Fig. 5-27: Imagestore Configurator - Master Control, Router Destinations

Choose a router destination from the field at the right of each of these 3 entries. 

• ‘Destination feeding PGM bus’ corresponds to the A input of the Imagestore 750. 

• ‘Destination feeding PST bus’ corresponds to the B input of the Imagestore 750.

• ‘Destination feeding AUX bus’ corresponds to an auxiliary monitoring device.

When you click the field to make an entry, a list of NV9000 destinations appears: 

Fig. 5-28: Imagestore Configurator - NV9000 destinations

Choose one and click ‘OK’.

Do the same for all 3 destinations.

These settings represent a physical video connection between the router and Imagestore 750 
and between the router and an auxiliary monitoring device. 
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Not every Imagestore 750 needs to control an aux device. If you leave the aux destination field 
blank, the Imagestore 750 will not control any aux device and the aux source buttons of iMC 
control panels will be disabled when they are controlling these Imagestore 750s..

Note: When iMC panels have dedicated monitor walls, it is unlikely that auxiliary video monitors 
will be used to display their channels’ aux source selections. Despite this, it is necessary to define 
unique ‘Destination feeding AUX bus’ entries for every channel so that aux source switches can 
be tallied back to the controlling panel(s). These destinations must differ from any iMC panel 
‘monitor wall AUX destination’ entries to avoid router conflicts as panels change ownership 
between different channel processors. 

Router Sources 
Please see 

Router Sources (Fed by PGM, PST, CLN, and MON Outputs) page 65  
Router Source (Fed by BLACK/SILENCE) page 65  
Router Source (Fed by USER 1-20) page 65

for additional information. 

 These settings are somewhat related to the MCS Panel Configuration Editor’s monitor wall 
settings. (See Monitor Wall on page 66.) 

In the Imagestore 750 Configurator, select the router sources that are fed by:

• Program output

• Preset (a.k.a. preview) output

• Clean-feed output

• Monitor output

• Black/silence

• User sources 1–20

In the Imagestore 750 Configurator, choose the ‘System Settings’ tab under ‘Configuration 
Mode’ and open the ‘Master Control > Router Sources’ branch of the navigation tree at the left. 

Fig. 5-29: Imagestore Configurator - Master Control, Router Sources
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Choose a router source from the field at the right of each of these entries. When you click the 
field to make an entry, a list of NV9000 sources appears: 

Fig. 5-30: Imagestore Configurator - NV9000 Sources

Choose one and click ‘OK’. 

Do the same for the other sources you want to configure. 

These settings represent a physical video connection into the router from (1) the Imagestore 
750’s outputs, (2) a black/silence generator, and (3) other related devices (perhaps a backup 
channel or HD/SD mirror channel). 

Each Imagestore 750 feeding the router must have its own distinct set of sources. Other sources 
may be shared between different channels.

Note: Be careful to modify these settings correctly for every device when sharing an Imagestore 
750 configuration between multiple devices. 

Graphics Co-Processor Configuration 

Slave Settings
Please see Graphics Co-Processor Feeding Fill and Key on page 65 for an introduction. 

This section describes how to configure the Imagestore 750 to use a graphics co-processor (i.e., 
the Intuition XG) with the Imagestore 750. 

 Intuition XG configuration is outside the scope of this document. Please refer to the Intuition 
XG publications listed under Applicable Publications and Tools on page 3. 

Example: Do not use XPlay to control the Intuition XG when it is being used in this master 
control environment.
86



Imagestore 750
User Manual
In the Imagestore 750 Configurator, choose the ‘System Settings’ tab under ‘Configuration 
Mode’ and open the ‘Devices > Slave’ branch of the navigation tree at the left. 

Fig. 5-31: Imagestore Configurator - Slave Devices, Configuration Mode

Configure the following settings relating to slave device command forwarding and media 
thumbnail transfers. (Here the primary device refers to the Imagestore 750 and the slave device 
is the Intuition XG).

• Slave keyer assign.

The primary keyer (DSK) to which the slave’s fill/key input is fed.

• Slave keyer follow up.

When this option is enabled, a primary keyer cut-up follows the overall slave layers, so that 
the assigned keyer is cut up when one or more slave layers have been cut/faded up. 

 If a panel is fading up an Intuition XG layer independently of the “command forwarding” 
mechanism, the primary keyer (DSK) will cut up only at the end of the slave layer fade.

When this option is disabled, the assigned keyer position remains unchanged regardless of 
the slave layer positions.

 If you want to use an iMC panel to preview Intuition XG graphics on a preset DSK without 
its appearing on program, then set this parameter to ‘disabled’.

• Slave keyer follow down.

When this option is enabled, a primary keyer cut-down follows the overall slave layers, so 
that the assigned keyer is cut down when all slave layers have been cut/faded down. This is 
particularly useful when there are out-transitions of indeterminate length coming from the 
Intuition XG.

When this option is disabled, the assigned keyer position remains unchanged regardless of 
the slave layer positions.
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• Slave fill/key input.

The fill and key port pair on which the slave graphics are received.

• Slave number of keyers.

The number of slave layers that are supported and that return thumbnails to the iMC panel. 

By default, the Intuition XG supports 8 layers.

• Slave IP address.

The slave’s IP address, used for sending media thumbnails to the iMC panel

The slave’s IP address is also used for command forwarding if network control is preferred to 
serial control.

• Slave type.

Set this field to ‘Intuition XG’ to tell the Imagestore 750 how the slave’s load and cue informa-
tion should be interpreted.

 To avoid conflicts in slave load and cue states, you must not use XPlay to control the Intu-
ition XG when it is used in the master control environment.

External Fill/Key Settings
In the Imagestore 750 Configurator, choose the ‘System Settings’ tab under ‘Configuration 
Mode’ and open the ‘Video > External Fill/Key > Fill-x/Key-x’ branch of the navigation tree at the 
left. 

Fig. 5-32: Imagestore Configurator - System Settings

Please refer to Keying Parameters on page 39 for more information about the fields on this page.
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Configure the following settings relating to the Intuition XG’s fill and key output format, and 
media management preferences:

• Input source. 

This describes the keyer’s input signal. The choices are ‘separate’, ‘self’, and ‘none’.

• Input type. 

This describes the keyer’s mixing method. The choices are ‘full’ and ‘linear’.

• Input sense. 

This specifies whether the key signal is to be inverted. The choices are ‘normal’ and ‘inverted’.

• Input name.

The name of this input as used by OxSox and the ‘R0’ (load image) Oxtel command.

In a master control system, this name is the mnemonic used on control panels to identify the 
fill/key input pair. For each fill/key pair, you have a choice of using the default name or a 
name of your choosing. For example, you can select “> INT-XG < for the fill/key that is fed by 
an Intuition XG. Always avoid names that have the potential to conflict with media names. 

• Input thumbnail name.

This is the name of a built-in graphic file that can be assigned to an external fill/key pair to 
give a thumbnail representation of it on a control panel. 

There are 4 choices: F1+K1.jpg, F2+K2.jpg, F3+K3.jpg, and INT-XG.jpg. 

For each fill/key pair, you have a choice of using the default file (e.g., F1+K1.jpg) or the INT-
XG.jpg file. To use INT-XG for the Intuition XG’s fill/key pair, choose ‘User Value’ rather than 
‘Default Value’ and select INT-XG.jpg.

The thumbnails identify the fill/key source as shown in this sample from the iMC GUI: 

Fig. 5-33: Example of thumbnails for Fill/Key sources

The names appear below the thumbnails. It is beneficial to have the name and the thumb-
nail match, although that is not enforced.

After you have completed all changes for the graphics co-processor configuration, save it onto 
the Imagestore 750 using ‘Save As > To Device . . .’ in the ‘File’ menu. 

Channel Acquisition and Ownership Configuration 
Please see Channel Acquisition and Ownership on page 66 for an introduction. 
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Channel ownership and acquisition configuration is carried out mainly in the MCS Panel Config-
uration Editor. A brief overview of the iMC panel configurations is given here. Please refer to iMC 
panel publications listed under Applicable Publications and Tools on page 3 for complete detail. 

Channel Selection Configuration 
First, decide which Imagestore 750 channel processors are to be controlled by which iMC panels 
at your broadcast facility. Then, for each iMC panel, configure an appropriate set of ‘channel 
selection’ buttons using the MCS Panel Configuration Editor. Follow these steps:

1  Open the MCS Panel Configuration Editor. 

2  Select the iMC panel to configure. 

3  Don’t forget to click the ‘Imagestore 750’ radio button in the ‘General’ tab.

4  Select the ‘Channel Selection List’ page: 

Fig. 5-34: iMC-Panel Configuration tool - Channel Selection list

Define the channels that are to be controlled by this panel by entering an IP address and 
mnemonic. The mnemonic will appear on panel buttons that are related to the channel. 
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In the MCS Panel Configuration Editor, select the ‘User Buttons Layout’ page (or any of the other 
customer-configurable button pages): 

Fig. 5-35: iMC-Panel Configuration tool - User Buttons Layout

To define a channel selection button, click on a button proxy, select ‘Channel’ from the 
“Channel’ category at the left, and select an IP address from the ‘Channel Selection’ drop-down 
list that appears in the button description fields at the bottom of the window. Repeat this for all 
channel selection buttons you want on the panel.

 Channel selection buttons are not required (although they are convenient). Panel operators 
can also select any channel through the channel menu.

To create a ‘No Channel’ button, click on a button proxy and select ‘No Channel’ from the 
“Channel’ category at the left. The ‘No Channel’ button lets the panel operator drop any channel 
it had previously acquired. 

Panel Permissions Configuration 
In the MCS Panel Configuration Editor, go to the ‘Advanced’ page and find the ‘Channel Acquisi-
tion Settings’: 

Fig. 5-36: iMC-Panel Configuration tool - Advanced tab, Channel Acquisition Settings
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For each panel, configure following parameters:

• Channel acquisition priority:

The panel’s priority (i.e., permission level) is an integer number from 1 to 255, where higher 
numbers represent higher authority. Panels with higher priority may preempt panels with 
lesser priority. Priority levels apply only to the ‘Allows kick’ setting. 

• Allows kicking:

The panel’s ‘Allows Kicking’ parameter determines how other panels are allowed to take 
ownership away from this panel when it has ownership of a channel. 

There are 4 levels you can select: 

Never

By higher priority panels only

By same or higher priority panels

Always

A common scenario is where most panels are “normal” and are set to the same priority level 
with ‘Allows Kicking’ from higher priority panels only. Thus, normal panel operators cannot 
take channel ownership from one another, but a supervisor with a higher priority panel can 
acquire ownership of any channel. 

• Allow sharing:

The panel’s ‘Allow Sharing’ flag determines whether this panel is allowed to share channels 
with other panels. Imagestore 750s will allow sharing only when all acquiring panels have 
the ‘allows sharing’ flag set on. If the owning panel does not allow sharing, then no other 
panel will be able to share the channel, whatever its priority.

 Imagestore 750s can enforce ‘Allows Kicking’ and ‘Allow Sharing’ settings on panels of 
lower priority. That is discussed in Channel Permissions Configuration, next. 

Channel Permissions Configuration 
In the Imagestore 750 Configurator, choose ‘Configuration Mode’ in the top right drop-down 
menu. From System Settings, select ‘Master Control > Channel Ownership’:
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Fig. 5-37: Imagestore Configurator - Channel Permissions Configuration

Configure the following parameters:

• Channel name. (This is intended to override the panel’s mnemonic, but is not currently 
used).

• Permission level.

Set the permission level to 0 to allow panels to use their own ‘allow kick’ and ‘allow share’ 
settings.

Set the permission level in the range 1–255, otherwise.

• Allow kick.

As for iMC control panels, there are 4 levels of this parameter:

Never

By higher priority panels only

By same or higher priority panels

Always

You can also set this parameter to ‘Use panel setting’. This is the default.

• Allow share:

As for iMC control panels, this setting is either enabled or disabled. 

You can also set this parameter to ‘Use panel setting’. This is the default.

Note: If the channel’s permission level is higher than a panel’s permission level, the channel will 
override the panel’s ‘Allows Kicking’ and ‘Allow Sharing’ settings. This allows a channel to 
enforce a consistency of settings between connected panels, but still allow a supervisor’s panel 
to override these standard settings and take control of a channel whenever necessary.

Monitor Wall Configuration 
Please see Monitor Wall on page 66 for an overview. 
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Because monitor wall switching is initiated by the iMC panel, monitor wall configuration 
belongs mostly within the MCS Panel Configuration Editor. 

A brief summary of iMC panel configuration is given here, but please refer to the iMC panel 
publications listed under Applicable Publications and Tools on page 3 for more detail. 

 Modify these settings carefully for every iMC panel. If your system has more than one 
monitor wall, each one has a distinct set of router destinations.

Monitor Wall Source Group Configuration 
A monitor wall typically displays all of the sources from a panel’s current source group.

Open the MCS Panel Configuration Editor, choose a panel, and then go to the ‘Monitor Wall’ 
page: 

Fig. 5-38: iMC-Panel Configuration tool - Xpt buttons, Destination IDs

Assign NV9000 destination IDs for each source button (labeled “XPT buttons” here) for which 
you want the source to appear on the monitor. 

 All the NV9000 destinations (i.e., router outputs) you choose here must, of course, be physi-
cally connected to the same monitor wall.

 It is easier to make these assignments when the MCS Panel Configuration Editor is 
“attached” to the NV9000 system. Check the box on the ‘NV9000 Settings’ page.

For example, the largest source group for an iMC-Panel-300 might have 16 sources, so you 
would assign 16 destination IDs. (Remember that there must also be 16 physical connections.) 
Whenever the panel operator changes to another source group, the panel causes appropriate 
router switches to these destinations so that the monitor wall follows the source group 
selection. 

 Note: For any “holes” within the currently selected source group, the monitor wall will 
receive the black/silence source defined in the Imagestore 750’s ‘router sources’ configura-
tion. See Router Sources on page 85 for details. 

Typically, the monitor wall 
displays all sources from 
the current source group 
for the Imagestore 750 
that is currently owned by 
the panel. The router 
destinations configured 
here are used for this 
purpose.
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Monitor Wall Configuration 
As an iMC panel acquires an Imagestore 750, the following can be displayed on the panel’s 
monitor wall:

• Program output.

• Preset (a.k.a. preview) output.

• Clean-feed output.

• Monitor output.

• Aux output.

• User 1–20. 

in addition to the sources in the current source group.

Open the MCS Panel Configuration Editor, choose a panel, and then go to the ‘Monitor Wall’ 
page. Use the channel output list. The first 5 entries in the list represent Imagestore 750 outputs: 

Fig. 5-39: IiMC-Panel Configuration tool - Monitor Wall Channels, Imagestore 750 outputs

The remaining entries — when you scroll down — represent the sources identified as User-1 
through User-20: 

Fig. 5-40: IiMC-Panel Configuration tool - Monitor Wall Channels, User outputs

Assign NV9000 destination IDs for each channel output that you want to appear on this panel’s 
monitor wall. 

 All the NV9000 destinations (i.e., router outputs) you choose here must, of course, be physi-
cally connected to the same monitor wall.

 It is easier to make these assignments when the MCS Panel Configuration Editor is 
“attached” to the NV9000 system. Check the appropriate box on the ‘NV9000 Settings’ page.

When the panel operator acquires a new channel, the panel causes appropriate router switches 
so that the monitor wall shows the channel outputs, the aux output, and any user-defined 
sources you have selected. The router sources associated with the Imagestore 750’s outputs and 
the router sources labeled User-1 through User-20 must also have been configured for each 
Imagestore 750 this panel will control. Please see Router Sources on page 85 for details. 

Typically, the monitor wall 
displays outputs from the 
Imagestore 750 that is 
currently owned by the 
panel, and can also 
display custom outputs 
such as a backup channel. 
The router destinations 
configured here are used 
for these purposes.
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Channel Acquisition Salvos
Another method for configuring the monitoring of channel processor outputs uses channel 
acquisition salvos.

Open the MCS Panel Configuration Editor, choose a panel, and then go to the ‘Channel Selec-
tion List’ page: 

Fig. 5-41: IiMC-Panel Configuration tool - Channel Acquisition Salvos

For every Imagestore 750 that this panel can acquire, select the channel and specify an appro-
priate Imagestore 750 salvo ID. The ID must be defined in the configuration of the selected 
channel.

 Imagestore 750 salvo IDs are numbers starting at 0. The Imagestore 750 salvo IDs map to 
NV9000 salvo IDs and it is the NV9000 that executes salvos. The mapping allows a degree of 
flexibility.

Each salvo executes a sequence of NV9000 commands. The salvo is responsible for routing 
outputs from the acquired Imagestore 750 to the local monitor wall. Typically there is one salvo 
for every channel processor at every iMC panel. IF there are 6 Imagestore 750s and 8 panels, 
there would be 48 salvos defined. 

The main disadvantage of this method is that all existing panel configurations must be updated 
whenever a new channel is added to the broadcast facility. It is easier and more scalable to 
configure channel outputs in the ‘Monitor Wall’ page.
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Miscellaneous Router Configuration 
In the Imagestore 750 Configurator, choose ‘Configuration Mode’ in the top right drop-down 
menu. From System Settings, select ‘Master Control > Router Configuration’: 

Fig. 5-42: Imagestore Configurator - Miscellaneous Router Configuration

 Just for your understanding, “NP0017” is the part number of the document that describes 
the NVISION Ethernet protocol (NVEP). It has no real meaning in the master control control 
system.

Configure the following parameters:

• NP0017 user ID.

 The default value should be used because the Imagestore 750 does not support the lock, 
protect, and release functions of NVISION router crosspoints.

In future software releases, this setting may be used by the NV9000 to track and diagnose 
the Imagestore 750’s lock, protect, release activity on router crosspoints. 

• NP0017 mnemonic set.

Up to 10 alternative name sets for sources and destinations can be defined in the NV9000 
configuration, using NV9000-SE Utilities. 

Note: name sets must be standard ASCII. 

This setting selects which name set is combined with the main name set when you create a 
new master control configuration (before any channel-specific naming overrides).

• Post-tally delay.

When the Imagestore 750 instructs the NV9000 router control system to perform a router 
switch, the NV9000 sends the switch command to the router and tallies back to the Images-
tore 750 at the same time. 

The router still must complete a physical switch which takes a small but significant amount 
of time depending on the physical characteristics of the router.

The value entered into the ‘post tally delay’ field is the worst-case router switching delay. 
The value is expressed in frames. The Imagestore 750 uses this value to ensure the integrity 
of A/B mixer output during transitions. 
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Note: If this value is too small, a flash will be seen on-air as the A/B mixer cuts back to the A 
input before the physical switch is made.

• Router timeout.

This parameter is used predominantly for monitoring and logging NV9000 communications. 

We recommend that you leave this at the default value of 500 ms 

• Router logging level.

This parameter allows you to control the granularity of router logs.

Note: If you are experiencing problems relating to router switching, set the router logging 
level to ‘Everything (very verbose)’ before retrieving message logs. After the fault has been 
diagnosed, return to the default setting ‘Fatal and important messages’ to avoid excessive 
message log activity.

Channel Transitions 
When an operator is performing complex transitions (i.e. A/B mixing with keyer fades), it is 
important that the durations of different parts of the transition relate to one another correctly. 

You can control this using a global transition mode (automation, slow, medium, fast) which 
applies to A/B mixing, keyer fades, keyer fades-to-black, and voice-overs. To give added flexi-
bility, each A/B mixer profile and each keyer has its own duration overrides. 

 Note: Transitions started by automation will always use automation rates. Slow, medium 
and fast apply only to transitions started at panels. 

Transition Parameters
Choose ‘Configuration Mode’ in the top right drop-down menu. From ‘System Settings’, select 
‘Miscellaneous > Channel Transitions’:

Fig. 5-43: Imagestore Configurator - Channel Transition Configuration

Configure the following parameters: 

• Channel transition mode — sets the global transition mode for this channel to: 

Automation.

Slow.
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Medium.

Fast.

Transition Rates
Each global transition mode has its own rate for A/B mixing: From ‘System Settings’, select 
‘Video > AB Mixer’: 

Fig. 5-44: Imagestore Configurator - Transition A/B Mixing

Configure the following parameters:

• Automation transition rate.

• Panel slow transition rate.

• Panel medium transition rate. 

• Panel fast transition rate. 
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Transition Type Profiles
Each A/B mixer type has an adjustable mixer profile. From ‘System Settings’, select 
‘Video > AB Mixer > Mixer Profiles’: 

Fig. 5-45: Imagestore Configurator - Transition AB Mixer profile

Configure the following parameters for each fade type:

• Percent down.

• Percent hold.

• Percent up.

• These percentages define how much time is assigned to the 3 parts of the A/B mix transition. 
Normally the hold period is a black color field, but for X-fades it is a 50% mix of A and B 
sources. 

• The following table shows the default mixer profiles. 

Mixer Profile Percent Down Percent Holda

a. Percent hold is only used by U-fades to hold the profile at black for a 
short time

Percent Up

V-Fade 50 0 50

Fade-Cut 100 0 0

X-Fade 50 0 50

Cut-Fade 0 0 100

Cut 0 0 0

U-Fade 33 34 a 33

V-Fade Preset 1 50 0 50

V-Fade Preset 2 50 0 50

Table 5-3: Default Transition AB Mixer profiles
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Except for A/B cuts, the default percentages for mixer profiles always total 100%. However, you 
can adjust a profile’s percentages to make its actual transition time longer or shorter than the 
current A/B mixer transition rate. For example, to make a fade-cut half the duration of other 
transitions, set its percentages to 50-0-0. 

You can also create asymmetric V-fades (i.e. 35-0-65) using one of the V-fade presets. 

Transition Rate for DSKs
Each DSK has its own transition rates for slow, medium, fast and automation. From System 
Settings, select ‘Video > Keyers > DSK n > Keyer Fader Operations’: 

Fig. 5-46: Imagestore Configurator - Transition DSK rates

Configure the following:

• Automation keyer fader rate.

• Panel slow keyer fader rate.

• Panel medium keyer fader rate.

• Panel fast keyer fader rate.

Note: The fader rates for each keyer are independent of one another. 
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Transition Rate for Voice-Overs
Each voice-over has its own transition rates for slow, medium, fast and automation. From the 
‘Audio Graph’ tab, click on a voice-over block: 

Fig. 5-47: Imagestore Configurator - Voice-over parameters

In the right-hand panel configure the following parameters:

• Automation fade rate.

• Panel slow fade rate.

• Panel medium fade rate.

• Panel fast fade rate.

Note: The default automation rate for voice-overs is much faster than for the A/B mixer and 
keying layers. This is because voice-overs should normally fade up very rapidly as soon as audio 
is present.

Panel Behavior Configuration 
When you are controlling a channel processor with an iMC panel, there are some actions the 
channel can take to make panel operation more efficient. 
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In the Imagestore 750 Configurator, select ‘System Settings > Master Control > Preferences’: 

Fig. 5-48: Imagestore Configurator - Master Control Preferences

Configure the following settings:

• ‘Cut all from air on hot PGM switch’.

This option cuts down everything that currently contributes to air — (keyers, voice-overs, 
etc.) — when the program source is hot-switched.

The rationale for this behavior is that none of the graphics will apply to the new source on 
program.

• ‘Rearm mix on preset bus source change’.

When the preset source changes to a source different from program, the last used A/B mix 
type will be armed.
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Advanced Audio 
Chapter 6 describes the advanced audio features of the Imagestore 750. 

Topics
Dolby  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 105 
Up-Mix  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 133 
Audio Description (AD)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 140 
Silence Detection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 143 
Audio Delays  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 146 

Dolby 
This section presents the Imagestore 750’s Dolby processing options:

• Integral decoding of Dolby E.1

• Integral encoding of Dolby E or Dolby Digital (AC-3).

Introduction 
The Dolby audio modules provide the following features:

• Dolby encoders and decoders.

• Dolby input from SDI video with embedded audio or AES.

• Metadata handling.

• Metadata RS-485 serial ports.

• Audio input status monitoring.

• Integral video delays.

• Integration in the 1RU chassis.

• Control with Oxtel automation command extensions.

• ‘Audio Graph’ page in the Imagestore 750 Configurator. (See Chapter 8)

 Note: The Imagestore 750 can accommodate a total of 4 Dolby decode, Dolby encode and 
up-mix modules.

1. Decoding of Dolby Digital (AC-3) is also supported, but not recommended.
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Dolby Data Types 

Dolby Digital (AC-3) 
Dolby Digital is a mechanism that carries multi-channel audio in a stereo audio signal. It is some-
times called “AC-3,” after the coding technology used. The high-quality compression achieved 
takes advantage of human hearing. The resulting decoded audio is not meant for re-encoding, 
rather for listening; hence its use in transmission. The Dolby Digital bitstream is a transmission 
bitstream, intended for delivery to the consumer at home.

Dolby E 
Dolby E is a high quality, video-frame-synchronized audio compression coding scheme that 
enables broadcasters to distribute surround sound and multi-lingual audio using an existing 
stereo infrastructure. Up to 8 audio channels plus metadata can be carried on a stereo channel. 
Dolby E can tolerate the multiple encoding and decoding cycles encountered during broadcast 
contribution, post-production, and distribution stages. Dolby E encoders and decoders convert 
to and from compressed audio.

Dolby Metadata 
A Dolby data stream contains information about the Dolby-encoded audio bit stream itself. This 
information is called metadata. Metadata is different for Dolby Digital and Dolby E. It is used to 
control aspects of the audio decoding and reproduction.

Dolby E metadata contains Dolby Digital metadata for every audio program carried in the Dolby 
data stream, plus information about the transport stream. Dolby Digital metadata contains data 
to be used by consumer electronics.

The metadata comprises of a set of parameters, for example:

Audio coding mode Describes a program’s associated audio channels.

Dynamic range Used to compress audio dynamic range at the consumer equipment.

Dialog normalization Adjusts consumer equipment audio output for consistent viewer loud-
ness; for example, across commercials, films, local news.

Dolby Handling on Legacy Systems 
An Imagestore 750 without Dolby modules can pass and switch between Dolby E data-streams. 
However it can only pass, not switch, Dolby Digital data. 

Audio processing is always carried out in parallel with the video processing. The diagram below 
shows the basic engine: 

Fig. 6-1: Basic Audio Engine 
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As the Dolby data passes through the audio engine, it is treated as pure data and left 
untouched. No decompression or re-compression is performed. Dolby E data streams can be 
switched cleanly, and the cut point is configured to synchronize with one of the following posi-
tions of the audio A/B mixer:

• Transition start.•Fully at A

• Transition mid-point (default).•Fully at B

• Transition end.

Any metadata in the data stream is also switched at this point.

Because all Dolby data remains compressed throughout the system, it is not possible to apply 
audio A/B-mixing or voice-overs on systems having no Dolby modules. To do this requires Dolby 
decode option(s) to be installed. 

The following diagram shows an Imagestore 750 without any Dolby options installed. 
Embedded audio from the sources consists of a mixture of PCM and Dolby E, for example, stereo 
2.0 PCM on channels 1 and 2 and Dolby E on channels 3 and 4. The PCM channels are A/B-mixed 
and a voice-over is applied; but only A/B-switching is performed on the Dolby E channels. The 
two stems are then recombined so the embedded output matches the source format: 

Fig. 6-2: Basic Audio Engine - A/B switching Dolby E Audio

For other Dolby applications, the respective Dolby hardware and software options are required. 
These are described in the following sections.

Installing Dolby Options 
The Imagestore 750’s Dolby options provide additional integrated Dolby decoding and 
encoding capability. 
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The Dolby decoding and encoding option add the ability to decode and encode Dolby 
according to the following diagram: 

Fig. 6-3: Audio Engine and audio processing Dolby modules

Note: The Imagestore 750 can accommodate a total of 4 advanced audio modules (a combina-
tion of Dolby decode, Dolby encode, and up-mix modules). 

Dolby Overview 
The Imagestore 750 Dolby decoding and encoding options provide an integrated, compact and 
flexible “Dolby decode-/encode-capable” 1RU channel branding processor. With Dolby decodes 
and encodes being performed within the Imagestore 750, it is possible to mix and cross-fade 
between Dolby inputs and apply PCM voice-overs before encoding back to Dolby audio. 

The Imagestore 750’s Dolby options provide the following principal features:

• Up to 4 modular Dolby decoders and encoders.

• Dolby data from:

Audio embedded in SDI video.

AES stereo pair(s).

• PCM (baseband, uncompressed) audio to Dolby data conversion.

• Metadata handling:

Metadata A/B switching synchronously with audio A/B mix.

Four RS-485 serial metadata I/O connections.

Custom-defined metadata presets.

Internal configurable metadata sources.

• Audio input status, reporting on the front panel or through SNMP.

PCM, Dolby E, or Dolby Digital.

• Audio type status bits in AES and embedded SDI audio.

‘Audio’ or ‘Non-Audio’.

• Integral video delays provide video delay compensation.

• No additional video reference is required. The existing bi-level or tri-level reference signal is 
used.

• The Imagestore 750’s GPIs are available for control.

• Automation commands are available for control.

�$@�$��
�

 	��������
�����������


 "!
��#

$���
'
%(
�

$��
�� 

$��
��!

�-��$��
�

 ��  ��

$��
������
������1 "!���#A�0
�
��A�
���2
�
�
��

�
��
	



�
�
��

�
��
	



�
�
��

�
��
	



�
�
��

�
��
	



��'5C��*� ��'5C��%	�
108



Imagestore 750
User Manual
• 1RU overall video/audio solution.

• ‘Audio Graph’ page, for setting audio configurations, in the Imagestore 750 Configurator.

Note: When Dolby E or Dolby Digital (AC-3) is fed into the AES inputs, the signal is reported as 
‘Non-Audio’. This is because Imagestore 750 is unable to detect Dolby E or Dolby Digital (AC-3) 
on its AES inputs and so treats it as non-PCM.

Decode and Encode Combinations 
The Imagestore 750 accepts up to 4 Dolby decoder/encoder modules. The modules provide 
decoding of Dolby E, and encoding of Dolby E or Dolby Digital.

The Dolby option’s product codes cover various cases by allowing combinations to be built. (See 
Product Codes on page 111.)

The table below summarizes some of the possible decode/encode use-case combinations: 

ID
Decode / Encode  
Combination

Dolby E  
Decoders

Dolby E  
Encoders

Dolby Digital  
Encoders

1 Dolby E encode 1, 2, 3 or 4

2 Dolby Digital encode 1, 2, 3 or 4

3 Dolby E decode 2 or 4

4 Dolby E decode + Dolby E encode 2 1 or 2

5 Dolby E decode + Dolby Digital encode 2 1 or 2

Table 6-1: Dolby module Encode/Decode Combinations
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The following diagrams depict possible Dolby decode/encode combinations from lines 1 and 2 
of Table 6-1: 

Fig. 6-4: Dolby Encode Combinations
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Fig. 6-5: Dolby Encode - Decode Combinations

In the example shown in Figure 6-6, the Imagestore 750 performs audio processing on both 
baseband audio (PCM) and on Dolby audio (using Dolby decoder and encoder modules). 

Fig. 6-6: Imagestore 750 example - A/B Mixing PCM and decoded Dolby audio

It is now possible to A/B-mix decoded Dolby from the input sources and to apply voice-overs 
prior to re-encoding. 

Additionally, it A/B-switches incoming input Dolby metadata and uses the metadata to re-
encode the output. (The switched metadata are also available in a serial form). 

Product Codes 
The Imagestore 750’s Dolby product codes are listed here.

The complete set of Imagestore 750 product codes is listed in Chapter 11.

• Dolby carrier board. 

�

�

�

$���
'
%(
�

 	
��
��
 
"!
��
�#

�

 �*��	�

!�*��	� ��
(�
?�%	�

���

�

�
��
��
��
 
"!

�?
���
�

���

��� ���

��
�

�-�

�$@

 

!

���

���

�
������

�
������

$���
'
%(
�

���

���

��
�

�-�

�$@

������+�%	�

 

!

�
������

�
������

�

111



Advanced Audio
Dolby
The Dolby carrier board product code is IS-750-DOLBY-CARRIER-BOARD.

Purchase this option to make an Imagestore 750 “Dolby-ready”. No Dolby modules are 
included with this product code.

 It is preferable to have the audio modules factory-fitted whenever possible because you 
will not have to open the unit.

 The carrier board option also makes the Imagestore 750 ready for other Imagestore 750 
audio processing options such as the up-mix option.

• Dolby kits. 

The Dolby kit product codes are:

IS-750-DOLBY-ENCE 1 Dolby E encoder + carrier board.

IS-750-DOLBY-ENCD 1 Dolby Digital encoder + carrier board.

IS-750-DOLBY-DEC 1 Dolby E decoder + carrier board.

IS-750-DOLBY-DEC2 2 Dolby E decoders + carrier board.

IS-750-DOLBY-DEC2-ENCE 2 Dolby E decoders + 1 Dolby E encoders + carrier 
board.

IS-750-DOLBY-DEC2-ENCD 2 Dolby E decoders + 1 Dolby Digital (AC-3) encoder + 
carrier board.

The Dolby kit codes apply to new factory-built Imagestore 750s. They provide:

• A Dolby carrier board installed in the Imagestore 750. The Imagestore 750 can fit up to 4 
Dolby modules.

• A special I/O card variant with RS-485.

• Up to 4 RS-485 ports, configured “In” or “Out”, for serial metadata.

• Dolby decode and encode modules installed according to the kit option.

Please contact Miranda Customer Support to determine whether existing Imagestore 750s 
can have Dolby added retrospectively.

• Dolby upgrade.

The Dolby upgrade product codes are:

IS-750-DOLBY-DEC-UPG Single Dolby E decoder.

IS-750-DOLBY-ENCE-UPG Single Dolby E encoder.

IS-750-DOLBY-ENCD-UPG Single Dolby Digital (AC-3) encoder.

Upgrades add decoders or encoders that extend the Dolby decoder/encoder kit combina-
tion, up to a maximum of 4 modules.

Upgrades or extensions are purchased either:

• With a Dolby kit at the original Imagestore 750 purchase. (The options are assembled in 
the factory.) 

• As an upgrade to an Imagestore 750 that already includes a Dolby kit.

In most cases, Dolby upgrades can be installed in the field. Please contact Miranda Customer 
Support for advice.

• Examples
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The figures below depict basic Dolby decoder/encoder use cases: 

Fig. 6-7: Imagestore 750 Example - Dolby Decode and Encode use cases

These cases are covered by the following kits:

The IS-750-DOLBY-DEC2-ENCE product code includes:

• Dolby carrier board.

• RS-485 serial I/O ports.

• Two decoder modules.

• One Dolby E encoder module. This leaves space for one further audio module to be fitted 
at a later date. The IS-750-DOLBY-ENCE-UPG could be purchased to add a second 
Dolby E encoder module.

Technical Specifications 
Inside an Imagestore 750 that is equipped with a Dolby kit, there is a Dolby carrier card which 
has 4 slots available for Dolby or upmix modules. There are no specific slots for decoder or 
encoder modules because the Imagestore 750 detects the modules’ presence and type 
automatically.

The Dolby modules used in the Imagestore 750 are as follows:

• Dolby decoder module.

• Dolby E encoder module.

• Dolby Digital encoder module.

Dolby Decode Module 
(The part number is CAT552.)
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1: IS-750-DOLBY-ENCE X

2: IS-750-DOLBY-ENCD X

3: IS-750-DOLBY-DEC2 X

4: IS-750-DOLBY-DEC2-ENCE X

5: IS-750-DOLBY-DEC2-ENCD X
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This module can decode both Dolby E and Dolby Digital. The Imagestore 750 decoder applica-
tion shown here is for Dolby E contribution audio only. The module accepts a stereo pair of 
Dolby data and up to 8 channels of backup PCM (not shown in the left figure) plus a backup 
metadata stream (not shown). The module outputs eight PCM audio channels, two PCM down-
mix audio channels (not shown) and a metadata stream. The delay through the module is 1 
frame, and an appropriate video delay should be applied to compensate for this. 

Fig. 6-8: Dolby CAT552 module Input/Output

Fig. 6-9: Imagestore 750 Configurator - Audio Graph representation of Dolby Decoder

Oxtel automation commands exist for controlling the module’s decoding mode. (See Automa-
tion Control on page 119.) 

The following decode modes are supported:

Automatic Decodes any compatible input type. When Dolby data is missing, the decoder 
uses backup PCM.

Dolby E Decodes only valid Dolby E and mutes any other type.

Dolby Digital Decodes only valid Dolby Digital (AC-3) and mutes any other type. It uses the 
stream type defined.

Mute Mutes regardless of the input type.

Force backup Forces the use of backup audio regardless of the input type.

A metadata revision preset file can also be defined. This file is used by the decoder module 
when there is no available metadata source from either the Dolby input or backup metadata 
stream. 

The decoder’s down-mix outputs provide an alternative stereo-only output based on the 
surround output. The down-mix mode parameter may be set to Lo/Ro (default), mono, or mute. 
The down-mix program select parameter indicates which program in the Dolby E bitstream is 
desired for down-mix.
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Down-Mix Options 
Lo/Ro (Left-only/Right-only) is a down-mixed stereo signal created from 5.1 audio signals that is 
fully stereo and mono compatible with very few side effects, but loses front-rear audio 
information.

Lt/Rt (Left-total/Right-total) is a down-mixed stereo audio signal created from 5.1 audio signals 
that keeps some front-rear audio information. 

(See also ‘Modes & Levels’ Tab on page 127 and Features Tab on page 131.) 

 Note: Lt/Rt down-mix is not available for Dolby decoding because this mode is broken in the 
module’s firmware. 

Dolby E Encoder Module 
(The part number is CAT559E.)

This module provides Dolby E encoding. The module accepts up to 8 channels of audio, as well 
as a metadata bitstream. The module outputs a stereo pair containing either encoded Dolby E, 
or PCM when it is in pass-through mode: 

Fig. 6-10: Dolby CAT559E Encoder module Input/Output

Fig. 6-11: Imagestore 750 Configurator - Audio Graph Dolby Encoder representation

The delay through the module is 1 frame. You should apply an appropriate video delay to 
compensate for it. 

Oxtel automation commands exist for controlling the module’s encoding modes. (See Automa-
tion Control on page 119.) 

The following encode modes are supported:

Encode Audio is encoded.

Pass-through Audio is passed through the module.

Follow decoder The encoder follows a decoder’s decode status. (When it decodes, the 
encoder will encode.)
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The audio latency for pass-through mode can be set either to match the encoding latency or to 
the minimum. The latency reduction parameter sets the number of sample periods (at 48 kHz) 
by which the encoding delay is reduced from the maximum value of 1 frame. 

The encoding bit depth parameter can be set to 20 bits (8-channel Dolby E) or 16 bits (6-channel 
Dolby E).

Dolby Digital Encoder Module 
(The part number is CAT559D.)

The Dolby CAT559D module provides Dolby Digital (AC-3) encoding. The module accepts up to 
6 channels of audio, as well as a metadata bitstream. The module outputs a stereo pair 
containing either encoded Dolby Digital, or PCM when in pass-through mode: 

Fig. 6-12: Dolby CAT555D module Input/Output

Fig. 6-13: Imagestore 750 Configurator - Audio Graph Dolby Encoder representation

The delay through the module is 6 frames. You should apply an appropriate video delay to 
compensate for this.: 

Oxtel automation commands exist for controlling the module’s encoding modes. (See Automa-
tion Control on page 119.) 

The following encode modes are supported:

Encode Audio is encoded.

Pass-through Audio is passed through the module.

Follow decoder The encoder follows a decoder’s decode status. (When it decodes, the 
encoder will encode.)

The audio latency for pass-through mode can be set either to match the encoding latency or to 
the minimum. The encoder latency can be set between 187 ms (default) and 450 ms. 

The encoder supports the following bitstream formats:
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• Dolby Digital 32 bit.

• Dolby Digital 16 bit channel 1.

• Dolby Digital 16 bit channel 2.

The encoder supports these automatic data rate modes:

• Auto 384

• Auto 448

The data rate is adapted to the channel coding (1/0, 2/0, . . . , 3/2) where 384 kbps and 448 kbps 
are the maximum rates. This is the recommended mode.

 Note: The standard data rate for ATSC transmission in the USA is 384 kbps.

The Dolby Digital (AC-3) encoder’s data rate may be set to any one of the following:

56 kbps 64 kbps 80 kbps 96 kbps 112 kbps 128 kbps

160 kbps 192 kbps 224 kbps 256 kbps 320 kbps 384 kbps

448 kbps 512 kbps 576 kbps 640 kbps

The channel modes (stereo, 5.1, etc.) determine the best data rate. This table summarizes the 
modes: 

Dolby Processing Times 
The Imagestore 750 takes one or more video frames to perform Dolby decoding and encoding: 

Note: The Imagestore 750 has built-in video delays that allow you to compensate for these 
delays. (See Video Frame Delays on page 43 and Audio Delays on page 146.) 

Table 6-2: Channel Mode Data Rates

Channel Mode Data Rate

1/0  C From 56 kbps, usually 96 kbps (mono)

2/0  L,R From 112 kbps, usually 192 kbps (stereo)

3/0  L,C,R From 256 kbps

2/1  L,R,S From 256 kbps

3/1  L,C,R,S From 320 kbps

2/2  L,R,Ls,Rs From 320 kbps

3/2  L,C,R,Ls,Lr From 384 kbps, often 448 kbps

Table 6-3: Dolby Processing Times

Type Direction Video Frames

Dolby E Decode 1

Dolby Digital Decode 1

Dolby E Encode 1

Dolby Digital Encode 6
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Upgrading Dolby Module Firmware  
Firmware for the Dolby modules is included within the Imagestore 750 software. A module’s 
firmware will be upgraded automatically during a software update, but only when an update is 
required.

Note: Each Dolby module firmware upgrade can take 3–4 minutes to complete. Therefore the 
overall software upgrade time could be extended by up to 16 minutes. Please monitor progress 
on Imagestore 750’s front panel and do not power down the Imagestore 750 too early. Doing so 
may render the Imagestore 750 inoperable.

Throughout the software upgrade, progress is reflected on the Imagestore 750’s front panel. The 
panel indicates which software/firmware file is being loaded. For Dolby modules, the filenames 
start with the Dolby module’s model number (for example, “Load cat552” or “Load cat559”).

Dolby Front Panel Display Items 
The following information relating to Dolby options is available at the front panel:

• Internal metadata sources.

The user-defined metadata preset to be loaded into the internal metadata sources can be 
set at the front panel. Choose Operate > Audio > MD Preset > Processor x, where 
x is 1, 2, 3, or 4.

• Audio module status and type.

Use the front panel menu Status > Audio Mod Stat to view the status and type of the 
optional audio modules installed. The status of the audio module can be one of the follow-
ing:

The module type shows whether an installed module is a Dolby decoder, a Dolby Digital 
encoder, a Dolby E encoder, or an up-mix module. 

• Input audio type.

The input status for all 16 channels of the 4 audio feeds and all 16 pairs of the AES inputs is 
available from the front panel. (See Inputs on page 164 for how these are configured.)

Status > Input Status > Audio Feed x > Channel y

Status > Input Status > AES > Pair n (L and R)

The front panel shows whether an input is carrying PCM, Dolby E, Dolby Digital, or non-PCM 
and whether the input is unlocked. It shows “Unknown” if the signal is locked but unrecog-
nized.

Configuring Dolby 
In versions of the Imagestore 750 software prior to v2.0.1, audio configuration was performed 
through hand-crafted text-based “mix files.” Although this is still possible, the graphical ‘Audio 
Graph’ page of the Imagestore 750 Configurator now makes designing and maintaining audio 
configurations much simpler, and is essential for configuring advanced audio modules such as 

Module Error The module has an error

Module OK There are no errors for the module

Not Fitted No module is installed

Unknown The module type is unknown
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Dolby. Delays through audio modules can also be calculated automatically. The Imagestore 750 
Configurator is available from the Miranda Conversion Software CD.

Note: If you are upgrading to newer software, you might prefer to retain your previous audio 
mix file if you are not using advanced audio modules. However, you will not benefit from the 
Imagestore 750 Configurator’s advanced audio features.

The Imagestore 750 Configurator (and its ‘Audio Graph’ page) is described in Chapter 8. The 
Imagestore 750 Configurator also provides a ‘Metadata Mode’ which is covered in Dolby Meta-
data on page 120. 

Automation Control 
Automation commands can be used to control some aspects of the audio modules.

Note: For details of the Oxtel automation protocol, see the documents listed under Applicable 
Publications and Tools on page 3. 

Dolby Decoder Modules 
Note: This applies only to the CAT552 decoder module. 

The Dolby decoder function can be set to one of the following modes using the ‘q3’ automation 
command: 

0 = Automatic.

1 = Dolby E.

2 = Dolby Digital.

3 = Mute.

4 = Force backup.

Please see Dolby Decode Module on page 113 for a description of each mode. 

Dolby E Encoder Modules 
Note: This applies only to the CAT559E encoder module.

The Dolby E encoder function can be set to one of the following modes using the ‘q1’ automa-
tion command: 

0 = Encode.

1 = Pass-through.

2 = From decoder status.

Please see Dolby E Encoder Module on page 115 for a description of each mode. 

Dolby Digital Encoder Modules 
Note: This applies only to the CAT559D encoder module.

The Dolby Digital encoder function can be set to one of the following modes using the ‘q2’ auto-
mation command:

0 = Encode.

1 = Pass-through.

2 = From decoder status.
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Please see Dolby Digital Encoder Module on page 116 for a description of each mode. 

Dolby Metadata 
Dolby metadata contains information about the audio bit-stream. It is different for Dolby Digital 
and Dolby E. 

• Dolby E metadata contains a copy of the Dolby Digital metadata for every program carried in 
the transport stream, as well as parameters specific to the transport stream such as what 
audio configuration of programs is being carried, for example 5.1 + 2. 

• Dolby Digital metadata contains data to be used by consumer electronics, such as mix levels 
for down-mixing surround sound into stereo.

Metadata can accompany the audio input into an Imagestore 750 and be routed though to 
output, or it can be supplied separately for use directly at the audio outputs. Metadata is 
routed through the Imagestore 750, connected between various metadata sources and des-
tinations. Metadata may be carried with the audio within an SDI or AES transport or sepa-
rately on a RS-485 serial connection.

The Imagestore 750’s metadata handling includes:

• A/B switching of metadata synchronously with the audio A/B-mixer.

• RS-485 serial metadata connections, flexible inputs and outputs.2

• Custom-defined metadata presets.

• Internal metadata generation from selectable custom-defined presets.

• Changing internally-generated metadata through automation.

• Flexible routing of metadata internally. 

Program Configuration 
Each Dolby decoder and encoder processes up to 8 mono audio channels. A “program configu-
ration” contains a set of audio “programs,” each of which contains a number of audio “channels.” 
For example, the program configuration “5.1 + 2” comprises two audio programs, 5.1 surround 
and stereo, with a total of eight audio channels.

2. Please refer to Rear Panel and Connections on page 200 for details of the RS-485 ports. 
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The composition of these eight channels is what Dolby metadata terms “program configura-
tion,” and metadata handling within the Imagestore 750 includes the following program 
configurations for Dolby E: 

Notation:

Notation “5.1” reflects the number of full-range channels, where “.1” reflects the limited range of 
the LFE channel.

Table 6-4: Dolby E Program Configuration - Main Output Channel Assignment Program Count, Channel Count

Dolby E Program 
Configuration

Main Output Channel Assignment

Pr
og

ra
m

  
Co

un
t

Ch
an

ne
l  

Co
un

t

1 2 3 4 5 6 7 8

5.1 + 2 1L 1R 1C 1LFE 1Ls 1Rs 2L 2R 2 8

5.1 + 1 + 1 1L 1R 1C 1LFE 1Ls 1Rs 2C 3C 3 8

4 + 4 1L 1R 1C 1S 2C 2S 2L 2R 2 8

4 + 2 + 2 1L 1R 1C 1S 3L 3R 2L 2R 3 8

4 + 2 + 1 + 1 1L 1R 1C 1S 3C 4C 2L 2R 4 8

4 + 1 + 1 + 1 + 1 1L 1R 1C 1S 4C 5C 2C 3C 5 8

2 + 2 + 2 + 2 1L 1R 3L 3R 4L 4R 2L 2R 4 8

2 + 2 + 2 + 1 + 1 1L 1R 3L 3R 4C 5C 2L 2R 5 8

2 + 2 + 1 + 1 + 1 + 1 1L 1R 3C 4C 5C 6C 2L 2R 6 8

2 + 1 + 1 + 1 + 1 + 1 + 1 1L 1R 4C 5C 6C 7C 2C 3C 7 8

1 + 1 + 1 + 1 + 1 + 1 + 1 + 1 1C 2C 3C 4C 5C 6C 7C 8C 8 8

5.1 1L 1R 1C 1LFE 1Ls 1Rs — — 1 6

4 + 2 1L 1R 1C 1S — — 2L 2R 2 6

4 + 1 + 1 1L 1R 1C 1S — — 2C 3C 3 6

2 + 2 + 2 1L 1R 3L 3R — — 2L 2R 3 6

2 + 2 + 1 + 1 1L 1R 3C 4C — — 2L 2R 4 6

2 + 1 + 1 + 1 + 1 1L 1R 4C 5C — — 2C 3C 5 6

1 + 1 + 1 + 1 + 1 + 1 1C 2C 3C 4C 5C 6C — — 6 6

4 1L 1R 1C 1S — — — — 1 4

2 + 2 1L 1R — — — — 2L 2R 2 4

2 + 1 + 1 1L 1R — — — — 2C 3C 3 4

1 + 1 + 1 + 1 1C 2C 3C 4C — — — — 4 4

7.1 1L 1C 1Ls 1Lb 1R 1LFE 1Rs 1Rb 1 8

7.1 Screen 1L 1C 1Ls 1Lc 1R 1LFE 1Rs 1Rc 1 8

L Left channel (front) Rs Right surround channel (rear, right)

R Right channel (front) Lb Left back channel

C Center channel (front) Rb Right back channel

S Surround channel (center rear) Lc Left center channel

Ls Left surround channel (rear, left) Rc Right center channel

LFE Low frequency effects channel
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Metadata Sources 
Metadata can be obtained from any of the following inputs:

• External RS-485 ports (4).

• Internal Dolby decoder module (4).

• Internal metadata A/B switch.

• Internally-stored custom-defined preset (4).

• Internal blank source.

Metadata Destinations 
Metadata passing through the Imagestore 750 can be supplied to a number of possible 
destinations:

• External RS-485 Ports (4).

• Dolby encoder module (4).

• Internal metadata A/B switch.

Metadata Routing 
All audio configurations that use Dolby and metadata have an accompanying metadata 
configuration. 

Metadata may be connected from any available “source” to any available “destination”. Metadata 
typically feeds an internal Dolby encoder to be embedded within the Dolby PGM output, or is 
output from the Imagestore 750 on an RS-485 port.

Use the ‘Audio Graph’ page under ‘Configuration Mode’ in the Imagestore 750 Configurator to 
configure metadata. Use ‘Metadata Mode’ to configure metadata presets. The following 
diagrams illustrate how to configure some simple metadata cases.
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Embedded SDI A/B Mixing (No Metadata) 
Figure 6-14 shows a simple 5.1 channel A/B mix, with SDI inputs and SDI output within the 
Imagestore 750 Configurator’s ‘Audio Graph’ page. 

Fig. 6-14: Audio graph - A/B Mixing Embedded PCM

Metadata Direct Routing 
Building on the sample of Figure 6-14, we next insert metadata at the output. In this case, a 
Dolby E encoder is added to the configuration. It is fed by external metadata from a serial RS-
485 communication port. However, the metadata could equally have come from any other 
metadata source.
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The metadata is then included within the Dolby E output via the PGM SDI stream. 

Fig. 6-15: Audio graph - Metadata Direct routing

Metadata Indirect A/B-Switched Routing 
Next, metadata is sourced from one of two RS-485 inputs, depending on the position of the 
audio A/B mixer. The metadata sources are cut at the half-way point of an audio A/B mix.
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The metadata is then included within the Dolby E output via the PGM SDI stream. 

Fig. 6-16: Audio graph - Metadata Indirect A/B Switched routing

 Note: Metadata generated internally by the Imagestore 750 is configured under ‘Metadata 
Mode’ within the Imagestore 750 Configurator.

Custom-Defined Metadata Presets 
There are 4 custom-defined metadata presets available in the Imagestore 750. The metadata 
presets form a complete list of all metadata parameters.

There are 4 internal metadata sources, called “banks” or “processors.” Custom-defined preset 
parameters can be loaded into these metadata banks.

The preset parameters for metadata are defined in the Imagestore 750 Configurator and trans-
ferred to the Imagestore 750 in a configuration file. After the configuration file is transferred, 
individual custom-defined preset files can then be loaded into the internal metadata banks 
through automation.
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After a custom-defined preset is loaded into an internal bank, its values can be over-ridden by 
subsequent automation commands. This does not affect the original custom-defined preset, 
just the values currently in use. 

Fig. 6-17: Imagestore 750 Configurator - Metadata Mode, Metadata presets

Metadata Mode  
Some metadata parameters are briefly described here. For a full description of Dolby metadata, 
refer to Dolby Labs’ metadata documentation:

• SMPTE RDD 6-2008, Description and Guide to the Use of the Dolby E Audio Metadata Serial Bit-
stream.

• Dolby Labs’ Metadata Guide.

The following parameters are found on the main left-hand pane of the Configuration Tool when 
in Metadata Mode.

• ‘Type’

This specifies which type of Dolby metadata is to be generated: 

• ‘Config’

This specifies the program configuration option. Available program configuration options 
are listed completely in Program Configuration on page 120.

 Note: This option is enabled only for Dolby E.

Dolby E Professional metadata

Dolby Digital Consumer metadata
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• ‘Pitch Shift’

This indicates the amount of pitch shift between the original playback speed and the current 
playback speed. 

• ‘Programs’

This control shows the available audio “programs” specified by the current ‘Config’ selection. 
When more than one “program” is available, you should select the one that you want to 
modify before making changes to the items in the right-hand pane of the metadata page.

 Note: This option is enabled only for Dolby E.

‘Modes & Levels’ Tab 
The parameters found in the ‘Modes & Levels’ tab of the metadata page are described here.

• ‘Description’

This allows the user to enter a textual description for the selected “program.” Any description 
entered appears in brackets within the list of programs.

• ‘Bitstream Mode’

This indicates the type of program service being carried. Choices include the following: 

• Main audio service: complete main (CM).

• Main audio service: music and effects (ME).

• Associated service: visually impaired (VI).

• Associated service: hearing impaired (HI).

• Associated service: dialogue (D).

• Associated service: commentary (C).

• Associated service: emergency (E).

• Associated service: voice over (VO).

• Main audio service: karaoke.

• ‘Audio Coding Mode’

This indicates which of the main service channels are in use. Choices include the following:

• 1/0 C

• 2/0 L,R

• 3/0 L,C,R

• 2/1 L,R,S

• 3/1 L,C,R,S

• 2/2 L,R,Ls,Rs

• 3/2 L,C,R,Ls,Rs

• ‘Center Mix Level’

This indicates the nominal down-mix level of the center channel (C) with respect to the left 
(L) and right (R) channels. Choices include the following:

• 0.707 (–3 dB)

• 0.595 (–4.5 dB)

• 0.500 (–6 dB)
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 Note: This option is enabled only for Dolby E.

• ‘Surround Mix Level’

This indicates the nominal down-mix level of the surround channels if they are in use. 
Choices include the following:

• 0.707 (–3 dB)

• 0.500 (–6 dB)

• 0

 Note: This option is enabled only for Dolby E.

• ‘Dolby Surround Mode’

This indicates whether program has been encoded in Dolby Surround. It can take one of the 
following values. Choices include the following:

• Not indicated

• Not encoded

• Encoded

 Note: This option is not used by the Dolby Digital (AC-3) decoder, but may be used by 
other portions of the audio reproduction equipment.

• ‘Dialogue Normalization’

The dialogue element of program audio generally serves as a reference for the loudness of 
all the other audio. When audio from different sources is reproduced, the apparent loudness 
of the dialogue element frequently varies from source to source.

The ‘Dialogue Normalization’ parameter indicates the average dialogue loudness during the 
program. It is used by the section of the sound reproduction system responsible for setting 
the reproduction level.

• ‘Mix Level’

The mix level indicates the absolute acoustic sound pressure level of an individual program 
during the final audio mixing session. The code represents a value in the range 0–31. The 
peak mixing level is 80 plus the value of the mix level in dB SPL, or 80 to 111 dB SPL. The peak 
mixing level is the acoustic level of a sine wave in a single channel whose peaks reach 100 
percent in the PCM representation. The absolute SPL value is typically measured by means of 
pink noise with an RMS value of 20 or 30 dB below the peak RMS sine wave level. The value of 
the mix level is not typically used within the Dolby Digital (AC-3) decoder, but can be used 
by other parts of the audio reproduction equipment. 

• ‘Room Type’

The room type indicates the relative size and monitor frequency response curve of the mix-
ing room used for the final audio mixing session. The room type value is not typically used 
by the AC-3 decoder, but can be used by other parts of the audio reproduction equipment. 
Choices include the following:

• Not indicated.

• Large room.

• Small room.
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• ‘Preferred Down-mix Mode’

The preferred stereo down-mix mode setting indicates the type of stereo down-mix pre-
ferred by the mastering engineer. This information may be used by the Dolby Digital (AC-3) 
decoder to configure the type of stereo down-mix automatically, but can also be overridden 
or ignored. Choices include the following:

• Not indicated.

• Lt/Rt down-mix preferred.

• Lo/Ro down-mix preferred.

Note: For information on down-mix options, see Down-Mix Options on page 115. 

• ‘Lt/Rt Center Mix Level’

This setting indicates the nominal down-mix level of the center channel with respect to the 
left and right channels in a Lt/Rt down-mix. Choices include the following:

• 1.414 (+3.0 dB)

• 1.189 (+1.5 dB)

• 1.000 (0.0 dB)

• 0.841 (–1.5 dB)

• 0.707 (–3.0 dB)

• 0.595 (–4.5 dB)

• 0.500 (–6.0 dB)

• 0.000 (–inf dB)

 Note: The meaning of this field is defined as described only if the audio coding mode is 
3/0, 3/1 or 3/2. If the audio coding mode is 1/0, 2/0, 2/1, or 2/2 then the meaning of this 
field is reserved.

• ‘Lt/Rt Surround Mix Level’

This setting indicates the nominal down-mix level of the surround channels with respect to 
the left and right channels in a Lt/Rt down-mix. Choices include the following:

• 0.841 (–1.5 dB)

• 0.707 (–3.0 dB)

• 0.595 (–4.5 dB)

• 0.500 (–6.0 dB)

• 0.000 (–inf dB)

 Note: The meaning of this field is defined as described only if the audio coding mode is 
2/1, 3/1, 2/2 or 3/2. If the audio coding mode is 1/0, 2/0 or 3/0 then the meaning of this 
field is reserved.

• ‘Lo/Ro Center Mix Level’

This setting indicates the nominal down-mix level of the center channel with respect to the 
left and right channels in a Lo/Ro down-mix. Choices include the following:

• 0.841 (–1.5 dB)

• 0.707 (–3.0 dB)

• 0.595 (–4.5 dB)

• 0.500 (–6.0 dB)
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• 0.000 (–inf dB)

 Note: The meaning of this field is defined as described only if the audio coding mode is 
2/1, 3/1, 2/2 or 3/2. If the audio coding mode is 1/0, 2/0 or 3/0 then the meaning of this 
field is reserved.

• ‘Lo/Ro Surround Mix Level’

This setting indicates the nominal down-mix level of the surround channels with respect to 
the left and right channels in a Lo/Ro down-mix. Choices include the following:

• 0.841 (–1.5 dB)

• 0.707 (–3.0 dB)

• 0.595 (–4.5 dB)

• 0.500 (–6.0 dB)

• 0.000 (–inf dB)

 Note: The meaning of this field is defined as described only if the audio coding mode is 
2/1, 3/1, 2/2 or 3/2. If the audio coding mode is 1/0, 2/0, or 3/0 then the meaning of this 
field is reserved.

• ‘Dolby Surround EXTM Mode’3

This mode indicates whether the program has been encoded in Dolby Surround EX.TM This 
information is not used by the AC-3 decoder, but can be used by other portions of the audio 
reproduction equipment. Choices include the following:

• Not indicated. 

• Not Dolby Surround EXTM encoded.

• Dolby Surround EXTM encoded.

Example: Note: The meaning of this field is defined as described only if the audio coding 
mode is 2/2 or 3/2. If the audio coding mode is 1/0, 2/0, 3/0, 2/1 or 3/1 then the meaning 
of this field is reserved.

• ‘Dolby Headphone Mode’

This setting indicates whether the program has been Dolby Headphone-encoded. This infor-
mation is not used by the Dolby Digital (AC-3) decoder, but can be used by other portions of 
the audio reproduction equipment. If the value is set to the reserved code, the decoder 
should still reproduce audio. Choices include the following:

• Not indicated.

• Not Dolby headphone encoded.

• Dolby headphone encoded.

 Note: The meaning of this field is only defined as described if the audio coding mode is 
2/0. If the audio coding mode is 1/0, 3/0, 2/1, 3/1, 2/2 or 3/2 then the meaning of this 
field is reserved.

• ‘AD Converter Type’

This setting indicates the type of A/D converter used to capture the PCM audio. This informa-
tion is not used by the AC-3 decoder, but can be used by other portions of the audio repro-

3. “Surround EX” is a trademark of Dolby Laboratories.
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duction equipment. If the type of A/D converter used is not known, choose the ‘Standard’ 
setting. Choices include ‘Standard’ and ‘HDCD’.

Features Tab 
The parameters of the ‘Features’ tab in the ‘Metadata’ page are described here.

• ‘Low Frequency Effects’

This setting indicates whether the low-frequency effects (LFE) or subwoofer channel is on or 
off.

• ‘Copyright’

If you set this attribute, the information in the bitstream is indicated as protected by copy-
right. Otherwise it is not indicated as protected. 

• ‘Original Bitstream’

This attribute indicates whether the bitsteam is original or a copy of another bitstream.

• ‘DC High Pass Filter’

This parameter indicates whether the DC blocking 3 Hz high-pass filter is applied to the main 
input channels in the Dolby Digital encoder. It is used to remove DC offsets in the program 
audio and would only be switched off in exceptional circumstances.

• ‘Bandwidth Low Pass Filter’

This parameter determines whether a low-pass filter is applied to the main input channels of 
a Dolby Digital encoder prior to encoding. The filter removes high-frequency signals that are 
not encoded. At suitable data rates, this filter operates above 20 kHz. In all cases, it prevents 
aliasing on decoding. It is normally switched on. This parameter is not passed to the Dolby 
Digital (AC-3) decoder.

• ‘LFE Low Pass Filter’

This parameter determines whether a 120 Hz low-pass filter (used to remove frequencies 
above 120 Hz that would cause aliasing when decoded) is applied to the LFE channel input 
of a Dolby Digital encoder prior to encoding. It is ignored if the LFE channel is disabled. This 
filter should be switched off only if the audio to be encoded is known to have no signal 
above 120 Hz. This parameter is not sent to the consumer Dolby Digital (AC-3) decoder.

• ‘Surround 90 Degrees Phase’

This parameter causes the Dolby Digital encoder to apply a 90-degree phase shift to the sur-
round channels. This allows a Dolby Digital decoder to create a Lt/Rt down-mix simply. For 
most audio material, the phase shift has a minimal impact when the Dolby Digital program 
is decoded to 5.1 channels, but provides a Lt/Rt output that can be Pro Logic®-decoded to L, 
C, R, and S, if desired. However, for some phase-critical material (such as music) the phase 
shift is audible when one is listening in 5.1 channels. Similarly, some material down-mixes to 
a satisfactory Lt/Rt signal without needing this phase shift. It is therefore important to bal-
ance the needs of the 5.1 mix and the Lt/Rt down-mix for each program. This parameter is 
not sent to the Dolby Digital (AC-3) decoder.

• ‘Surround Attenuation’

The Surround 3 dB attenuation parameter determines whether the surround channel(s) are 
attenuated 3 dB before encoding. It is used to compensate for the level of the surround sig-
nal(s) originating from a theatrical mixing room (dubbing stage) and those originating from 
mixing rooms used for television and DVDs. For compatibility with older film formats, theat-
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rical mixing rooms set the surround playback channel sensitivity (and thus the reproduced 
SPL) 3 dB lower than the sensitivity (thus reproduced SPL) of the front channels. The conse-
quence is that the surround signal levels on tapes produced in a dubbing stage are 3 dB 
higher than those produced in a consumer mixing room. Therefore, to convert to a con-
sumer mix from a theatrical mix, it is necessary to reduce the surround levels by 3 dB by 
enabling this parameter.

• ‘RF Pre-Emphasis’

This parameter is designed to protect against over modulation when a decoded Dolby Digi-
tal bitstream is RF-modulated. When enabled, the Dolby Digital encoder includes pre-
emphasis in its calculations for RF mode compression. The parameter has no effect when 
decoding using line mode compression. Except in rare cases, this parameter should be dis-
abled.

Compression Tab 
The following are the compression profile parameters found within the ‘Compression’ tab under 
‘Metadata Mode’ in the Imagestore 750 Configurator.

• Profile

This field indicates the RF compression word of the AC-3 bitstream associated with the spec-
ified program.

The setting allows the program provider (or broadcaster) to implement a large dynamic 
range reduction (heavy compression) in a way that ensures that a monophonic down-mix 
does not exceed a certain peak level. The heavily compressed audio program might be desir-
able for certain listening situations such as movie delivery to a hotel room, or to an airline 
seat. The peak level limitation is useful when, for instance, a monophonic down-mix feeds an 
RF modulator and over modulation must be avoided.

A compression profile is one of the following:

• None

• Film, Standard

• Film, Light 

• Music, Standard

• Music, Light

• Speech

Dynamic Range Tab 
Each audio “program” carried within a Dolby E stream has a stream of dynamic range control 
profiles associated with it. The dynamic range is composed of the profile to which the value 
applies (value between 1 and 8), and the actual dynamic range profile value:

• None

• Film, Standard

• Film, Light 

• Music, Standard

• Music, Light

• Speech
132



Imagestore 750
User Manual
Automation Control 
Automation commands can be used to change internal metadata source values. The internal 
sources of metadata are termed “banks.” There are 4 available banks.

 Note: For details of the Oxtel automation protocol, see the Automation publications listed 
under Applicable Publications and Tools on page 3. 

Internal Metadata Sources 
Oxtel automation commands starting with “o” are used for controlling internal Dolby metadata 
parameters. 

 Note: Although many aspects of metadata sources can be controlled individually, it is pref-
erable to prepare a set of required presets beforehand and load them using the ‘oT’ 
command. 

Up-Mix 
“Up-mix” is the conversion of 2-channel audio to multi-channel audio. The up-mix audio option 
adds integral up-mix capability to the Imagestore 750. It creates a multi-channel-compatible 
audio signal from a stereo source using the Linear Acoustic upMAXTM up-mixing algorithm. 

The up-mix audio module provides the following features:

• Stereo to multi-channel audio.

• Up to 4 up-mix modules.

• Linear Acoustic’s upMAXTM up-mix algorithm.

• AutoMAXTM and metadata follow modes.

• Down-mix compatible output.

• Control through Oxtel automation command extensions.

• Configurable in the ‘Audio Graph’ page of the Imagestore 750 Configurator. (See Chapter 8.)

Note: up to 4 Dolby encode, Dolby decode, and Up-Mix audio modules can be installed in 
the Imagestore 750 at one time.
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Up-Mix Configurations 
A number of different up-mix combinations can be configured. For example, it can be posi-
tioned after or before the A/B mix to suit the formatting of the source audio: 

Fig. 6-18: Imagestore 750 Up-Mix positioned before/after A/B Mix

Product Codes 
Product codes for Imagestore 750 are as follows:

The complete set of Imagestore 750 product codes is listed in Chapter 11.

Up-Mix Kit 
The up-mix kit is IS-750-UMX. 

The up-mix kit applies to new factory-built Imagestore 750s. It provides:

• Audio module carrier card.

• Additional RS-485 serial ports.

• Up-mix module (one).

Up-Mix Upgrade 
The up-mix upgrade product code is IS-750-UMX-UPG .

The up-mix upgrade is used either to supplement a factory-built Imagestore 750 that either has 
an up-mix kit or Dolby kit. Alternatively, it can be used to purchase additional up-mix modules 
at a later date. 

This option is applicable only to an Imagestore 750 already equipped with a Dolby carrier board. 
It includes one up-mix module. 
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IS-750-UMX Up-mix kit
IS-750-UMX-UPG Up-mix upgrade 
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Technical Specifications 
An Imagestore 750 that is equipped with an up-mix kit has a carrier card containing 4 slots avail-
able for either up-mix or Dolby modules. There are no specific slots for up-mix modules because 
the Imagestore 750 detects the modules’ presence and type automatically.

Up-Mix Module 
The part number is MOD-LA-DUP701.

The up-mix audio module supports Linear Acoustic’s upMAXTM 5.1-channel surround-field 
synthesizer under license. It creates “down-mix-compatible” left, right, center, surround and LFE 
channels from a two-channel audio input. 

You can place each up-mix module in one of 4 modes:

• Pass-through.

In pass-through mode, six input channels are passed through the module unaltered: 

Fig. 6-19: Up-Mix module, pass-through mode

• Up-mix.

In this mode, the module synthesizes a multi-channel audio signal from a stereo audio input. 

Fig. 6-20: Up-Mix module, Stereo Up-Mix mode

• From metadata.

In this mode, the control of up-mixing or passthrough is steered by metadata. This allows 
automated stereo/surround switching between inputs when the input source contains 
same-source audio transitions. 

Fig. 6-21: Up-Mix module, From Metadata mode

• AutoMAX.TM

‘AutoMAXTM’ mode will automatically switch between stereo and 5.1 at its input to provide 
5.1 output at all times. It will automatically decide whether to up-mix.4, 5 This ensures a fully 
automatic delivery of 5.1 audio to the consumer. 

&�'��#

4� 	���������
�

&�'��# �����
�
�

&�'��# ���� 	���
���� 	���
�����
�
�

�
������

4. Current up-mix modules use Linear Acoustics’ AutoMax-IITM algorithm.
5. Earlier up-mix modules used an earlier Linear Acoustics’ AutoMax-ITM algorithm. When up-mix was en-

abled, the input channels 1 and 2 (L/R) were always up-mixed onto outputs 1–6 (L/R/C/LFE/Ls/Rs). If in-
put channels 3–6 were also present then these signals were mixed onto the up-mixed C/LFE/Ls/Rs 
outputs. In summary, there was no dynamic signal detection between 5.1 and stereo inputs. 
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Fig. 6-22: Up-Mix module, AutoMax mode

 Note: When AutoMAXTM is enabled, the input channels 1 and 2 (L/R) are always up-mixed 
onto outputs 1-6 (L/R/C/LFE/Ls/Rs). If input channels 3–6 are also present then these signals 
are mixed onto the up-mixed C/LFE/Ls/Rs outputs. In summary, there is no dynamic signal 
detection between 5.1 and stereo inputs.

The following additional parameters may be set on an up-mix module:

The Imagestore 750 Configurator’s ‘Audio Graph’ page shows a pair of down-mix outputs in 
addition to the 6 up-mix outputs. These give an alternative mix for any stereo-only applications: 

Fig. 6-23: Imagestore 750 Configurator - Audio graph Up-Mix representation

Up-Mix Processing Times 
Up-mix processing takes one video frame to perform. 
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Parameter Description

LFE enable Enable or disable low frequency effects.

LFE level Sets the level of the created bass enhancement signal (expressed as percent-
age)

Center width Controls how much of the center channel of the up-mixer is spread to the left 
and right channels. 0%=full center, 100%=full L/R.

Surround depth Controls back-to-front panning of the surround output where 100% equals 
full signal from left surround (Ls) and right surround (Rs) and 0% equals sur-
round fully mixed into the left/right/center (L/R/C) channels. 0%=full L/R, 
100%=full Ls/Rs. 

Up-mix to discrete time Time (ms) to cross-fade from up-mixed output to discrete (non-up-mixed) 
source.

Discrete to up-mix time Time (ms) to cross-fade from discrete (non-up-mixed) source to up-mixed 
output.

Threshold Sets the threshold for the AutoMAX-II algorithm to decide that the input 
audio is not 5.1 (expressed in dB as a positive number).

Down-mix type Sets the down-mix type as Lt/Rt or Lo/Ro. (See Down-Mix Options on 
page 115)

Table 6-5: Up-Mix parameters
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The Imagestore 750 has built-in video delays that allow you to compensate for this delay. This is 
described, for Dolby modules, in Audio Delays on page 146. The same principles apply to up-
mix.

Upgrading Up-Mix Module Firmware 
Firmware for the up-mix modules is included within the Imagestore 750 software release. A 
module’s firmware will be upgraded automatically during a software update, but only when an 
update is required. 

 Note: Each up-mix module firmware upgrade can take 3 or 4 minutes to complete. Therefore 
the overall software upgrade time could be extended by up to 16 minutes. 

Please monitor the progress of the upgrade on the Imagestore 750’s front panel. Do not power 
down the Imagestore 750 too early because doing so can render the Imagestore 750 inoperable.

Throughout the upgrade, progress is reflected on the front panel of the Imagestore 750. The 
panel indicates which software/firmware file is being loaded. 

For up-mix modules, the panel shows the firmware upgrade as ‘Load up-mix’.

Configuring Up-Mix 
The ‘Audio Graph’ page of the Imagestore 750 Configurator is the recommended tool for 
designing audio configurations that incorporate up-mix modules. See Audio Graph on 
page 161.

Imagestore 750 Configurator 
In the Imagestore 750 Configurator, you can do the following:

• Draw the audio configuration, connecting audio inputs and outputs and other audio blocks 
to up-mix blocks.

• Draw Dolby metadata configurations and connect any required metadata to up-mix mod-
ules 

Type Video Frames

Up-mix 1

Table 6-6: Up-Mix processing times
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Connecting Up-Mix Modules 
Figure 6-24 shows how an up-mix module might be inserted in the audio graph. In this example, 
the inputs can be in stereo or 5.1 surround. 

Fig. 6-24: Imagestore 750 Configurator - Connecting Up-Mix modules

Connecting Metadata to Up-Mix Modules 
We need to control the up-mix module depending on whether the input is stereo or 5.1 
surround, so the module can know whether to up-mix the input, or pass it straight through. To 
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do this, place up-mix module in ‘From Metadata’ mode, and then use the first RS-485 port to 
control whether up-mix is enabled or disabled. 

Fig. 6-25: Imagestore 750 Configurator - Connecting Metadata to Up-Mix module

Metadata 

Dolby metadata contains information about the audio bit-stream including what configuration 
of “programs” is being carried; for example 5.1 + 2. Therefore, you can use Dolby metadata to 
drive an up-mix processor.

Metadata can be carried in the Dolby signal on AES, on SDI, or separately on an RS-485 serial 
connection.

Metadata handling within the Imagestore 750 includes:

• A/B switching of metadata synchronously with the audio A/B mix.

• RS-485 serial metadata connections.6

• Flexible inputs and outputs.

• Custom-defined metadata presets.

• Internal metadata generation from selectable custom-defined presets.

• Changing internally-generated metadata through automation.

• Flexible routing of metadata internally.

These points are explained in Dolby Metadata on page 120.

6. Please refer to Rear Panel and Connections on page 200 for details of the RS-485 ports.
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Metadata Monitoring and Processing 
The Imagestore 750 can route metadata from any one of its internal metadata sources. It can use 
custom-defined metadata presets to set up the metadata audio channel mode, parameters of 
which can then be modified through automation.

 Note: There is no support for dynamic processing of metadata parameters contained within 
an external Dolby bit-stream.

Custom-Defined Metadata Presets 
There are 4 user-defined metadata presets available in the Imagestore 750. The metadata 
presets form a complete list of all metadata parameters.

There are 4 internal metadata sources, called “banks” or “processors.” Custom-defined preset 
parameters can be loaded into these metadata banks.

The preset metadata parameters are defined in the Imagestore 750 Configurator and transferred 
to the Imagestore 750 in a configuration file. After the configuration file is transferred, automa-
tion can then load individual custom-defined preset files into the internal metadata banks.

After a custom-defined preset is loaded into an internal bank, its values can be over-ridden by 
subsequent automation commands. This does not affect the original custom-defined preset, 
just the values currently in use.

Dolby Metadata on page 120 gives further information regarding the individual metadata 
parameters.

Automation Control 
Automation commands can control some aspects of the audio modules and to change internal 
metadata source values. The internal sources of metadata are called “banks.” There are 4 avail-
able banks.

The metadata commands are summarized in Automation Control on page 119. 

Note: For details of the Oxtel automation protocol, see the Automation publications listed 
under Applicable Publications and Tools on page 3. 

Up-Mix Modules 
The up-mix function can be placed, with the ‘q0’ automation command, in one of the following 
modes:

0 = Passthrough.

1 = Enable.

2 = AutoMD (follow metadata).

3 = AutoMAXTM

Please see Technical Specifications on page 135 for a description of each mode. 

Audio Description (AD) 
Audio description refers to additional narration for blind and visually impaired consumers of 
visual media including television. It consists of a narrator talking through the television 
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program, describing what is happening on the screen during the natural pauses in the audio, 
and sometimes during dialogue if it is deemed necessary.

When the viewer hears the television program, the original program audio track is mixed with 
this additional narration or commentary. The mixing can be done at one of two places in the TV 
signal chain:

• AD receiver mix. 

• AD broadcast mix.

AD Receiver Mix 
Program audio is mixed with the mono AD commentary in each TV receiver. The viewer can 
adjust the AD commentary level at their own receiver. Mixing is performed under the control of 
a special control tone signal, which can be passed as an audio signal through television equip-
ment for transmission. In this mode, both the original program audio and AD tracks (mono 
commentary and control tone) are broadcast.

Note: No special Imagestore 750 option is needed in this case because the control tone signal 
and the extra audio commentary track can both be passed as ordinary audio signals through 
the Imagestore 750.

AD Broadcast Mix 
Program audio is mixed in with the AD commentary at the TV station ready for transmission. 
Mixing is again performed under the control of a special control tone signal, but this time it is 
done by the Imagestore 750 ahead of transmission. In this mode, both the original program 
audio and program-with-commentary are broadcast. 

A mono commentary track is mixed by Imagestore 750 with stereo background audio to yield 
an extra program-audio stereo track with the commentary mixed in. The mixing of the commen-
tary track is (again) controlled by a special control tone from another audio channel. The control 
tone determines how the background audio is ducked and the commentary mixed with it.

Note: The IS-750-AD option is required in this case. 

Product Code 
The code for the Imagestore 750’s audio description is IS-750-AD. It represents one AD block 
only.

Note: This is a software option which does not require any hardware upgrade.

The complete set of Imagestore 750 product codes is listed in Chapter 11.

Configuration 
After the audio description option has been purchased and installed, a single ‘Audio Descrip-
tion’ block becomes selectable within the Imagestore 750 Configurator’s ‘Audio Graph’. You can 
place this block in your audio configurations as required.
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An audio configuration with a single audio feed connected to an AD block is shown in the 
following ‘Audio Graph’ example: 

Fig. 6-26: Imagestore 750 Configurator - Audio graph, Audio Description block

The PGM output gives the following audio on its first four channels:

1  Stereo-left background audio.

2  Stereo-right background audio.

3  Stereo-left background audio with AD commentary mix.

4  Stereo-right background audio with AD commentary mix.

The channels (or pins) of the input audio feed contain the following signals:

1  Stereo-left background audio.

2  Stereo-right background audio.

3  AD commentary track.

4  AD control tone.

The first two input pins are passed-through to the ‘SDI PGM Output’ block (pins 1 and 2) to give 
a straight copy of the stereo background audio. All four input pins are then connected to the 
relevant pins of the AD block, the output of which is routed to pins 3 and 4 of the ‘SDI PGM 
Output’ block. 

An audio configuration with dual audio feeds plus an A/B-mixer feeding an AD block is shown in 
the following ‘Audio Graph’ sample: 

Fig. 6-27: Imagestore 750 Configurator - Audio Description audio graph
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Note: The AD control tone must be A/B cut (not A/B mixed) so that the control tone always 
remains valid.

In both cases, the broadcast consumer will start hearing the AD commentary mix when they 
switch from the first to the second stereo pair.

Silence Detection 
Note: Silence detection is included as part of the standard audio options (IS-750-Audio6 and 
IS-750-Audio16).

Introduction 
Silence detection is used to automate control of one or more audio voice-overs based on the 
audio level present within the audio source:

• Embedded SDI audio.

• AES inputs.

• Easyplay audio clips (including wide multi-language clips).

When an external audio voice-over can appear at any time (from embedded SDI audio or AES 
inputs), silence detection automatically ducks the background and mixes the voice-over. This is 
very useful because it removes the need for synchronous automation to control the voice-over. 

Easyplay clips that contain multiple language variants most probably have different running 
times for each language. With traditional voice-overs, the background for all channels must 
remain ducked until the final language completes playing out; which is clearly problematic for 
other languages that finished earlier. The silence detection feature gets around this by 
detecting the finished language clip and restoring the background audio to its normal level.

Configuration 
Follow these steps to add silence detection blocks into an audio configuration:

1  Open the Imagestore 750 Configurator’s ‘Audio Graph’ page.

2  Drag an instance of ‘Audio AutoDuck’ onto the audio graph.

3  Select the number of channels per mixer source (1 to 16).

Note: A maximum of 16 audio channels can be shared between all silence detection blocks. 

4  Connect appropriate sources to the background (BG) and voice-over (VO) input pins.

5  Connect appropriate destinations to the output pins.

6  Set the following parameters for the ‘Audio AutoDuck’ block:

Parameter Default Description

Silence threshold –40 Level at which to consider the voice-over input as silent (in dB)

Silence trigger dura-
tion

25 Duration to wait (in fields) with audio below silence threshold 
before considering input to be silent

Fade-out rate 25 Fade from duck rate (in fields)

Fade-in rate 2 Fade to duck rate (in fields)

Table 6-7: Imagestore 750 Configurator - Audio AudioDuck parameters
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In this example, an Intuition XG provides a stereo audio voice-over embedded within an SDI fill 
signal. Whenever the audio voice-over is present, it is mixed automatically into the background 
audio. There is no need for that the Intuition XG to send any automation commands to the 
Imagestore 750 to control the voice-over block. 

Fig. 6-28: Imagestore 750 Configurator - Silence Detection example, external voice-over audio on SDI fill

Note: AES audio sources (such as EAS audio warning messages) can also provide the external 
voice-over.

Duck level –20 Duck level (in dB)

Duck mode Individ-
ual mode

Which channels are ducked when the voice-over becomes active. 
‘Individual mode’ means each channel duck is individually con-
trolled. ‘Collective mode’ means that all channels are ducked 
whenever any voice-over activity is detected.

Parameter Default Description

Table 6-7: Imagestore 750 Configurator - Audio AudioDuck parameters
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In the next example, a multi-language Easyplay clip (4 x stereo pairs) feeds an ‘AutoDuck’ silence 
detection block in ‘individual mode’: 

Fig. 6-29: Imagestore 750 Configurator - Silence Detection example, multi-language Easyplay audio clip

Although this configuration is likely to work well, there might be differences in the ducking for 
an individual language if there is any stereo panning present in the source. A better solution is 
to use individual ‘AutoDuck’ blocks for each language and place each block into ‘collective 
mode’, as shown here: 

Fig. 6-30: Imagestore 750 Configurator - Silence Detection example with several AutoDucks

This ensures that each stereo pair is ducked collectively.
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Audio Delays 
Dolby decoding and encoding takes time to perform. It is very important that the audio and 
video delays through the Imagestore 750 are consistent and unchanging to avoid lip-sync issues 
or “jumps” in transmission. This section addresses how you can achieve that.

See Dolby Processing Times on page 117, 

Dolby Delays 
This table lists the audio delay incurred for various Dolby decode/encode use cases, The delay is 
expressed in video frames:

See Video Frame Delays on page 43 for a list of the different video frame delays that are avail-
able to compensate for any audio delays incurred by Dolby processing, such as for the use cases 
listed above. 

The following table shows the program delays required for the Dolby use cases above:

When an Imagestore 750 is configured to use its DVE, the DVE delays the video by 1 or 2 frames. 
In this case, a compensating delay must be inserted into the background video path, post AB 
mixer: A ‘PGM post A/B-mix’ delays must be applied to PGM video7 to compensate for the extra 
video delay that will be incurred when processing DVE:

Interlaced video standards 1 frame.

Progressive video standards 2 frames.

Decode Encode Dolby Delay (Frames)

— Dolby E 1

— Dolby Digital 6

Dolby E — 1

Dolby E Dolby E 2 = (1 + 1)

Dolby E Dolby Digital 7 = (1 + 6)

Table 6-8: Delay for Dolby decode/encode

Decode Encode
PGM Audio Delay PGM Video Delay—No DVE

Dolby PCM Post A/B-Mix Output

— Dolby E 1 — — 1

— Dolby Digital 6 — — 6

Dolby E — 1 — — 1

Dolby E Dolby E 2 — — 2

Dolby E Dolby Digital 7 — — 7

Table 6-9: Video delays for Dolby delay compensation

7. A post-A/B mix delay must also be applied to preview bus video if DVE preview is required.
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The following table shows the PGM delays required for the above Dolby use cases when DVE 
processing is required on an interlaced video standard:

The following table shows the PGM delays required for the above Dolby use cases when DVE 
processing is required on a progressive video standard:

Note: In rows 1 and 3 of the preceding table, the video delay fo in-stream branding exceeds the 
audio delay for Dolby processing. Additional PCM audio delays must therefore be added so lip 
sync is maintained.

When an Imagestore 750 is configured for in-stream branding insertion, approximately 6 frames 
of ‘PGM post A/B-mix’ delay must be applied to PGM video to compensate for the the extra 
video delay that will be incurred. The following table shows the PGM delays required for the 
above Dolby use cases when in-stream branding insertion is required:

Decode Encode PGM Audio Delay
PGM Video Delay—DVE 

(Interlaced)

Dolby PCM Post A/B-Mix Output

— Dolby E 1 — 1 0

— Dolby Digital 6 — 1 5

Dolby E — 1 — 1 0

Dolby E Dolby E 2 — 1 1

Dolby E Dolby Digital 7 — 1 6

Table 6-10: PGM delays for Dolby cases, with DVE for interlaced video standard

Decode Encode PGM Audio Delay
PGM Video Delay—DVE 

(Progressive)

Dolby PCM Post A/B-Mix Output

— Dolby E 1 1 2 0

— Dolby Digital 6 — 2 4

Dolby E — 1 1 2 0

Dolby E Dolby E 2 — 2 0

Dolby E Dolby Digital 7 — 2 5

Table 6-11: PGM delays for Dolby cases, with DVE for progressive video standard

Decode Encode PGM Audio Delay
PGM Video Delay—In-
Stream Branding

Dolby PCM Post A/B-Mix Output

— Dolby E 1 5 6 0

— Dolby Digital 6 — 6 0

Dolby E — 1 5 6 0

Table 6-12: PGM delays for Dolby cases, in-stream branding
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See In-Stream Branding Insertion on page 18 for additional information.

Note: In rows 1, 3, and 4 of the preceding table, the video delay for in-stream branding exceeds 
the audio delay for Dolby processing. Additional PCM audio delays must therefore be added so 
lip sync is maintained.

Metadata Delays 
Dolby metadata normally corresponds to one of the following use-cases:

Pass-through Metadata from the video source(s) is passed through decoder(s) and 
encoder(s).

Insert at output Metadata stream is fed to the Dolby encoder.

Dolby metadata that passes through decoders and encoders automatically incur the same delay 
as audio. (See Dolby Processing Times on page 117 and Dolby Delays on page 146.) Any meta-
data that bypasses decoders must be set up to match the audio delay.

Note: Dolby metadata processors incur a minimum 2 frame delay when set in modification 
mode.

Audio Delay Blocks 
The audio engine has up to 6 audio delay banks available for use in the ‘Audio Graph’ of the 
Imagestore 750 Configurator. Each audio delay bank is 16 audio channels wide. Each banks’s 
delay value is configurable in the Imagestore 750 Configurator ‘Audio Graph’ or in the front 
panel using ‘Setup > Audio Setup > Delays’. (See Audio Delay Blocks on page 167.) 

Each delay bank can provide from 1 to 32,767 audio samples of delay, where the audio sample 
rate is 48 kHz. This provides over 16 video frames of audio delay for each audio delay block, 
although the actual delay in frames depends upon the frame rate for the current video standard 
as follows:

50 Hz standards Maximum of 17.06 frames audio delay.

59.94 Hz standards Maximum of 20.45 frames audio delay.

You can use audio delay banks and video frame delays in conjunction to ensure that the audio 
and video are kept in sync when processing in-stream branding insertion, DVE, Dolby E, Dolby 
Digital encoding or decoding, stereo to 5.1, or up-mix.

Dolby E Dolby E 2 4 6 0

Dolby E Dolby Digital 7 — 6 1

Decode Encode PGM Audio Delay
PGM Video Delay—In-
Stream Branding

Dolby PCM Post A/B-Mix Output

Table 6-12: PGM delays for Dolby cases, in-stream branding
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Control and Monitoring 
Chapter 7 provides information about controlling the Imagestore 750 and monitoring its status.

Topics
Control Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 149 
Monitoring and Alarms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 151 

Control Options 
The Imagestore 750 can be controlled in several different ways:

• From the front panel.

• By automation.

• From iMC panels.

• From PresStation or Presmaster.

• By GPI events.

• By the Emergency Alert System

Front Panel 
The front panel and its joystick are for local, manual control and can be used to navigate 
through a menu of parameters to adjust parameter values. 

A full list of menu items available is listed in Appendix A, Front Panel Menu. 

Front panel control of the Imagestore 750 is performed using a four-position joystick in conjunc-
tion with prompts from the display.  

Fig. 7-1: Imagestore 750 Front Panel

Where this user manual discusses joystick input, it represents the 4 positions of the joystick with 
the terms ‘[esc]’, ‘[enter]’ or the arrow icons  and .
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At times, additional symbols are shown on the top line of the display, at the right hand edge. 
These highlight the state of the A/B Mixer (video or audio), the keyers or voice-overs. These are 
the symbols and their meaning: 

Note: The front panel is normally used only during commissioning and is not suitable as a 
general control method because the Imagestore 750 is likely to be remotely located in an equip-
ment rack. You can, however, use the Imagestore 750’s web interface (and its front panel mirror) 
to control the front panel remotely. (See Front Panel Mirror on page 178.) 

Automation 
External automation drivers using the Oxtel series protocol can control all aspects of Imagestore 
750 behavior either through a serial port or over Ethernet. If your system includes the master 
control option, it can also be controlled using Presmaster automation.

Note: For details of the Oxtel and Presmaster automation protocols, see the automation publica-
tions listed under Applicable Publications and Tools on page 3. 

iMC Panels 
Any iMC panel (iMC-Panel-200, iMC-Panel-300, or iMC-Panel-GUI) can be used to provide 
manual control of an Imagestore 750 and an override to automation. The Imagestore 750 must 
include the master control option if it is to be controlled by an iMC panel.

Note: For details about the iMC panels, see the master control documentation listed under 
Applicable Publications and Tools on page 3. 

PresStation / Presmaster 
A PresStation master control panel can also provide manual control of an Imagestore 750 and an 
override to automation. With this setup, the master control logic lies within the Presmaster 
product.

Note: See the Presmaster documentation listed under Applicable Publications and Tools on 
page 3. 

 Warning: PresStation panels are not compatible with iMC panels.

GPI Controller Switch 
GPI control circuitry connected to the Imagestore 750’s GPI connector can be used to trigger 
internal command macros. See GPI Inputs and Macros on page 48 and GPIO / LTC on page 207 
for more detail. 

A Source A

B Source B

– Intermediate state, transition being processed.

↑ Image/voice-over keyed up (to air)

↓ Image/voice-over keyed down (from air)

B Fade to black

S Fade to silence
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Emergency Alert System 
An Emergency Alert System (EAS) receiver can control an Imagestore 750 through its serial port 
and GPI connector, provided the EAS option is installed. See Emergency Alert System (EAS) on 
page 35 for more detail. 

Monitoring and Alarms 
Many different error conditions are being continually monitored by the Imagestore 750 system. 
By assigning an appropriate alarm level to each error condition, you can determine whether a 
system is running correctly based on your facility’s requirements.

Alarm Levels 
Alarm levels are configured for each error condition either in the Imagestore 750 Configurator 
(System Settings > Status Monitoring) or at the front panel (‘Config Alarms’). An alarm level 
takes one of the following values: 

No error Does not contribute to an alarm.

Minor error Contributes to an alarm as a minor error.

Major error Contributes to an alarm as a major error.

Critical error Contributes to an alarm as a critical error.

See System Settings on page 158. 

The following table shows the different error conditions that are monitored by the Imagestore 
750. The factory default alarm level for each error condition is shown by a check mark: 

Error Condition

Alarm Level

No  
Error Minor major Critical

External reference — unlocked 

External reference — format mismatch 

Video input — [A, B, C, D, Fill-1, Key-1, Fill-2, Key-2] — loss 

Video input — [A, B, C, D, Fill-1, Key-1, Fill-2, Key-2] — format mis-
match



Video input timing — [A, B, C, D, Fill-1, Key-1, Fill-2, Key-2] — timing 
offset out of range



Video input — overall input timing offset out of range 

Embedded audio input — audio feed [1–4] — channel [1–16] — 

type change


Embedded audio input — audio feed [1–4] — channel [1–16] — 

audio loss


AES audio input — pair [1–16] — channel [1 or 2] — type change 

AES audio input — pair [1–16] — channel [1 or 2] — audio loss 

Health — temperature 

Table 7-1: Imagestore 750 monitored error conditions
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The following types of error condition are supported:

Unlocked The external reference signal is missing or bad.

Format mismatch The input signal does not match the output video standard.

Video loss Video is missing from the input.

Input timing Input timing either follows behind or is more than one line before the 
program output. 

Overall timing Any one of the available input timing errors is triggered.

Audio type change Audio type changes between PCM, Dolby E, Dolby Digital and non-
PCM.

Audio loss Audio signal is not present.

Temperature FPGA temperature is greater than 80 °C.

Voltage Any one of the available voltages is out of tolerance by ± 5% or more.

PSU The power supply unit is out of tolerance by ± 10% or more.

Disk usage The disk usage exceeds 80% of available capacity.

Slave connection The slave connection has been lost. Note that the slave heartbeat 
must be set up in ‘Slave > Slave Heartbeat’ section under ‘Configura-
tion Mode’ in the Imagestore 750 Configurator. A valid Intuition XG 
must connected for the slave connection to operate.

Router connection The router connection has been lost. Note that the master control 
option (IS-750-Master-Control) must be present for this to operate.

Video FTB The most downstream keyer (DSK 4) has been faded to black.

Audio FTS Audio has been faded to silence.

GPIO direction The GPIO direction has changed.

GPIO status The GPIO status has changed.

Health — voltage 

Health — PSU [1 or 2] 

Health — fans  

Health — slave connection 

Health — router connection 

System — network interface link 

System — disk usage 

Video — FTB angle 

Audio — FTS angle 

GPIO line [0 to 15] — direction 

GPIO line [0 to 15] — status 

Error Condition

Alarm Level

No  
Error Minor major Critical

Table 7-1: Imagestore 750 monitored error conditions
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Note: The factory default settings are chosen to give errors for hardware states which are abso-
lutely critical to the operation of the Imagestore 750. During the commissioning of Imagestore 
750s, you should decide on additional error conditions that will be needed to optimize the 
monitoring of your system. For example, errors in the reference, or video and audio inputs, 
should probably carry some warning level. 

Note: When Dolby E or Dolby Digital (AC-3) is fed into the AES inputs, the signal is reported as 
‘Non-Audio’. This is because Imagestore 750 is unable to detect Dolby E or Dolby Digital (AC-3) 
on its AES inputs and so treats it as non-PCM..

You can also configure whether an associated SNMP trap should be triggered when any failure 
occurs. (See SNMP Traps, following.) 

SNMP Traps 
The alarm settings described under Monitoring and Alarms on page 151 can be monitored 
using SNMP traps. 

In typical SNMP setups, one or more administrative computers, called managers, have the task 
of monitoring or managing a group of devices on a computer network. Each managed device 
(in this case, the Imagestore 750) executes a software component called an agent which reports 
information via SNMP to the manager.

An SNMP-managed network consists of three key components:

• Managed device — the Imagestore 750.

• Agent — software which runs on managed devices.

• Network management system (NMS) — software which runs on the manager.

A network management system (NMS) executes applications that monitor and control 
managed devices. Although the Imagestore 750 does not permit any SNMP control, it does 
provide an extensive range of traps for monitoring error states. (See Monitoring and Alarms on 
page 151 for the alarm settings.) 

Network management systems (NMS) provide the bulk of the processing and memory resources 
required for network management. This means that there is little load placed on the Imagestore 
750 as it reports on error states. Also a single manager can monitor many managed devices 
within one or multiple facilities thus centralizing all monitoring.

SNMP agents expose data on the managed systems as variables. The variables accessible 
through SNMP are organized in hierarchies. These hierarchies, and other metadata (such as type 
and description of the variable), are described by Management Information Bases (MIBs). 

This document does not describe how to set up an SNMP manager, however there are many 
examples on the internet.

Note: Miranda makes available two MIBs for the Imagestore 750 — one for the manufacturer 
(Miranda) and one for the product (Imagestore 750). Please contact Miranda Customer Support 
for the latest MIBs. They can also be copied from the Imagestore 750 at ‘/usr/share/snmp/mibs/
IMAGESTORE-MIB.txt’ and ‘/usr/share/snmp/mibs/MIRANDA-MIB.txt’.
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Status LED 
The status LED is located on the front panel of the Imagestore 750 to the right of the joystick. 
This single-color (red) LED indicates the overall status of the Imagestore 750 by its illumination 
state:

Off = No error Slow flashing = Major error

On = Minor error Fast flashing = Critical error

If there are multiple errors, the LED always shows the most severe error detected. 

Note: The status LED is useful during commissioning, but is not suitable as a general status 
monitoring method because the Imagestore 750 is likely to be remotely located in an equip-
ment rack. It is for this reason that alarms and associated traps are monitored using SNMP. 
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Chapter 8 provides information regarding the Imagestore 750 Configurator. 

Topics
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 155 
Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 156 
Managing Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 175 

Introduction 
The Imagestore 750 is configured using the Imagestore 750 Configurator, version 1.5 or later. 

This Windows-based application allows you to control the start-up state of the Imagestore 750. 
It will then always restart in a known state.

The Media Conversion Suite (MCS) CD that ships with the Imagestore 750 includes a copy of the 
Imagestore 750 Configurator. The Imagestore 750 Configurator is also available from Miranda 
Customer Support.

Configurator Mode Selection 
The Imagestore 750 Configurator has a number of modes, which are selectable in the drop-
down menu at the top right-hand corner of the application window. 

Fig. 8-1: Imagestore 750 Configurator - drop-down Modes menu

Whether a particular mode is available depends on the options you have purchased. For each of 
these modes, the Imagestore 750 Configurator displays one or more settings pages (or tabs) as 
listed here:

• Configuration mode

‘System settings’ Create and edit the system configuration for use at startup.

‘Store manager’ Edit the store allocation used by the DSKs.

‘Audio graph’ Create and edit the internal audio routing.

‘Licences’ Shows the licences present in the Imagestore 750.

• Metadata mode
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‘Metadata’ Create and edit metadata presets.

• Gain mode

‘Gain’ Create and edit audio gain presets.

• Shuffle mode

‘Shuffle’ Create and edit audio shuffle presets.

• Master control mode

‘Channel sources’ Create and edit available channel sources.

‘Source groups’ Create and edit the source groups as viewed on an iMC panel.

• Salvo mode

‘Router salvos’ Create and edit router salvo information. 

• Macro mode

‘Macros’ Create and edit macros. (See Macros on page 50.) 

• DVE mode

‘DVE mapping’ Create and edit DVE mappings.

Note: There is a main configuration file for the Imagestore 750 and a configuration file for each 
mode. Each mode’s file is independent of the main configuration. To use any mode, either open 
or create a configuration file in that mode as described under Modes, following. Mode files must 
then be referenced by the main configuration.

Modes

Configuration Mode 
The validity of any configuration file depends critically on the hardware capabilities of the 
Imagestore 750 and the software options that are currently installed. These are defined in a 
capabilities file, which is always available from a running Imagestore 750. The file can also be 
saved as a file local to your PC. (See Exporting a Capabilities File on page 176.) Configuration 
files have the file extension .xml. Capabilities files have file extension .caps.

After starting the Imagestore 750 Configurator, you should open a configuration file to edit. You 
can create a new (default) configuration, or use an existing configuration either from the 
Imagestore 750 or from your PC. 

Select ‘Configuration Mode’ in the drop-down list at the top right corner of the Imagestore 750 
Configurator.

Use the ‘File’ menu as follows:

• File > New > From Device...

Creates a new (default) configuration based on device capabilities from a running Images-
tore 750.

• File > New > From File...

Creates a new (default) configuration based on device capabilities from a .caps file on your 
PC.

• File > Open > From Device...

Opens an existing configuration from a running Imagestore 750. 
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This can either be the active configuration or another configuration saved in the Imagestore 
750.

• File > Open > Advanced...

Opens an existing configuration either from a running Imagestore 750 or from a .caps file on 
your PC. 

The configuration is validated against the device capabilities either from the running 
Imagestore 750 or from your local .caps file.

Note: the active configuration is the current state of the Imagestore 750.

During commissioning, the front panel is used to define most of the Imagestore 750’s settings. 
You can then open the current state (or active configuration) in the Imagestore 750 Configurator 
to adjust particular system settings. (See System Settings on page 158.)
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System Settings 
The ‘System Settings’ tab (under ‘Configuration Mode’) is used to view and edit the main config-
uration. The left-hand pane contains entries for the following groups of main features, which 
vary depending on the licences installed: 

Fig. 8-2: Imagestore 750 Configurator - System Settings page

Features are grouped into categories. You can expand the menu tree wherever a [+] is seen to 
reveal sub-menu options. You can collapse the menu tree wherever a [–] is seen. You can select 
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individual system settings for the current configuration and modify them in the right-hand 
pane. Whenever a setting is clicked, a description of the feature appears below it (in the right-
hand pane) as a helpful guide. The description includes the corresponding automation 
command, which can be cross-referenced against the Oxtel series automation protocol docu-
ment. See the automation documents listed under Applicable Publications and Tools on page 3. 

System settings are of two types:

Persistent Settings from the Setup and Config Alarms front panel menus only.

State Settings from the Operate front panel menu, which are volatile in nature.

Persistent System Settings 
Persistent settings are options such as the serial port Baud rate (Setup > Serial Comms > Serial 
Ports > COM x > Baud Rate) which are always expected to persist after being modified during 
commissioning. The Imagestore 750 Configurator allows such values to be defined within a 
specific configuration — either to the factory default value or a custom-defined value.

State System Settings 
State settings are options (from the ‘Operate’ menu) such as keyer fader positions and media 
loads.

At restart, required state settings behavior might be: 

• Set to a specific value.

• Set to their last system value.

State settings can be set to their last system value, by selecting ‘System value persists’ for the 
parameter in the Imagestore 750 Configurator.

The possible restart behaviours of state settings are as follows:

• Default value Reset to the factory-default value.

• User value Reset to a user-defined value.

• System value persists Persist from the previous session.
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An example of restart behavior for Imagestore 750 is a situation where DSK 1, DSK 2 and DSK 3 
should be cut down, but DSK 4 should be cut up with the station logo loaded. This may be 
achieved by configuring ‘user values’ as shown in the following two figures: 

Fig. 8-3: Imagestore 750 Configurator - DSK 4 restart behavior cut up

Fig. 8-4: Imagestore 750 Configurator - DSK 4 restart behavior logo filename
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Store Manager 
The ‘Store Manager’ tab (under ‘Configuration Mode’) allows the total store memory to be allo-
cated to 4 available stores on a percentage basis. 

Fig. 8-5: Imagestore 750 Configurator - Store Manager

The 4 stores feed the corresponding keying layers (DSK1–DSK4) on the program and preview 
buses.

This allows more store memory to be allocated to a specified layer that will be used for playing out 
long animations. The factory default is for all stores to be equally allocated.

Audio Graph 
The ‘Audio Graph’ tab (under ‘Configuration Mode’) is used to define all routing within the audio 
engine graphically. To use the page, choose audio blocks from the left pane and drag them onto 
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the ‘Audio Graph’ view (the middle pane). Then connect the appropriate pins between blocks by 
drawing lines from output pins to input pins:

Fig. 8-6: Imagestore 750 Configurator - Audio Graph tab

You can expand or collapse audio blocks (and subblocks) by double-clicking the ‘+’ or ‘–’ 
symbols at the top left corner of a block. 

You can draw multiple lines (at one time) by selecting multiple pins, and then dragging your 
cursor from one of the pins to the pin to which it connects. 

To select multiple pins, use your mouse to drag a selection rectangle around the pins.

The selected audio block (or pin of a block) is highlighted by a red line and its parameters 
appear in the right pane. You can edit the parameters in the right pane.

To select multiple blocks, use your mouse to drag a selection rectangle around the blocks.

A variety of sample audio templates are supplied as starting points for creating custom audio 
configurations. These are described in detail in the Imagestore 750 web interface. (See Audio 
Templates on page 182.)
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Fig. 8-7: Imagestore 750 Configurator - Audio Graph view

The Imagestore 750 supports the following audio block categories, in each of which you can 
find several audio block types:

• Inputs

• Outputs

• Audio Mix Blocks

• Audio Delay Blocks

• Audio Modules

• Metadata

You can select a category in the drop-down list at the top of the left pane. When you select a 
category, the audio blocks that belong to that category appears in the pane below. At the 
bottom of the category list is ‘Show All’. This choice presents all audio block types at once.
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Note: There are also ‘Legacy Audio Mix Blocks’ that are deprecated and should be used only for 
compatibility with legacy IS23 products. These blocks have been superseded with alternatives 
that provide enhanced features. If you attempt to add a legacy block, the Imagestore 750 
Configurator will suggest an alternative block(s) that should be instead. Legacy audio mix 
blocks are not described in this document and are not recommended.

Note: Audio graph blocks highlighted in red on the audio graph window indicate that they are 
not supported by the Imagestore 750. Unsupported blocks occur when you are editing an audio 
graph created for an Imagestore 750 with different options. Ensure that your audio graph 
contains no unsupported blocks. They provide no functionality.

Inputs 
The input blocks define all possible audio sources for the system. The Imagestore 750 supports 
the following blocks:

Block Type Description

SDI audio feed Represents embedded audio from an SDI input. Four audio feeds are 
supported, each having 16 channels of embedded audio. Each feed can be 
configured to match any one of the SDI inputs, or it can follow the video A/B 
mixer’s A or B input.

AES inputs Represents the physical AES inputs on the device. There are 16 AES pairs 
giving a total of 32 input audio channels.

Easyplay Represents an Easyplay stream for playing out audio clips. There are 4 
Easyplay streams which share a total of 16 audio channels. Each stream can 
be configured with an associated voice-over that is cut up automatically 
whenever an Easyplay file is playing out. Alternatively, a queue of the 
Easyplay stream can follow the associated voiceover position (in which case 
playing the Easyplay stream does not drive the voiceover). Alternatively, 
each stream can also be instructed to follow corresponding program or 
preview video channel keyer cuts and fades, or loads and unloads using a 
filename association and optional filename prefix. Alternatively, each stream 
can be driven independently by automation. Each stream can also be 
configured to indicate whether it is associated with a PGM or PST voiceover.

Silence Provides an input that is silence.

Test tone Provides a test tone, the frequency of which can be modified.

Table 8-1: Audio Graph - Input signal blocks
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Outputs 
The output blocks represent the physical outputs and metering of the Imagestore 750. Pins from 
input blocks may be routed directly to pins in output blocks, but they are normally routed 
through one or more mix blocks.

For the outputs listed, when the audio type is configured to be automatic, the audio type for 
each pair will change if an input suddenly switched from data to audio (pass-through).

Audio Mix Blocks 
The audio mix blocks define all possible methods for mixing audio sources. The Imagestore 750 
supports the following blocks, all of which support mixing of streams up to 48 channels wide:

Block Type Description

SDI PGM output Represents the physical program SDI output (having 16 embedded audio 
channels). The audio type for each pair can be set to ‘audio’, ‘non-audio’ or 
‘automatic’.

SDI PVW output Represents the physical preview SDI output (having 16 embedded audio 
channels). The audio type for each pair can be set to ‘audio’, ‘non-audio’ or 
‘automatic’.

SDI CLF output Represents the physical clean-feed SDI output (having 16 embedded 
audio channels). The audio type for each pair can be set to ‘audio’, ‘non-
audio’ or ‘automatic’

SDI MON output Represents the physical monitor SDI output (having 16 embedded audio 
channels). The audio type for each pair can be set to ‘audio’, ‘non-audio’ or 
‘automatic’.

Meters Represents the audio meters (48 channels)

AES output Represents the 16 AES output pairs (on the AES connector). The audio type 
for each pair can be set to ‘audio’, ‘non-audio’ or ‘automatic’.

Table 8-2: Audio Graph - Output blocks

Block Type Description

Audio AB mixer Provides A/B mix, A/B cut, and A/B data cut between two input sources.

Audio mix Provides custom mixing of up to 8 input sources.

Audio description Allows a background mono commentary track to be mixed with the stereo 
background audio for people who are visually impaired. The commentary 
track is controlled by an AD control tone. (See Audio Description (AD) on 
page 140.) 

Audio PGM voice-over Provides a voice-over onto background program audio, ducking the back-
ground appropriately. Gain presets and shuffle presets can be used for the 
voice-over input, and fade rates, duck level, and preset levels and the initial 
fader position on startup can be set. See Gain Mode on page 170 and Shuf-
fle Mode on page 171 

Audio PST voice-over Provides a voice-over on background preset audio, using the settings from 
the program voice-over of the same index allowing previewing the armed 
state of voice-overs before they are taken to air. Arming and disarming a 
PGM voice-over automatically causes a change in the PST voice-over.

Table 8-3: Audio Graph - Mix blocks
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Audio voice-over preview Provides preview of voice-over of shuffle-sensitive, gain-adjusted voice-
over channels but without any being affected by the associated program 
voice-over position. This has been superseded by the Audio PST voice-over, 
and is recommended for use only in legacy configurations.

Audio gain Allows audio sources to be attenuated at a specific level (expressed in dB) 
with per-channel control. 

Audio input program gain Provides gain modification through gain presets or the j0 automation com-
mands. The j011 (mute), j012 (trim), j013 (phase) and j014 (level) can be used to 
control up to 16 channels. See Gain Mode on page 170. 

Audio input program shuf-
fler

Provides shuffles through shuffle presets or the j0 automation commands. 
The j010 command can be used to shuffle up to 16 channels. See Shuffle 
Mode on page 171.

Audio input program mul-
tiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio input  
preset gain

Provides gain modification through gain presets or the j0 automation com-
mands. The j031 (mute), j032 (trim), j033 (phase) and j034 (level) can be used to 
control up to 16 channels. See Gain Mode on page 170. 

Audio input  
preset shuffler

Provides shuffles through shuffle presets or the j0 automation commands. 
The j030 command can be used to shuffle up to 16 channels. See Shuffle 
Mode on page 171.

Audio input  
preset multiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio output  
program gain

Provides gain modification via gain presets or the program gain automation 
commands. The j100 commands (set output level), and j101 (set output 
mute) adjust the levels or mutes of channels passed through the block. The 
j1030 (set program output level via gain type) adjusts the master gain for the 
entire program output gain block. Each channel has its own gain/mute flag 
in addition to a master gain (i.e., they are totally independent).

Audio output  
program shuffler

Provides the ability to perform shuffles through shuffle presets on the pro-
gram output. See Shuffle Mode on page 171.

Audio output  
program multiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio output  
preview multiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio output  
meter multiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio output  
cleanfeed multiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio output  
monitor multiplexor

Provides multiplexing of several sources of audio onto a single output. This 
is useful for monitoring different audio sources on the same audio output.

Audio fade to silent mix Manipulates the audio when the fade-to-silent fader is moved. The block 
will ramp over the period of the FTS fader. 

Audio fade to silent cut Manipulates the audio when the fade-to-silent fader is moved. The block 
will cut to silence at the point when the FTS fader is fully off. The cut is per-
formed over 1 field to ensure there are no clicks or squeaks in the audio. 

Block Type Description

Table 8-3: Audio Graph - Mix blocks
166



Imagestore 750
User Manual
Mixing generally requires that the input sources to the block be PCM. Exceptions to this are the 
‘Audio A/B Mixer’ block, ‘Audio Fade to Silent Data’ block, and ‘Audio AutoMute’ block, which 
may be used with data streams.

Audio Delay Blocks 
The Imagestore 750 supports 6 delay banks, each of which provides 16 channels of input and 
output.

Each delay bank can provide from 1 to 32,767 audio samples of delay, where the audio sample 
rate is 48 kHz. This results in over 16 video frames of audio delay for each audio delay block, 
although the actual delay in frames depends upon the frame rate for the current video standard 
as follows:

50 Hz standards Maximum of 17.06 frames audio delay.

59.94 Hz standards Maximum of 20.45 frames audio delay. 

Fig. 8-8: Audio Graph - audio delay bank

See Audio Delay Blocks on page 148 for more information. 

Audio fade to silent data Manipulates the audio when the fade-to-silent fader is moved. The block 
cuts to silence at the point when the FTS fader is fully off. The cut is per-
formed instantaneously and will result in clicks or squeaks if used with non-
data. 
It is intended to be used within data streams that would otherwise be cor-
rupted if a fade were attempted. 

Audio AutoMute Mutes the output of the block for a user-specified amount of time when the 
“sense” pin changes types (i.e., between PCM, Dolby-E, AC3, or non-audio).

Audio AutoDuck This is a silence detection block used to control an associated voice-over 
forcing it to fade up or down according to whether a volume level exceeds a 
definable threshold, or is below the threshold, for a definable duration. The 
fade in and out rates, and the duck level can be defined. Whether the trig-
gering of a duck is dependent or independent on other channels can be 
configured.

Block Type Description

Table 8-3: Audio Graph - Mix blocks
167



Imagestore 750 Configurator
Modes
Audio Delay Calculation 
The following audio blocks incur audio delays of varying duration:

• Dolby decode and encode modules 

• Metadata delays

• Up-mix modules

• Audio delay blocks

The audio delay calculation feature lets you determine the cumulative audio delay at any pin on 
any audio block in the ‘Audio Graph’. The delay is shown in frames (including fractions of frames 
to two decimal places) and samples (at 48 kHz). This helps to ensure that there is consistent and 
unchanging audio delay throughout the system.

To calculate audio delays, perform the following steps:

• Create your audio configuration using the Imagestore 750 Configurator’s ‘Audio Graph’ 
page.

• Select ‘Tools > Calculate delays’ from the menu, or press ‘F2’.

• Select ‘Yes’ in the warning dialog, “Calculating the delays in a configuration can take a very 
long time. Do you wish to continue?”

• Position your mouse over audio or metadata pins on any block within the ‘Audio Graph’ to 
see the delay in both frames and samples.

Note: Calculation of audio delays in complex audio configurations with many route permuta-
tions can take a long time. It might be possible to remove non-essential parts of the ‘Audio 
Graph’ before starting the audio calculation. 

Audio Modules 
The audio modules present depend on the hardware and licences present in the Imagestore 
750: 

Metadata 
The metadata blocks generate and manipulate metadata. See Dolby Metadata on page 120 for 
general metadata information and Metadata Mode  on page 126 for more information on the 
‘Metadata’ tab of the Imagestore 750 Configurator. 

Block Type Description

Dolby decoder module This module (1) decodes Dolby E and Dolby Digital 
(AC-3) and (2) outputs surround PCM with a stereo 
down-mix alternative. It also decodes Dolby metadata 
and provides backup audio capability. See Dolby 
Decode Module on page 113 for a details

Dolby Digital (AC-3) encoder module Encodes up to 8 channels of PCM as Dolby Digital (AC-
3). See Dolby Digital Encoder Module on page 116.

Dolby E encoder module Encodes up to 8 channels of PCM as Dolby E. See 
Dolby E Encoder Module on page 115.

Up-mix module Provides up-mix capability from stereo to 5.1 
surround audio. See Up-Mix on page 133.

Table 8-4: Audio Graph - Audio Modules
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Licences 
The ‘Licences’ tab lists the licence names that are currently enabled for the Imagestore 750. The 
second column shows licence values. (Where these are applicable, they are non-zero.) The third 
column gives a description of the licence. 

Fig. 8-9: Imagestore 750 Configurator - Licences tab

Note: For historical reasons, the licence names shown by the Imagestore 750 Configurator do 
not correspond to the option names listed in Chapter 11, Options. 

Metadata Mode 
Please refer to Metadata Mode  on page 126 which presents the ‘Metadata’ tab of the Images-
tore 750 Configurator when it is in ‘Metadata Mode’. 

Block Type Description

Metadata AB mixer Provides the ability to switch between A and B metadata streams.

Metadata blank source Provides an empty metadata source.

Metadata processor Allows metadata to be generated, manipulated, or passed through.

Metadata UARTs These represent the metadata RS-485 ports (on the GPIO connector) 
of the Imagestore 750.

Table 8-5: Audio Graph - metadata blocks
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Gain Mode 
When the Imagestore 750 Configurator is in ‘Gain Mode’, you can define gain presets which can 
then dynamically adjust overall gain and the level, trim, mute, and phase characteristics of indi-
vidual audio channels at various points within the audio mix. 

To enter ‘Gain Mode’, select it from the drop-down list at the top right corner of the Imagestore 
750 Configurator. 

You can then create or edit gain preset files by selecting ‘File > New’ or ‘File > Open’. When you 
create a gain preset file, you must specify the number of channels. 

The following attributes may be defined for each gain preset file:

• Number of channels 1 to 48

• Master gain +28 dB to –100 dB 0 dB default

• Per-channel level +28 dB to –100 dB 0 dB default

• Per-channel trim +28 dB to –100 dB 0 dB default

• Per-channel mute Enabled or disabled

• Per-channel phase Enabled or disabled

The following example shows a portion of 16-channel gain preset file with default settings: 

Fig. 8-10: Imagestore 750 Configurator - Gain Mode, Gain Presets

When the preset is complete, you can save it to the Imagestore 750 by selecting ‘File > Save’. 
(See Saving a Configuration on page 175.) 

Gain presets that are saved to the system can be used within these audio mixer blocks. 

• Audio gain.

• Audio input program gain.

• Audio input preset gain.

• Audio output program gain.

• Audio program voice-over.

(See Audio Mix Blocks on page 165.)
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Shuffle Mode 
When the Imagestore 750 Configurator is in ‘Shuffle Mode’, you can define shuffle presets which 
can then dynamically adjust the channel shuffling at various points within the audio mix. 

To enter ‘Shuffle Mode’, select it from the drop-down list at the top right corner of the Images-
tore 750 Configurator. 

You can then create or edit shuffle preset files by selecting ‘File > New’ or ‘File > Open’. When 
you create a shuffle preset file, you must specify the number of channels. The number of inputs 
can range from 1 to 48 channels. The number of outputs can range from 1 to 48 channels. 
Square and non-square shuffle presets are supported.

To edit the shuffle, click any of the squares in the matrix. Red squares represent a connection. 
White squares represent the absence of a connection. 

 Be aware that rows are inputs and columns are outputs.

The following example shows a 16×16 shuffle preset:

Fig. 8-11: Imagestore 750 Configurator - Shuffle Mode, Shuffle Preset

This particular preset swaps stereo pairs.

When the preset is complete, you can save it to the Imagestore 750 by selecting ‘File > Save’. 
(See Saving a Configuration on page 175.) 

Shuffle presets that are saved to the Imagestore 750 can be used in these audio mixer blocks. 

• Audio input program shuffler.

• Audio input preset shuffler.

• Audio output program shuffler.

• Audio program voice-over
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(See Audio Mix Blocks on page 165.)

Master Control Mode 
 This mode is available only when the master control licence (IS-750-Master-Control) is 

installed.

Master control mode allows you to create and edit the channel sources and source groups that 
will permit the inclusion of the Imagestore 750 in an iMC master control system and permit 
control of router switching by iMC panels and automation. 

To enter ‘Master Control Mode’, select it from the drop-down list at the top right corner of the 
Imagestore 750 Configurator. You can then create or edit master control configurations by 
selecting ‘File > New’ or ‘File > Open’.

When the configuration is complete, you can save it to the Imagestore 750 by selecting ‘File > 
Save’. (See Saving a Configuration on page 175.) 

Go to System settings > Master control > Master control configuration to specify a master control 
configuration to use:

Please refer to Master Control Configuration on page 72 for details regarding master control 
setup. 

Salvo Mode 
 This mode is available only when the master control licence (IS-750-Master-Control) is 

installed.

Salvo mode allows you to create and edit the mapping between router salvo names, which are 
retrieved from the NV9000 router control system, and IDs that can be used by automation. 
When an iMC panel is connected to the Imagestore 750, it uses salvo IDs to drive salvos in the 
NV9000. 

To enter ‘Salvo Mode’, select it from the drop-down list at the top right corner of the Imagestore 
750 Configurator. 

Fig. 8-12: Imagestore 750 Configurator - Salvo Mode

Right-click on the left pane to expose a context menu that allows the following actions to be 
performed:
172



Imagestore 750
User Manual
Add salvo(s) This allows one or more salvo to be added from the macro list in 
the connected NV9000 router control system. Use the control or 
shift key to select multiple sequences.

Reassign router salvo(s) This allows you to reassign the selected salvo(s).

Modify ID(s) This allows you to change the IDs of the selected salvo(s), as used 
by automation.

Rename This allows you to rename the salvo(s). You can change the entry in 
the ‘Name’ column. 

Multiple salvos can be renamed with a number appended to differ-
entiate them. You can choose the router salvo name or generate 
names of your own choosing.

Delete This allows you to delete salvo(s).

You can create or edit salvo configurations by selecting ‘File > New’ or ‘File > Open’. When the 
configuration is complete, you can save it to the device by selecting ‘File > Save’. (See Saving a 
Configuration on page 175.) 

Go to System settings > Master control > Master control configuration to specify a salvo configuration 
file to use:

Please refer to Salvo Configuration on page 80 for details regarding salvo setup. 

Macro Mode 
Macro mode provides a versatile and user-friendly way to edit macros which include a custom 
sequence of Oxtel automation commands. The operation of macros and ‘Macro Mode’ are 
described in more detail in Adding Macros on page 51.

Note: For details of the Oxtel automation protocol, see the Automation publications under 
Applicable Publications and Tools on page 3. 

To enter ‘Macro Mode’, select it from the drop-down list at the top right corner of the Imagestore 
750 Configurator. 

Fig. 8-13: Imagestore 750 Configurator - Macro Mode

Click in the left panel to select a macro.

Right-click in the middle pane to expose a context menu that allows the following actions to be 
performed:
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Add command This adds another row to the middle pane, in which you can enter a 
command and a comment for the selected macro. 

Move commands up This allows you to reorder commands.

Move commands downThis allows you to reorder commands.

Delete commandThis deletes the selected command(s).

Enter commands in the ‘Command’ column of the middle pane. Enter comments in the 
‘Comment’ column. 

You can create or edit macro configurations by selecting ‘File > New’ or ‘File > Open’. When the 
configuration is complete, you can save it to the Imagestore 750 by selecting ‘File > Save’. (See 
Saving a Configuration on page 175.) 

Go to System settings > Miscellaneous > Macro to specify a macro preset file to use:

DVE Mode 
 This mode is available only when the DVE licence (IS-750-DVE) is installed.

DVE mode allows the DVE sequences stored on the Imagestore 750 to be mapped to an ID that 
is used by automation. When an iMC panel is controlling the Imagestore 750, its DVE button(s) 
can be mapped onto any available DVE sequence by making use of the current DVE 
configuration.

Note: DVE sequences are created and transferred to the Imagestore 750 using the ‘DVE Editor’ 
provided on the Media Conversion Suite CD that ships with the Imagestore 750. 

To enter ‘DVE Mode’, select it from the drop-down list at the top right corner of the Imagestore 
750 Configurator. 

This is a sample DVE mode window: 

Fig. 8-14: Imagestore 750 Configurator - DVE Mode, DVE Configurations

Right-click on the left pane to expose a context menu that allows the following actions to be 
performed:

Add DVE sequence(s) This allows selection of one or more DVE sequences from those 
stored on the Imagestore 750. Use the control or shift key to 
select multiple sequences.

Reassign DVE sequence(s) This allows selected DVE sequences to be re-assigned.

Modify ID(s) This allows the IDs of one or more selected DVE sequence to be 
changed.
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Delete This deletes the selected DVE sequence(s).

Once the configuration is complete, you can save it to the device by selecting ‘File > Save’. (See 
Saving a Configuration on page 175.) 

Go to System settings > DVE > DVE Mapping to specify a DVE mapping preset file to use.

Managing Configurations

Saving a Configuration 
When a configuration (or preset) from any of the available configurator modes is completed, 
you can save it to one or more Imagestore 750s and create a backup file as necessary. Use the 
‘File’ menu as follows:

• ‘File > Save’

Confirm the IP address of the Imagestore 750 and the filename under which to save the con-
figuration.

Subsequent saves reuse the same IP address and filename.

• ‘File > Save As > To Device…’

Confirm the IP address of the Imagestore 750 and the filename under which to save the con-
figuration. This creates a new configuration file.

• ‘File > Save As > To File…’

Make a backup copy of the configuration (to your PC or elsewhere).

You can also copy the current ‘active configuration’ to a file by selecting User Presets > Export 
from the front panel. The configuration filename created is in the format 
‘YYYYMMDD_HHMMSS.xml’ within the Imagestore 750.

Importing a Configuration
There are two ways to import (or apply) the main system configuration so that it becomes 
‘active’ on the Imagestore 750.

The first method uses the Imagestore 750 Configurator:

1  Select ‘Configuration Mode’ from the drop-down list at the top right corner.

2  Open the configuration that you want, using one of the ‘File’ menu options listed in Config-
uration Mode on page 156. To copy the current state of the Imagestore 750, select ‘File > 
Open > From Device... > Active configuration’.

3  Make changes to the configuration as required.

4  Select ‘File > Save and Apply Configuration…’ from the menu.

5  Confirm the IP address of the target Imagestore 750, configuration filename, and that you 
wish to proceed.

6  The Imagestore 750 restarts as a result of the ‘Save and Apply Configuration’ command.

The second method uses the front panel to import a configuration that has already been saved 
on the Imagestore 750:

1  Select ‘User Presets > Import > filename.xml’ from the front panel menu.
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2  Restart the Imagestore 750, as instructed, for the configuration to be applied.

3  If you do not restart the Imagestore 750 and want to cancel the import selection, re-enter 
‘User Presets > Import’ menu and select ‘Keep Current’.

During the restart, the last imported configuration (or the active configuration if there was no 
import) is validated against the Imagestore 750’s capabilities and the resulting settings become 
the new active configuration. 

Note: If the same configuration file is imported to Imagestore 750s with different capabilities 
files, then each Imagestore 750 will use its own capabilities file to validate all configuration 
settings. Configuration settings that cannot be supported will be ignored. Configuration 
settings that are not defined, but are supported, will assume the factory default settings.

Assuming that no further configuration files are imported (normally the case, after a system is 
set up correctly), the ‘active configuration’ continues to apply on subsequent restarts. Please 
note however that the ‘active configuration’ is subsequently modified on an ongoing basis by 
changes to ‘persistent’ settings. (See System Configuration on page 58.) 

The ‘active configuration’ from any Imagestore 750 can be copied into the Imagestore 750 
Configurator at any time so that edits can be made to ‘persistent’ settings and the restart 
behavior of ‘state’ settings. The new configuration file can then be saved back to the Imagestore 
750 and re-imported when required. 

Note: The restart behavior of “state” settings cannot be changed without a restart of the 
Imagestore 750.

The front panel’s ‘User Preset > Last Config’ menu option shows the name of the last configura-
tion file that was imported. This is really just a reminder on which configuration file the ‘active 
configuration’ was originally based. This value persists between system restarts providing there 
are no further imports.

Exporting a Capabilities File 
The validity of any configuration file depends critically on the hardware capabilities of the 
Imagestore 750 and the options that are currently installed. These are defined in a capabilities 
file (.caps), which is always generated by a running Imagestore 750. 

The capabilities file and ‘active configuration’ file are useful for fault diagnosis.

If you want a local copy of a capabilities file, use the Imagestore 750 Configurator to open the 
‘active configuration’ from the target device, and then select ‘File > Export Capabilities File…’. 
You will be prompted to enter a file name.

The capabilities file is also availadble from the Imagestore 750 web interface. (See System Infor-
mation on page 179.) 
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Chapter 9 provides information regarding the Imagestore 750’s web interface. 

Topics
Connecting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 177 
Web Interface Pages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 178 

Connecting 
You can access the Imagestore 750’s web interface by entering the IP address1 of the Imagestore 
750 in the address bar of your web browser. The Imagestore 750 web interface supports Internet 
Explorer (version 7 and later) and Mozilla Firefox (version 3 and later).  

Fig. 9-1: Imagestore 750 - Web Page

 Warning: Some features available in the Imagestore 750’s web interface will affect the oper-
ation of the unit and can result in the loss of output. Exercise great care if you are using the 
web interface while the Imagestore 750 is on-air.

After clicking on the “LOGIN” button, the software asks you for a password. 

Fig. 9-2: Imagestore 750 Web page - Log In

 Note: The default password is “miranda” — all lower case.

1.  You can determine the IP address from the front panel menu  
Status > System Info > IP Address.
 177



Web Interface
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When you log in, the home page appears and offers an introduction. Links to various other 
pages are available on the left side of the window. The current software version appears at the 
top of the page: 

Fig. 9-3: Imagestore 750 Web Interface - Home page

Web Interface Pages

Front Panel Mirror 
This page allows you to manipulate settings of the Imagestore 750. It is a mirror (or emulator) of 
the Imagestore 750’s front panel. You can operate or configure the Imagestore 750 remotely. 
You can navigate this front panel “mirror” the same way you navigate the menu at the actual 
front panel: in this case, by clicking the ‘<’, ‘>’, ‘ESC’ and ‘ENT’ buttons, or using the four arrows on 
your keyboard if you first click somewhere in the white window. 

Fig. 9-4: Imagestore 750 Web Interface - Front Panel Mirror

 Warning: This page should be used with great care when the Imagestore 750 is on-air since 
on-air output can be affected. 

The page has a link at which you can view the full menu structure of the Imagestore 750. Note 
that many of the items in the menu depend upon installed options. See Appendix A, Front Panel 
Menu for a complete listing of menu items. 
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System Information 
This page gives access to the following system information:

Fig. 9-5: Imagestore 750 Web Interface - System Information

The page has links to the following pages: 

• System information

‘Release Notes’ — new features or bugs fixed in each release of the software.

‘Licences’ — the currently installed Imagestore 750 options. 

‘Network Information’ — information related to the Ethernet interface.

‘Running Processes’ — a list of processes currently running on the Imagestore 750.

‘Interrupt Statistics’ — interrupt statistics for the Imagestore 750.

‘Serial Configuration’ — how the serial ports are configured.

‘Serial Statistics’ — serial port data statistics.

‘FPGA Information’ — firmware build date, identity and version number.

‘Dolby Module Information’ — audio module types, firmware version, and status.

• Diagnostics
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‘Latest Log Message’ — shows, and continually updates, the most recent additions to the 
Imagestore 750’s message log.

‘Full Log Messages (current session)’ shows the full log message file for this boot session. If 
the file is very long, it can take some time to load. The display updates (only) if you click 
‘Refresh’ in the web browser.

‘Full Log Messages (previous session)’ shows the full log message for the previous boot ses-
sion. If the file is very long, it can take some time to load.

‘Create Diagnostics Archive’ will collate all system information about an Imagestore 750. It is 
intended for fault diagnosis and should always be submitted to Miranda Support after a fail-
ure with any Imagestore 750 before you restart it. The archive file also includes the log mes-
sage files. The file created is named diagnostic.tar.gz by default and is saved in the location on 
your PC (or its network) that you specify.

Note: See Message Logging on page 57 for details of how to modify the amount of logging 
information accumulated in message logs. 

• Device Capabilities

‘Create Device Capabilities File’ allows you to download a copy of the Imagestore 750 capa-
bilities file. The file created is named devicecaps.caps by default and is saved in the location on 
your PC (or its network) that you specify.

This file tells the Imagestore 750 Configurator about the Imagestore 750’s device capabilities 
and available options. See Chapter 8 for information on the Imagestore 750 Configurator. 

 The device capabilities file can be used in conjunction with the Imagestore 750 Configu-
rator when there is no actual Imagestore 750 you can connect.

Media Management 
This page allows you to upload, download, or delete files (to or from the Imagestore 750). 

Fig. 9-6: Imagestore 750 Web Interface - Media Management
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The page allows you manage these file types:

• Graphics files • Custom mix files • Master control configuration

• Easyplay files • Gain presets • Router salvos

• Configuration preset files • Shuffle presets • DVE sequences

• Active configuration files • Metadata presets • DVE presets

• Default mix files • Macro presets

 Warning: Use this page with great care when the Imagestore 750 is on-air because on-air 
output can be affected.

It is recommended that a media management system is used to transfer media to the Images-
tore 750.

You can download individual media files directly by clicking on the file name. You can download 
multiple media files in a single.tar file by selecting them and then clicking on the ‘Download 
Selected’ button. You might have to scroll to find the button.

You can delete multiple media files by selecting them and choosing the ‘Delete Selected’ 
button. 

You can upload individual media files to the Imagestore 750 by clicking the ‘Browse’ button, 
navigating to select a file, and then clicking ‘Add File’.

The page also lists configuration files and preset files in addition to media files. You can upload, 
download, or delete preset files and other configuration files as you can media files. Deleting 
configuration files is not recommended. If you do, exercise caution.

If you replace any configuration file, a reboot is required so that the Imagestore 750 can read 
and apply the settings.

Note: This web page is intended for convenience and should not be considered a viable alterna-
tive for professional media management tools or FTP transfers.

Note: Media transfers using the web page are likely to be slower and less effective for large files. 
For information on the FTP interface, please refer to the FTP Interface section.
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Audio Templates 
This page provides links to sample audio configuration templates to aid in the design of 
complex audio models in the ‘Audio Graph’ page of the Imagestore 750 Configurator. The page 
lists the principal features of each template and also lists all inputs, outputs, and preview modes. 

Fig. 9-7: Imagestore 750 Web Interface - Audio Templates

See Sample Audio Graph Templates on page 27 for more information. 
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System Backup 
This page allows you to back up all presets, fonts, and configurations of the Imagestore 750 or 
to restore files to the Imagestore 750. A backup is generated in a.tar file. 

Fig. 9-8: Imagestore 750 Web Interface - System Backup

To create a backup, click the ‘Backup’ button. The backup file generated is named backup.tar 
and is saved in a location on your PC (or its network) that you specify. 

To restore a file, click the ‘Browse’ button, navigate to select a backup file, and then click the 
‘Restore’ button. 

Note: System backups do not include media or sound files. Those should be backed up using 
FTP instead.
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System Reset
This page allows you to reboot the Imagestore 750. 

Fig. 9-9: Imagestore 750 Web Interface - System Reset

 Warning: Never use this option when the Imagestore 750 is on-air.
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Software Upgrade 
This page allows you to upgrade the Imagestore 750’s software.

 Warning: Do not switch off the Imagestore 750 during an upgrade.

 Warning: Carrying out an upgrade instantly stops the Imagestore 750’s software, resulting 
in a loss of output.

 Warning: Upgrades can take a long time to complete, depending on features and software 
versions: You can expect up to 15 minutes plus 3 to 4 minutes for each Dolby module 
installed.

The software upgrade page is long and is presented next in two parts, following.

This is the first part: 

Fig. 9-10: Imagestore 750 Web Interface - Software Upgrade
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This is the last part: 

Fig. 9-11: Imagestore 750 Web Interface - Revert Software option

There are two types of upgrades possible:

• ‘Software Upgrade’ — leaves all media and configuration settings intact.

• ‘Software Full Re-initialisation’ — removes the configuration files as well as the media and 
restores the Imagestore 750 to its factory settings. Only the network settings will persist. 

 Warning: The Imagestore 750 will lose its output during an upgrade. Both of these 
upgrade options instantly stop the Imagestore 750’s software, resulting in a loss of 
output.

 Warning: Do not switch off the Imagestore 750 during an upgrade. Do not switch off the 
Imagestore 750 if you see a progress bar on the Imagestore 750’s hardware front panel. 

Switching off will interrupt the upgrading process, including interrupting the programming 
of the CPU FPGA “platform flash” memory, which will render the Imagestore 750 inoperable. 
It would then need to be returned for repair.

Warning: Imagestore 750 upgrades can take a long time to complete, depending on fea-
tures and software versions. You can expect up to 15 minutes plus 3 to 4 minutes for Dolby 
module installed. 

It may take several minutes for the software update to transfer to the Imagestore 750 during 
which time a web page message window is displayed stating that the update is under way. 
Progress is shown on the hardware front panel. After the software has installed, the Images-
tore 750 will automatically power cycle and boot the new software. 

Note: This page does not allow software version 2.0 to be downgraded. This requires a bootable 
USB stick.
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The ‘Software Full Re-Initialisation’ option is similar to the ‘Software Upgrade’ option, but the full 
system image will be refreshed, including all settings and media. This option should be required 
only if a disk failure occurs. 

 Warning: The ‘Software Full Re-initialisation’ option reformats the compact flash drive. 

The ‘Software Full Re-initialisation’ option reformats the compact flash drive (and HDD option if 
it is installed), so all existing media and configurations will be lost. Please use extreme caution 
and ensure that appropriate backups are made before using this option.

Revert Software
The ‘Revert Software’ option reverts the Imagestore 750 to its previously installed software. The 
Imagestore 750 will reboot automatically. All media files and configurations are maintained.

To start the reversion, check the ‘Are you sure?’ checkbox and then click ‘Revert’. You should 
monitor the progress of the software reversion and not interrupt the process.

Bootable USB Key
The ‘Create Bootable USB Key’ option allows you to create a bootable USB key containing an 
HTTP server. (Software upgrades from version 2.0 or later do not require a USB key to be created 
because software can be updated directly from the Web page.) 

Note: Always ensure that you use a USB key (not a USB HDD) when creating a bootable USB 
stick for updating software. The Imagestore will not be able to boot from a USB device that 
reports itself as a USB HDD device, even though it will appear to have imaged correctly.

The appropriate update zip file (is750-update-v42.zip) is required to create the bootable USB key. 
The process is as follows:

• Insert a blank USB key into the Imagestore 750. (You must remove the front fascia from the 
Imagestore 750. The USB port is located to the left of the front panel display.)

• Click ‘Browse’.

• Select the update.zip file from the ‘Choose File’ dialog.

• Check the ‘Media Inserted’ checkbox and click ‘Create’.

• Monitor the progress on the Imagestore 750’s front panel until it shows ‘DONE! Press Any 
Key’.

• Press the front panel joystick to remove the message.

• Remove the USB key (unless it is further required for this Imagestore 750).

This process creates a bootable USB key which can be used to upgrade an Imagestore 750, re-
initialize an Imagestore 750, or revert an Imagestore 750 to its previous software version. 
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FTP Interface 
Chapter 10 provides information about transferring media to the Imagestore 750 via FTP.

Topics
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 189 
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Secure transfers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 190
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Example FTP Client - WinSCP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 193

Media transfer via FTP

Introduction 
It is recommended that a media management system is used to transfer media to the 
Imagestore 750.

However, in the absence of a media management system, it is recommended that media is 
transferred to the Imagestore 750 via FTP. GUI-based or command-line-driven FTP client 
software utilities are freely available on most platforms and are installed by default on many.

File Transfer Protocol (FTP) is a standard network protocol used to transfer files from one host to 
another host over a TCP-based network, such as the Internet. The Imagestore 750 provides an 
FTP interface.

Login Credentials

The default Imagestore 750 FTP server login credentials are case-sensitive and are:

User name: miranda 
Password: password

Note: Miranda reserves the right to change the defaults if necessary. In case of difficulty logging 
in, please contact Miranda support.

For more details on FTP etc, please contact Miranda support.
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Imagestore 750 Media Folders

Each Imagestore 750 media type resides in a specific folder on the Imagestore 750. 
The table below lists the media’s media folder name, i.e where the media file must be 
transferred to.

For example: 
In a GUI FTP client, drag-and-drop a graphics media file to the Imagestore 750 “images” 
folder.

The Imagestore 750 media folder names seen from the FTP login are links to Imagestore 750’s 
internal folders. The Linux folder full path names are listed in the table above, for information 
only.

Secure transfers
Media may also be securely transferred to the unit using SFTP / SCP (file transfers will be made 
using AES encryption). A client such as WinSCP is required to use this feature. The default login 
credentials are the same as for FTP.

For more details on FTP etc, please contact Miranda support.

Media Type 
Imagestore 750 
Media Folder name 

(Imagestore 750  internal Linux folder 
full path, for information only)

Graphics  images /home/images
(linked to /home/non_critical/images)

Easyplay  sounds /home/sounds

Configuration Preset  configs /home/configs

Active Configuration  params /home/params
(linked to /home/params.root1)

Default mix Files  cfgtemplates_default /home/ cfgtemplates_default

Custom Mix Files  mixes /home/mixes

DVE Sequences  sequences /home/sequences

DVE Presets  dvepresets /home/dvepresets

Gain Presets  gainpresets /home/gainpresets

Shuffle Presets  shufflepresets /home/shufflepresets

Metadata Presets  mdpresets /home/mdpresets

Macro Presets  macropresets /home/macropresets

Table 10-1: Imagestore 750 Media folders for FTP transfers
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Example FTP Client - Windows Explorer

Type in the Imagestore URL into the address bar of the Windows Explorer window:

ftp://10.96.203.121 

Type in User name and Password into the Log On dialog:

 

Fig. 10-1: FTP login via Windows Explorer
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Fig. 10-2: FTP login Folder View from Windows Explorer
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Example FTP Client - WinSCP
(WinSCP is a GPL-licensed FTP client for Windows, downloadable from http://winscp.net.)

In the WinSCP Login dialog, enter the Imagestore IP address as Host name, type in the User 
name and Password and select FTP as File protocol. Login.

Fig. 10-3: FTP login with WinSCP

Fig. 10-4: FTP folder view from WinSCP (dual window, media folder and IS750)
193

http://winscp.net


FTP Interface
Example FTP Clients
194



Options 
Chapter 11 presents licensing options for the Imagestore 750.

Topics
About Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 195
Available options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 195
IS-750-LOGO Option . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 196
Audio Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 197

About Options
Licences, or purchase options, enable different features of the Imagestore 750. These options 
are either pre-installed, with the original purchase order, or can be used to upgrade an Images-
tore 750.

When options are enabled, they are listed in two places:

• The Options menu of the front panel.

• The ‘Licences’ tab of the Imagestore 750 Configurator (under ‘Configuration Mode’). See 
Licences on page 169.

Available options
The following Imagestore 750 options are available: 

Option Description

IS-750 The basic Imagestore 750, which includes A and B inputs, 3 fill/key 
inputs (including C and D inputs), A/B mix, program output, preview 
output, clean feed output, monitor output, 512 MB of stores memory, 
and supports SD and HD video standards

IS-750-LOGO A reduced Imagestore 750 “logo inserter” (A input only, 2 fill/key 
inputs, program output, preview output, 512 MB of stores memory, 
and supports SD and HD video standards

IS-750-LOGO-CD C and D input upgrade for IS-750-LOGO.

IS-750-LOGO-CF Clean-feed output upgrade for IS-750-LOGO

IS-750-LOGO-MF Monitor output upgrade for IS-750-LOGO

IS-750-DVE Single DVE (PGM and PVW)

IS-750-DVE-DUAL Dual DVE (PGM and PVW)

IS-750-Audio6 Audio: 1 group embedded, 16 AES in, 16 AES out

IS-750-Audio16 Audio: 4 groups embedded, 16 AES in, 16 AES out

Table 11-1: Imagestore 750 Licence Options
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IS-750-LOGO Option
The IS-750-LOGO option is a branding-only product. From a hardware perspective, it is identical 
to the standard Imagestore 750, but the following features are disabled:

• A/B mixing

• C and D inputs (Fill-3/Key-3).

• Clean-feed output.

IS-750-EAS Emergency Alert System (includes one AES input when no audio 
option is present).

IS-750-EP2 Easyplay stereo (16 channels available in version 3.1 and later).

IS-750-EP8 Easyplay 8 channels (16 channels available in version 3.1 and later).

IS-750-EP16 Easyplay 16 channels (available in version 3.1 and later)

IS-750-ET Easytext text generation

IS-750-Clock Bugclock (digital or analog).

IS-750-MEM-2GB Stores memory: 2 GB option

IS-750-HDD Internal media storage hard disk drive kit. (Software and operating 
system reside on the compact flash.)

IS-750-DOLBY-CARRIER-BOARD Carrier board without any advanced audio modules. This option 
makes the Imagestore 750 “Dolby-ready.” Note that all Dolby and up-
mix kits listed below do include the carrier board option. Extra mod-
ule upgrades may be purchased up to a total of four modules.

IS-750-DOLBY-DEC One Dolby decoder module, plus carrier board.

IS-750-DOLBY-DEC2 Two Dolby decoder modules, plus carrier board.

IS-750-DOLBY-DEC2-ENCE Two Dolby decoder modules and one Dolby E encoder module, plus 
carrier board.

IS-750-DOLBY-DEC2-ENCD Two Dolby decoder modules and one Dolby Digital (AC-3) encoder 
module, plus carrier board.

IS-750-DOLBY-ENCE One Dolby E encoder module, plus carrier board.

IS-750-DOLBY-ENCD One Dolby Digital (AC-3) encoder module, plus carrier board.

IS-750-DOLBY-DEC-UPG Add one Dolby decoder.

IS-750-DOLBY-ENCE-UPG Add one Dolby E encoder.

IS-750-DOLBY-ENCD-UPG Add one Dolby Digital (AC-3) encoder.

IS-750-UMX One up-mix module, plus carrier board.

IS-750-UMX-UPG Add one up-mix module.

IS-750-TEMP Temperature probe (available in version 3.0 and later)

IS-750-AD-1 Audio description block (available in version 3.1 and later)

IS-750-Master-Control Router control, source selection, arm and disarm, for iMC control pan-
els (available in version 4.2 and later)

IS-750-Dual-NIC Dual NIC option allowing separation of master control and media 
(available in version 4.2 and later). Contact Miranda for more details.

Option Description

Table 11-1: Imagestore 750 Licence Options
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• Monitor output.

If you need to enable these features at a future date, it is possible to upgrade to a standard 
Imagestore 750 by purchasing the appropriate licence(s). These are highlighted with a yellow 
background in the preceding options table.

 Note: The IS-750-Master-Control option is not compatible with IS-750-LOGO because master 
control requires A/B mixing.

Audio Options
The Imagestore 750’s audio options include an appropriate audio breakout option. These 
options include a SCSI cable and a 1RU breakout box that allows easy connection of 75W BNC or 
110W 3-pin, quick-release AES cables. (The SCSI pin-out is described in Rear Panel and Connec-
tions on page 200.) 

The product code of the 75W breakout box is ABT-32-32-D75. The product code of the 110W 
breakout box is ABT-32-32-D110.

If you have purchased the IS-750-EAS option without the IS-750-Audio6 or IS-750-Audio16 
option, then a stereo audio break-out cable (product code 1872-9100-100) is shipped with the 
unit. This is a SCSI-to-XLR cable giving one stereo pair voice-over capability.

Dolby modules (Dolby decode, Dolby E encode, Dolby Digital encode) and up-mix module 
options require that a Dolby carrier board also be installed. The carrier board and module 
options can be retrofitted to older Imagestore 750s. Please note that if the RS-485 ports are not 
present then metadata input and output will not be possible. 
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Chapter 12 provides guidelines for the integration of Imagestore 750(s) into a broadcast system. 

Topics
Rack Mounting Instructions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 199 
Rear Panel and Connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 200 

For installation of an iMC master control system, see Chapter 5.

Rack Mounting Instructions 
Observe these points:

1  Elevated operating ambient temperature.

If you install the Imagestore 750 in a closed or multi-unit rack assembly, the operating ambi-
ent temperature of the rack environment may be greater than room ambient temperature. 
Therefore, give consideration to installing the equipment in an environment compatible 
with the maximum ambient temperature specified by the manufacturer.

2  Reduced air flow. 

Install the Imagestore 750 in a rack so that the amount of air flow does not compromise safe 
operation of the equipment.

3  Mechanical loading. 

Mount the Imagestore 750 in the rack with even mechanical loading to prevent potential 
hazardous conditions.

4  Circuit overloading.

Give consideration to the connection of the equipment to your plant’s power supply circuit 
and the effect that circuit overloading might have on over-current protection and supply 
wiring. Consider equipment nameplate ratings appropriately.

5  Reliable grounding.

Maintain reliable grounding of rack-mounted equipment. Give particular attention to supply 
connections other than direct connections to the branch circuit (for example, the use of 
power strips). 

Ventilation 
The Imagestore 750 is ventilated front-to-back. Air enters the unit through the front, and 
exhaust air leaves the unit through the rear of the unit and through slots in the side at the rear. 

Example: Note: It is essential that the air ventilation holes in the front, rear, and side of the 
Imagestore 750 remain clear of any obstruction. Miranda recommends leaving a minimum 
half-inch gap above and below the Imagestore 750 in a rack.
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Power Requirements 
The Imagestore 750 has a main supply input circuit that automatically senses whether the 
applied AC voltage is in the range of 90–132 VAC or 180–264 VAC and responds accordingly. The 
Imagestore 750 accepts both 50 Hz and 60 Hz AC supplies. Under normal conditions, power 
consumption is approximately 150 Watts. The power consumed depends on the number of 
options that were installed.

Environment 
The Imagestore 750 tolerates operating temperatures from 5 °C to 40 °C with humidity between 
20 and 80%, non-condensing. The Imagestore 750 can be stored at temperatures ranging from –
10 °C to +70 °C. 

Restricted Access Location 
The Imagestore 750 must be in a restricted access location. Access should be granted only to 
service persons or users who have been instructed on the precautions that should be taken 
within the location.

Rear Panel and Connections 
The rear panel connections are arranged as shown here: 

Fig. 12-1: Rear Panel Connectors

• At the left:

12 BNCs4.4 — 8 SDI video inputs and 4 SDI video outputs.

1 BNC — analog reference input.

1 AES connector (16 AES pairs, input and output).

• At the right:

4 serial communication ports (COM1–COM4, RJ45).

2 RJ45 Ethernet connectors (LANs 1 and 2).

1 GPIO connector (GPI, LTC, Dolby metadata).

2 AC inputs.
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AC ConnectoGPIO ConnectorAES Connector 
COM Ports (4)

LAN Ports (2)Video Ref. Video Inputs and Outputs
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Video Inputs and Outputs 
The SDI ports function according to SMPTE 292M-1998 (HD) and SMPTE 259M-1997 (SD). The 
video standards supported are:

Each input and output connector is a 75W BNC.

If an invalid SDI signal is present then the input to the program bus will revert to black video. 
Alternatively a color field or test pattern may be substituted in place of valid SDI. 

Fig. 12-2: Rear Panel Connectors - Video Inputs and Outputs 

The following table lists the video signals, in order from left to right: 

HD 1080i50, 720p50, 1080i59.94, 720p59.94

SD 625i50, 525i59.94

Name Description

MON OUT Video monitor output. 
The Imagestore 750 allows you to monitor a number of internal signal paths through this 
connector. You can monitor video throughout the system, from the inputs through to the 
outputs (including between keyers) plus the contents of stores (fill and key), DVE scalers, 
color fields and test patterns.

CLN OUT Clean-feed output. 
The Imagestore 750 allows you to view a number of internal signal paths through this 
connector. The clean-feed output can be used to view partially branded video of the pro-
gram bus.

PVW OUT Preview output. 
The Imagestore 750 allows you to view a number of internal signal paths through this 
connector. Graphics for each keying layer are shared between the program and preview 
video buses, but keyer states are independent. The preview output is typically used for 
previewing graphics, audio voice-overs, and DVE moves prior to bringing them to air on 
the program bus.
Audio for program and preview can be controlled independently. This allows Easyplay 
clips or external voice-overs to be previewed before being heard on the program output.

C/FILL-3 IN Key 3’s fill input. This signal is also called ‘C IN’.

PGM OUT Program output.
The signal on this connector is the output generated by the Imagestore 750: a combina-
tion of an input video signal with any graphics that are keyed onto the program bus, plus 
embedded audio output from the audio mix engine. 
An exception to this is when a test pattern is routed directly to PGM OUT, which is only 
useful for commissioning purposes. 
Whenever the Imagestore 750’s software is inactive, a bypass relay on the rear panel con-
nects A IN directly to PGM OUT (and C IN directly to PVW OUT). This ensures that input 
video always gets to air, although the Imagestore 750 loses its ability to key graphics at 
this time. 

Table 12-1: Video Connectors Inputs and Outputs
201



Installation
Rear Panel and Connections
Note that audio for program and preview can be controlled independently. This enables Easy-
play clips or external voice-overs to be previewed before being heard on the program output.

Reference Input 
There is a single video reference input: 

Fig. 12-3: Rear Panel Connector - REF Input

REF IN (BNC) accepts a standard analog reference such as SD analog bi-level sync and HD tri-
level sync. It accepts both 50 Hz and 59.94 Hz frame rates, but all of the input signals (including 
fill and key) must use the same frame rate as the reference input. Refer to Reference Types on 
page 22 for a compatibility matrix between REF IN and output video format. 

 Note: Only VITC ANSI/SMPTE standard 12M-1995 may be present on bi-level sync.

Video Relay Bypass 
The Imagestore 750 has 2 mechanical relays that bypass the Imagestore 750’s video and audio 
processing when the Imagestore 750 loses power and also when it is starting up. These relays 
route A IN to PGM OUT and C/FILL 3 IN to PVW OUT. 

This rear silk screen shows the bypass connections: 

Fig. 12-4: Rear Panel Connectors - Video Relay Bypass

A IN Video input A. (This signal is also called the “PGM IN” and “background.”)

B IN Video input B. (This signal is also called “PVW IN.”)

D/KEY-3 IN Key 3’s key input. This signal is also called ‘D IN’.

FILL-1 IN Key 1’s fill input.

KEY-1 IN Key 1’s key input.

FILL-2 IN Key 2’s fill input.

KEY-2 IN Key 2’s key input.

REF IN Analog reference, either HD tri-level sync or SD bi-level sync (“black and burst”).

Name Description

Table 12-1: Video Connectors Inputs and Outputs

Bypass connections
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AES Connector 
The AES connector is a 68-pin SCSI VHDCI-68 female connector. You can connect 16 AES/EBU 
input pairs and 16 AES/EBU output pairs at this port. 

Fig. 12-5: Rear Panel Connector- Audio AES Connector

(This provides 32 mono audio channels in and 32 mono audio channels out.)

Each AES channel should be connected to the Imagestore 750 over two wires using balanced 
(differential + and –) signals and a grounded shield. Signal and associated pinout connections 
are given in the following table. 

4C

.5

.�

�

Pin Signal Pin Signal

1 AES_IN_1 (+) 35 AES_IN_1 (–)

2 AES_IN_2 (+) 36 AES_IN_2 (–)

3 AES_IN_3 (+) 37 AES_IN_3 (–)

4 AES_IN_4 (+) 38 AES_IN_4 (–)

5 AES_IN_5 (+) 39 AES_IN_5 (–)

6 GND 40 GND

7 AES_IN_6 (+) 41 AES_IN_6 (–)

8 AES_IN_7 (+) 42 AES_IN_7 (–)

9 AES_IN_8 (+) 43 AES_IN_8 (–)

10 AES_IN_9 (+) 44 AES_IN_9 (–)

11 AES_IN_10 (+) 45 AES_IN_10 (–)

12 AES_IN_11 (+) 46 AES_IN_11 (–)

13 AES_IN_12 (+) 47 AES_IN_12 (–)

14 AES_IN_13 (+) 48 AES_IN_13 (–)

15 AES_IN_14 (+) 49 AES_IN_14 (–)

16 AES_IN_15 (+) 50 AES_IN_15 (–)

17 AES_IN_16 (+) 51 AES_IN_16 (–)

18 AES_OUT_1 (+) 52 AES_OUT_1 (–)

19 AES_OUT_2 (+) 53 AES_OUT_2 (–)

20 AES_OUT_3 (+) 54 AES_OUT_3 (–)

21 AES_OUT_4 (+) 55 AES_OUT_4 (–)

22 AES_OUT_5 (+) 56 AES_OUT_5 (–)

23 AES_OUT_6 (+) 57 AES_OUT_6 (–)

24 AES_OUT_7 (+) 58 AES_OUT_7 (–)

25 AES_OUT_8 (+) 59 AES_OUT_8 (–)

26 AES_OUT_9 (+) 60 AES_OUT_9 (–)

27 AES_OUT_10 (+) 61 AES_OUT_10 (–)

28 AES_OUT_11 (+) 62 AES_OUT_11 (–)

29 AES_OUT_12 (+) 63 AES_OUT_12 (–)

Table 12-2: Audio AES Connector pinout
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1RU audio breakout boxes are available for both 110 W and 75 W connectors. (These are products 
ABT-32-32-D110 and ABT-32-32-D75 respectively.) Connect to the audio breakout box with a SCSI 
VHDCI-68 male to HD68 male SCSI cable. 

This is a drawing of the 110 W breakout box, which has 3-pin quick-release connectors: 

Fig. 12-6: Audio Breakout Box - ABT-32-32-D75

This is a drawing of the 75 W breakout box, which has BNCs: 

Fig. 12-7: Audio Breakout Box - ABT-32-32-D110

The following table shows the dimensions of the audio breakout boxes: 

30 GND 64 GND

31 AES_OUT_13 (+) 65 AES_OUT_13 (–)

32 AES_OUT_14 (+) 66 AES_OUT_14 (–)

33 AES_OUT_15 (+) 67 AES_OUT_15 (–)

34 AES_OUT_16 (+) 68 AES_OUT_16 (–)

Pin Signal Pin Signal

Table 12-2: Audio AES Connector pinout

��

@

��

@

Product W H D1 D2

ABT-32-32-D110 482.6 mm  
19.00 inches

43.2 mm 
1.70 inches

37.7 mm 
1.48 inches

29.4 mm 
1.16 inches

ABT-32-32-D75 482.6 mm 
19.00 inches

43.2 mm 
1.70 inches

40.1 mm 
1.58 inches

31.9 mm 
1.26 inches

Table 12-3: ABT-32-32 dimensions
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LANs 1 and 2 
The Ethernet connectors (LANs 1 and 2) are RJ45 10/100baseT ports, which automatically nego-
tiate the fastest speed possible: 

Fig. 12-8: Rear Panel Connectors - LAN ports 1 and 2 - RJ45

These ports are typically used for uploading and downloading media and configuration files, 
but can also be used for automation. You can connect the Imagestore 750 to two local networks. 

 Note: It is recommended that both LAN ports be connected, ideally to separate switches 
because the ports are ‘bonded’ together (in software) to achieve Ethernet redundancy on 
the same IP address.

 Note: Separate IP addresses can be assigned to LAN 1 and LAN 2 for master control applica-
tions where media transactions must be isolated from automation control. This is known as 
VLAN port tagging. It is not usually required since modern networks can deal with all trans-
actions over one IP address, and network redundancy is lost. Please contact Miranda 
Customer Support for details.

The pin-out of the Ethernet port is: 

Each of the LAN ports has two integral LED indicators. 

Pin Signal Name 

1 TDP

2 TDN

3 RDP

4 n.c.

5 n.c.

6 RDN

7 n.c.

8 n.c.

Table 12-4: LAN ports connector pinout

Green Indicates 100 Mbps speed.

Yellow Indicates active network link.
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COM 1–4 
There are 4 COM ports, COM 1 through COM 4: 

Fig. 12-9: Rear Panel Connectors - Serial Comms ports

They are 8-pin RJ45 ports that provide serial bidirectional communications to external automa-
tion systems, EAS units, a slave device, RCP Classic, or an ST61XX thermometer. The serial port 
type can be configured as RS-232 or RS-422. The Baud rate can be set to 1200, 9600, 19200, 
38400, 57600 or 115200. 

See Emergency Alert System (EAS) on page 35, Temperature Probe on page 38, and Graphics 
Co-Processors on page 52for more information. 

A serial port can be set to receive Oxtel automation commands or to transmit certain Oxtel auto-
mation commands to a slave device using the “Oxtel Slave” protocol. For EAS, the serial port will 
receive “ENDEC 1822” and “TFT EAS 911T” protocols, and for the temperature probe, it will 
receive “ST61XX Thermometer” protocol. 

 A Baud rate of 1200 is valid only when used with the protocol for the ST61XX thermometer.

When your Imagestore 750 is used for master control, the serial port can also be set to send and 
receive Presmaster protocol automation using the “Presmaster Automation” protocol, although 
Oxtel automation is a superior and more flexible protocol and should therefore be preferred. 

If a Presmaster Control System (PCS) is controlling the Imagestore 750, you should select “Oxtel 
Automation” protocol, and it is recommended that a Baud rate of 57,600 and serial type of RS-
422 be used. Note that Presmaster software version 4.6 or higher is required for controlling all 
four DSKs.

The pin-out of each COM port is:

Pin Signal Name RS-422 Signal Name RS-232

1 TX+ RTS

2 TX– TXD

3 RX+ CTS

4 n.c. n.c.

5 n.c. n.c.

6 RX– RXD

7 n.c. n.c.

8 GND GND

Table 12-5: Serial Comms Ports connector pinout
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Serial Connection to Intuition XG 
If the Imagestore 750 uses an Intuition XG co-processor, it often requires a serial connection to 
the Intuition XG. 

This connection can be achieved with a normal Ethernet cable plus a Miranda RJ45-to-DB9 
adapter supplied with the Imagestore 750. 

The adapter is Miranda part number 1897-1800-100 (Intuition-XG RS232-to-IS750 Com Port). 
The adapter is illustrated here: 

Fig. 12-10: Intuition-XG RS232-to-IS750 adapter

GPIO / LTC 
The GPIO / LTC connector is a 44-pin HD type: 

Fig. 12-11: Rear Panel Connectors - GPIO / LTC connector

An Imagestore 750 that has a Dolby or upmix option can use the RS-485 connections on this 
connector, which are dedicated to Dolby metadata. Dolby metadata is transmitted on a serial 
RS-485 link as an intermittent and asynchronous serial data stream, with bursts of data occur-
ring at the video frame rate. This connector supports a variety of signals:

• General-purpose interface.

16 general-purpose interface ports, software configurable as inputs or outputs.

1 +12 V supply (500 mA max).

1 +5 V supply (500 mA max).

1 ground pin.

• Linear time code port. 

�

.�

��

55
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LTC+, LTC–, ground.

• Total DC fail alarm.

2-pin “contact closure” for a condition of total DC voltage failure within the Imagestore 750. 
(When the Imagestore 750 is normally powered, these 2 pins are isolated.) These contacts 
can be used to switch on some external warning buzzer or lamp (provided this is less than 
400 mA, and less than 25 V.

• Dolby metadata RS-485 serial ports.

4 ports (4 differential signals) configured as input or output.

115200 Baud.

1 start bit, 8 data bits, 1 stop bit, no parity

• Two RS-232 ports for future use.

The table below shows pin-outs for the GPIO 44-way D-type connector.  

Note: GPI numbering is zero-based for pin-outs, automation, and the front panel. (Use GPI-0, 
GPI-1, GPI-2, and so on, to GPI-15.)

Miranda offers a 44-terminal GPIO adapter to help you use this connector. Its order code is GPIO-
44TBA. Another adapter is the IS-25-44-ADP, which is a 25-pin-to-44-pin adaptor that allows 
wiring designed for the 25-pin GPI/LTC connector to be used with the 44-pin GPI/LTC connector.

Note: The 25-pin GPIO/LTC port was used with earlier Imagestore 750s. Please refer to the 
Imagestore 750 user’s manual for version 1.14.0 or 1.14.1 software.

Connection of General-Purpose Interface (GPI) 
Any GPI port can be used either to trigger the execution of a series of internal pre-programmed 
commands (input) or to monitor the status of the Imagestore 750 (output). Each GPI can be 
configured as either an input or an output. See General Purpose Interface (GPI) on page 47. 

Pin Signal Name Pin Signal Name Pin Signal Name 

1 LTC– 16 RS485/1+ 31 LTC+

2 LTC_GND 17 RS485/1– 32 GP_GND

3 TOTAL_DC_FAIL 18 RS485/2+ 33 GPIO_15

4 GPIO_14 19 RS485/2– 34 GPIO_13

5 GPIO_12 20 RS485/3+ 35 GPIO_11

6 GPIO_10 21 RS485/3– 36 GPIO_9

7 GP_+5V 22 RS485/4+ 37 TOTAL_DC_FAIL

8 GP_+12V 23 RS485/4– 38 GPIO_8

9 GPIO_7 24 GND 39 GPIO_6

10 GPIO_5 25 GND 40 GPIO_4

11 GPIO_3 26 GND 41 GPIO_2

12 GPIO_1 27 RS232A_TX (reserved) 42 GPIO_0

13 GP_GND 28 RS232A_CTS (reserved) 43 RS232A_RX (reserved)

14 RS232B_TX (reserved) 29 RS232A_RTS (reserved) 44 RS232B_RX (reserved)

15 RS232B_RTS (reserved) 30 RS232B_CTS (reserved)

Table 12-6: GPIO / LTC connector pinouts
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Input to GPI 
Where a GPI port is used as an input, the command macro with which it is associated can be 
activated either by connecting or by disconnecting the input line to GPI ground (GPIO pin 13 or 
15) depending whether ‘GPI On’ or ‘GPI Off’ has been assigned to the port.

Output from GPI 
A GPI port can be used as an output and its active status (on) is defined by the output being 
internally pulled to ground by a Darlington transistor. (Active low is represented by +0.7 V or 
less.) Lamps or relays attached to an output port can use either the GP +12 V supply (pin 8) or GP 
+5 V supply (pin 7) but the maximum current drawn from either supply should not exceed 
500 mA. These supplies are fused.

Where a GPI output is used to drive a relay coil, you should incorporate reverse voltage protec-
tion diodes in the circuit to protect the Imagestore 750 from voltage transients.

LTC Connection 
Where linear timecode is provided for the Imagestore 750, it should conform to ANSI/SMPTE 
standard 12M-1995. The input level should be between 1.0 and 2.0 volts peak-to-peak.

AC Input 
The Imagestore 750 is equipped with two 350 W power supply units, each fed from its own rear 
IEC connector. The power supplies are auto-ranging from 100–120 VAC and 200–240 VAC. 

Fig. 12-12: Rear Pael Connectors - IEC Mains AC Inlets

Applying Power 
Each of the two power supply units (PSU) of the Imagestore 750 has a power switch that 
becomes accessible when you remove the front fascia. The Imagestore 750 should be 
connected to main power with an appropriate circuit breaker on each circuit.

After power is applied, the Imagestore 750 will boot automatically. The normal complete boot 
process takes about 50 seconds, or approximately 90 seconds after a software upgrade. Addi-
tional time should be allowed for advanced audio module firmware upgrades.

Before applying power, ensure that the USB port does not contain a USB device. When starting 
up, the Imagestore 750 first checks to see if there is a USB device present. If it finds one, it will 
attempt to boot from that device. Note that this USB port is hidden by the front fascia.
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The normal boot sequence is complete when the following top level “boot-up” menu appears 
on the front panel display. 

Fig. 12-13: Imagestore 750 Front Panel message after booting

Note: When a restart is required to change any configuration setting, then you can perform a 
software restart. This option usually completes in approximately 16 seconds. It is much faster 
than a hardware restart.
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Specifications 
Chapter 13 presents the core product specifications for the Imagestore 750. 

SDI Inputs and Outputs 
The Imagestore 750 can receive and transmit the following SD-SDI / HD-SDI video standards:

525i, 59.94 Hz SMPTE 259M-1997 270 Mb/s

625i, 50 Hz SMPTE 259M-1997 270 Mb/s

1920x1080i, 59.94 Hz SMPTE 274M-1998 1.485 Gb/s

1920x1080i, 50 Hz SMPTE 274M-1998 1.485 Gb/s

1280x720, 59.94 Hz SMPTE 296M-2001 1.485 Gb/s

1280x720, 50 Hz SMPTE 296M-2001 1.485 Gb/s

Input is through screened 75W BNC connectors. The return loss is better than –15 dB up to 
1.5 GHz. Each input circuit is provided with automatic adaptive equalization circuitry suitable for 
lengths of up to 110 m of Belden 8281 or Belden 1694A cable.

All outputs have amplitudes of 800 mV (± 10%).

The Imagestore 750 delays the video path by no more than one line, excluding any in-circuit 
frame delays that are configured.

Power Requirements 
The Imagestore 750 accepts either 110 VAC or 230 VAC (auto-ranging from 100–120 VAC and 
200–240 VAC), 60 Hz or 50 Hz. There are supply fuses within each of two removable power 
supply modules. There are DC supply fuses within the Imagestore 750.

Interfaces 
The Imagestore employs these interfaces: 

COM (RS-232 or RS-422) Automation serial control interfaces 

Ethernet Image-loading, configuration, and transfer or automation

GPIs 16 GPIs with an input and output macro editor

RS-485 Dolby metadata serial interfaces (4)
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Video Frame Rates 
These are video frame rate data for the rates handled by the Imagestore 750: 

Mechanical 
The Imagestore 750 has a 1RU chassis with the following mechanical specification: 

Environmental 

Note: An air-conditioned environment is recommended for optimal performance and reliability.

Standard

Pixels 
per 
Active 
Line  
(S/AL)

Active 
Lines 
per 
Frame

Frame 
Rate  
(Hz)

Scanning 
Format

Interface 
Sampling 
Clock fre-
quency  
Fs (MHz)

Clock 
Periods 
per Total 
Line  
(S/TL)

Total 
Lines per 
Frame

SMPTE 259M

525i, 59.94 720 486 30/1.001 2:1 interlaced 13.5 858 525

625i, 50 720 576 25 2:1 interlaced 13.5 864 625

SMPTE 274M

1920 × 1080, 
59.94, 2:1 1920 1080 30/1.001 2:1 interlaced 74.25/1.001 2200 1125

1920 × 1080,  
50, 2:1 1920 1080 25 2:1 interlaced 74.25 2640 1125

SMPTE 296M

1280 × 720, 
59.94 1280 720 60/1.001 1:1 progressive 74.25/1.001 1650 750

1280 × 720, 
50 1280 720 50 1:1 progressive 74.25 1980 750

Table 13-1: Imagestore 750 Video Frame Rate Information

Height 44.5 mm (1.75 in — 1RU)

Width 482.6 mm (19.0 in) with mounting ears; 442.0 mm (17.40 in) without ears

Depth 660.4 mm (26.0 in) 

Weight 9.0 kg (19.8 lbs) minimum system, 1 PSU

Cooling Forced air, internal fans

Operating temperature 5 °C to 40 °C

Storage temperature –10 °C to 70 °C

Humidity 20% to 80%, non-condensing
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Front Panel Menu 
Appendix A presents the commands of the front panel menu. 

The following list shows the hierarchical structure of the Imagestore 750’s front panel menus. 
Many menu items are dependent on the presence of one or more licence options.

(Commands at the same indentation can be accessed, at the front panel, by moving the joystick 
to the left or right, corresponding to the arrows on the front panel. A command that is indented 
relative to the previous command is accessed by moving the joystick down, corresponding to 
the word “enter” on the front panel.) 

Note: This is a long list. Some items are marked with “Repeats for . . .” to shorten the list. 

Status

General Status General system status

Temperature Temperature of the FPGA

PSUA 12V Actual voltage of the 12V PSUA

PSUB 12V Actual voltage of the 12V PSUB

SYS 5V Actual voltage of the 5V supply rail

SYS 3.3V Actual voltage of the 3.3V supply rail

SYS 2.5V Actual voltage of the 2.5V supply rail

SYS 1.8V Actual voltage of the 1.8V supply rail

SYS 1.2V Actual voltage of the 1.2V supply rail

DVE 12V Actual voltage of the 12V supply rail on the DVE card

DVE 2.5V Actual voltage of the 2.5V supply rail on the DVE card

DVE 1.8V Actual voltage of the 1.8V supply rail on the DVE card

DVE 1.2V Actual voltage of the 1.2V supply rail on the DVE card

PSU A Status of the 12V PSUA

PSU B Status of the 12V PSUB

FAN 1 SPEED Speed of the first fan, in RPM

FAN 2 SPEED Speed of the second fan, in RPM

FAN 3 SPEED Speed of the third fan, in RPM

FAN 4 SPEED Speed of the fourth fan, in RPM

FAN 5 SPEED Speed of the fifth fan, in RPM

Timecode Status “LTC” or “VITC” if valid timecode is present; otherwise “BAD-Internl”

“DF” for dropframe; “ND” for no dropframe

“Fwd” or “Bwd” shows LTC direction

Timecode Time “Ext” if valid external time code; “Int” if using internal clock 

Ref Status

Ref Source  “External Ref” if locked to EXT REF; “SDI A” if locked to A; “Free Running” or “Unknown”

Ext Reference

Ext Ref Status “Locked” if the external reference is valid; “Unlocked” if missing. It does not differentiate 
between tri-level (HD) or bi-level (SD) analogue references.

Ext Standard “625 Line”, “525 Line”, “1080i/59.94”, “1080i/50”, “720p/59.94”, “720p/50 or “Unknown” if 
not present
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Input Status

A Input

Video Standard “625 Line”, “525 Line”, “1080i/59.94”, “1080i/50”, “720p/59.94”, “720p/50” or “Unlocked” if 
signal is not present

Input Timing Input timing relative to the Program Output in lines/samples; “Unlocked” if video signal is not 
present, or “Unknown” if the signal is not recognized.

B Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

C Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

D Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

FILL-1 Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

KEY-1 Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

FILL-2 Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

KEY-2 Input

Video Standard See “A Input” (above)

Input Timing See “A Input” (above)

Audio Feed 1–4 Repeats for audio feeds 1–4

Channel 1 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 2 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 3 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 4 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 5 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 6 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 7 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 8 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 9 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 10 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 11 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 12 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 13 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 14 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 15 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Channel 16 “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

AES

Pair 1L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 1R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 2L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 2R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 3L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 3R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 4L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”
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Pair 4R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 5L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 5R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 6L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 6R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 7L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 7R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 8L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 8R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 9L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 9R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 10L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 10R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 11L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 11R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 12L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 12R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 13L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 13R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 14L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 14R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 15L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 15R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 16L “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Pair 16R “PCM”, “DolbyE”, “DolbyD” “Non-PCM” or “Unlocked”

Clocks

27 MHz Clk Shows the status of the 27 MHz clock as “Locked” or “Unlocked”

54 MHz Clk Shows the status of the 54 MHz clock as “Locked” or “Unlocked”

74 MHz Clk Shows the status of the 74 MHz clock as “Locked” or “Unlocked”

Output Status

Program

Video Standard Video standard of Program Output

Preview

Video Standard Video standard of Preview Output

Audio Mod Stat

Module 1 Status “Module Error”, “Module OK”, “Not Filled” or “Unknown”

Module 2 Status “Module Error”, “Module OK”, “Not Filled” or “Unknown”

Module 3 Status “Module Error”, “Module OK”, “Not Filled” or “Unknown”

Module 4 Status “Module Error”, “Module OK”, “Not Filled” or “Unknown”

Module 1 Type “Dolby Decoder”, “Dolby D Encoder”, “Dolby E Encoder”, “Up-mix”, “Not Filled” or 
“Unknown”

Module 2 Type “Dolby Decoder”, “Dolby D Encoder”, “Dolby E Encoder”, “Up-mix”, “Not Filled” or 
“Unknown”

Module 2 Type “Dolby Decoder”, “Dolby D Encoder”, “Dolby E Encoder”, “Up-mix”, “Not Filled” or 
“Unknown”

Module 2 Type “Dolby Decoder”, “Dolby D Encoder”, “Dolby E Encoder”, “Up-mix”, “Not Filled” or 
“Unknown”

System Info

Serial Number Serial number (factory set)

IP Address IP address (changed via Setup > Network menu).

Hostname Hostname (changed via Setup > Network menu).

Network Mask Network mask (changed via Setup > Network menu).
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Gateway Add Gateway address (changed via Setup > Network menu).

MAC Addres MAC address (factory set)

NTP Server NTP server address (changed via Setup > Network menu).

Op System Linux operating system kernel version

File Sys Type File system type for the /home partition (JFS)

Animation Mem Store memory associated with DSK 1

Animation Mem Store memory associated with DSK 2

Animation Mem Store memory associated with DSK 3

Animation Mem Store memory associated with DSK 4

Images Used Number of files in the image library (up to 4000 displayable on the front panel)

Disk Space Used Disk space used, in MB or GB, with percentage of total space used

Current MixFile ‘Audio Graph’ if audio is defined by the Imagestore 750 Configurator. Otherwise, the name of 
the mix file

COM 1 Counters “Rx” (received data), “Tx” (transmitted data), “FE” (framing errors), “PE” (parity errors), “BI” 
(breaks), “OE” (overrun errors)

COM 2 Counters See “COM 1 Counters” (above)

COM 3 Counters See “COM 1 Counters” (above)

COM 4 Counters See “COM 1 Counters” (above)

RS232 A Counters See “COM 1 Counters” (above). Reserved for future use

RS232 B Counters See “COM 1 Counters” (above). Reserved for future use

RS485 1 Counters See “COM 1 Counters” (above)

RS485 2 Counters See “COM 1 Counters” (above)

RS485 3 Counters See “COM 1 Counters” (above)

RS485 4 Counters See “COM 1 Counters” (above)

Time Zone Time zone offset from GMT (changed via Setup > Date/Time)

Current Date Current date (changed via Setup > Date/Time)

Current Time Current time (changed via Setup > Date/Time)

Running Since Date and time when the unit was last powered up

Main Board Rev Main board revision

I/O Board Rev I/O board revision

DVE Board Rev DVE board revision

Store SPD Store memory Serial Presence Detect (SPD) size and product ID

Delay SPD Delay memory Serial Presence Detect (SPD) size and product ID

CPU FPGA Date Firmware build date

CPU FPGA Ident Firmware mode: “SD” or “HD”

CPU FPGA Version Firmware version number

Operate

Set Inputs

A

Pass SDI Selects incoming SDI input for use by this input

Colour Field 1 Selects Color Field 1 for use by this input (in place of SDI)

Colour Field 2 Selects Color Field 2 for use by this input (in place of SDI)

Colour Field 3 Selects Color Field 3 for use by this input (in place of SDI)

Test Pattern 1 Selects Test Pattern 1 for use by this input (in place of SDI)

Test Pattern 2 Selects Test Pattern 2 for use by this input (in place of SDI)

B

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)
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C

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)

D

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)

Fill-1

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)

Key-1

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)

Fill-2

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)

Key-2

Pass SDI See “A” (above)

Colour Field 1 See “A” (above)

Colour Field 2 See “A” (above)

Colour Field 3 See “A” (above)

Test Pattern 1 See “A” (above)

Test Pattern 2 See “A” (above)

Input Masks

A Allows a rectangular mask to be applied to each physical SDI input by adjusting the Left, Right, 
Top and Bottom extent of the mask. 

Warning: Setting masks will directly affect the equivalent SDI source, so anything else that uses 
that source (for example, the AB Mixer or a DVE Input) will be also affected.

If an input is associated with a color field or test pattern (so that it is not using its SDI input 
source), then the image will not be masked. Only the SDI source is masked.

B See “A” (above)

C See “A” (above)

D See “A” (above)
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Fill-1 See “A” (above)

Key-1 See “A” (above)

Fill-2 See “A” (above)

Key-2 See “A” (above)

Colour Fields

Colour Field 1 Defines Color Field 1 in terms of RGB values as a percentage

Colour Field 2 Defines Color Field 2 in terms of RGB values as a percentage

Colour Field 3 Defines Color Field 3 in terms of RGB values as a percentage

Mix A Input

A Selects A as the A input for the AB mixer

B Selects B as the A input for the AB mixer

C Selects C as the A input for the AB mixer

D Selects D as the A input for the AB mixer

Fill-1 Selects Fill-1 as the A input for the AB mixer

Key-1 Selects Key-1 as the A input for the AB mixer

Fill-2 Selects Fill-2 as the A input for the AB mixer

Key-2 Selects Key-2 as the A input for the AB mixer

 Mix B Input

A  Selects A as the B input for the AB mixer

B Selects B as the B input for the AB mixer

C Selects C as the B input for the AB mixer

D Selects D as the B input for the AB mixer

Fill-1 Selects Fill-1 as the B input for the AB mixer

Key-1 Selects Key-1 as the B input for the AB mixer

Fill-2 Selects Fill-2 as the B input for the AB mixer

Key-2 Selects Key-2 as the B input for the AB mixer

Program Input

A Selects A as the Program input for IS-750-LOGO

B Selects B as the Program input for IS-750-LOGO

C Selects C as the Program input for IS-750-LOGO

D Selects D as the Program input for IS-750-LOGO

Fill-1 Selects Fill-1 as the Program input for IS-750-LOGO

Key-1 Selects Key-1 as the Program input for IS-750-LOGO

Fill-2 Selects Fill-2 as the Program input for IS-750-LOGO

Key-2 Selects Key-2 as the Program input for IS-750-LOGO

AB Mixer

Cut AB Cuts the AB mixer between the A/B inputs 

Cut To A Cuts the AB mixer to the A input

Cut To B Cuts the AB mixer to the B input

Fade AB Fades AB mixer between the A/B inputs over AB mixer fade duration

Fade To A Fades AB mixer to the A input over AB mixer fade duration

Fade To B Fades AB mixer to the B input over AB mixer fade duration

Trans Type

X-Fade Selects cross-fading as the mode for AB mixing

V-Fade Selects V-fading as the mode for AB mixing

Mix Rate Selects AB mixer fade rate in fields/frames (interlaced/progressive) used when fades as 
performed via the front panel or automation

V-Fade Colour Selects the RGB color field through which V-fades will transition. The default color is black.

Set Cut Mode

Any Field Selects A/B cuts or fades to start on any field (interlaced)

Field 1 (Def) Selects A/B cuts or fades to start on field 1 (interlaced)

Field 2 Selects A/B cuts or fades to start on field 2 (interlaced)
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Play Forward Plays the selected DVE sequence in the forward direction.

Play Backward Plays the selected DVE sequence in reverse direction.

Load Sequence Select and play DVE sequence. When sequence is selected this plays the previously selected 
sequence in reverse.

Load Action

First Keyframe Loading the DVE sequence will start it at the first keyframe

Last Keyframe Loading the DVE sequence will start it at the last keyframe

Play Forward Loading the DVE sequence will start it playing forwards

Play Backward Loading the DVE sequence will start it playing backwards

DVE Mode

Disabled DVE is out of circuit (bypassed). 

If the DVE will be enabled at run-time, add compensating video delays to match the DVE delay. 

Enabled DVE is in circuit and active. 

There is a video delay through the DVE. The DVE inputs are defined by DVE 1 input and DVE 
2 input (if licensed). You must add compensating video delays to match the DVE delay. 

DVE 1 Input

A Video input A is passed into the first DVE window. 

B Video input B is passed into the first DVE window. 

C Video input C is passed into the first DVE window. 

D Video input D is passed into the first DVE window. 

AB Mixer AB mixer output is passed into the first DVE window.

Fill-1 Video input Fill-1 is passed into the first DVE window. 

Key-1 Video input Key-1 is passed into the first DVE window. 

Fill-2 Video input Fill-2 is passed into the first DVE window. 

Key-2 Video input Key-2 is passed into the first DVE window. 

DVE 2 Input

A Video input A is passed into the second DVE window. 

B Video input B is passed into the second DVE window. 

C Video input C is passed into the second DVE window. 

D Video input D is passed into the second DVE window. 

AB Mixer AB mixer output is passed into the second DVE window.

Fill-1 Video input Fill-1 is passed into the second DVE window. 

Key-1 Video input Key-1 is passed into the second DVE window. 

Fill-2 Video input Fill-2 is passed into the second DVE window. 

Key-2 Video input Key-2 is passed into the second DVE window. 

2D DVE (PVW)

Play Forward Plays the selected DVE sequence in the forward direction on PVW. 

Play Backward Plays the selected DVE sequence in reverse direction on PVW.

Load Sequence Select and play DVE sequence. When sequence is selected, this plays the previously selected 
sequence in reverse.

Load Action

First Keyframe Loading the DVE sequence will start it at the first keyframe

Last Keyframe Loading the DVE sequence will start it at the last keyframe

Play Forward Loading the DVE sequence will start it playing forwards

Play Backward Loading the DVE sequence will start it playing backwards

DVE Mode

Disabled DVE is out of circuit (bypassed). Add video delays if compensation of the DVE delay is required

Enabled DVE is in circuit and active. The inputs are defined by DVE 1 input and DVE 2 input (if 
licensed). Add video delays if compensation of the DVE delay is required. 

DVE 1 Input

A Video input A is passed into the first DVE window. 
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B Video input B is passed into the first DVE window.

C Video input C is passed into the first DVE window.

D Video input D is passed into the first DVE window. 

AB Mixer AB mixer output is passed into the first DVE window.

Fill-1 Video input Fill-1 is passed into the first DVE window. 

Key-1 Video input Key-1 is passed into the first DVE window.

Fill-2 Video input Fill-2 is passed into the first DVE window. 

Key-2 Video input Key-2 is passed into the first DVE window. 

DVE 2 Input

A Video input A is passed into the second DVE window. 

B Video input B is passed into the second DVE window.

C Video input C is passed into the second DVE window. 

D Video input D is passed into the second DVE window.

AB Mixer AB mixer output is passed into the second DVE window.

Fill-1 Video input Fill-1 is passed into the second DVE window.

Key-1 Video input Key-1 is passed into the second DVE window.

Fill-2 Video input Fill-2 is passed into the second DVE window. 

Key-2 Video input Key-2 is passed into the second DVE window.

DVE Config

K1K2 DVE K3K4 DVE output positioned between DSK 2 and DSK 3 within the video channel streams on both 
PGM and PVW.

K1 DVE K2K3K4 DVE output positioned between DSK 1 and DSK 2 within the video channel streams on both 
PGM and PVW.

DVE K1K2K3K4 DVE output positioned before DSK 1 within the video channel streams on both PGM and PVW.

DSK 1–4 Repeat for DSKs 1–4

Keyer Ops

Cut Up/Down Cuts up/down the keyer over the background video

Cut Up Cuts up the keyer over the background video

Cut Down Cuts down the keyer over the background video

Fade Up/Down Fades up/down the keyer over the background video

Fade Up Fades up the keyer over the background video

Fade Down Fades down the keyer over the background video

Fade Rate Adjusts the keyer fade rate between 1 and 999 fields as used by the front panel and automation

Set Key Params

Source

Self  Key data is derived from the Fill signal

Separate  Key data is derived from Key signal

None  Key data is set white so there is no transparency

Type

Full  Passes the foreground signal where the key signal is present

Linear  Sums background and foreground images to create the signal

Sense

Normal  Selects the mode in which a black key means transparent and a white key is opaque

Invert  Selects the mode in which a white key means transparent and a black key is opaque

Masking

Disable  Uses no masking of the keyer output

Setup  Defines a mask area within the range determined by the size of the image and the standard.

C, G & T  Sets clip, gain and transparency. Clip is the level under which the key signal will be forced to 
black. Gain amplifies the signal forcing grey levels to approach white. Transparency affects the 
luminance of the key and therefore the amount of background allowed in the output.

Cut To/Fr Blk Cuts to/from black output

Cut From Blk Cuts from black output
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Cut To Blk Cuts to black output

Fade To/Fr Blk Fades to/from black output

Fade From Blk Fades from black output

Fade To Blk Fades to black output

FTB Rate Sets fade-to-black rate in fields between 1 and 999 used by the front panel and automation

Input Ops

Fill-1/Key-1 Selects keyer input from Fill-1/Key-1 rather than store

Fill-2/Key-2 Selects keyer input from Fill-2/Key-2 rather than store

Fill-3/Key-3 Selects keyer input from Fill-3/Key-3 rather than store

Unload Input Sets no external input and unloads any associated store

Store Ops

Load Image Loads a file from the image library into the appropriate store

Set Position Sets the position of an image or animation. Does not adjust graphics from external fill/key.

Save Image Saves the current image with changed settings

Unload Image Unloads the contents of the appropriate store

Load Mode

Clean Load Unloads an existing image before loading new one

Cut Load Existing image remains active until new one is loaded, then a cut occurs, 

Warning: Loading a new image will fail in this mode if the sum of the resident image/animation 
and the new image/animation exceeds the image memory capacity. Use Clean Load mode when 
using such large animations

Start Strap Starts an Easytext crawl loaded into this layer

Stop Strap Stops an Easytext crawl loaded into this layer

Start Timer Starts a Bugclock timer loaded into this layer

Stop Timer Stops a Bugclock timer loaded into this layer

Reset Timer Resets a Bugclock timer loaded into this layer

Play Animation Starts an animation loaded into this layer

Restart Anim Restarts an animation loaded into this layer from the beginning

Stop Animation Stops an animation loaded into this layer when it has completed a loop

Stop Anim Now Stops an animation loaded into this layer immediately

Preview Output

Preview o/p Selects default Preview Output

Program o/p Selects a copy of PGM OUT as the Preview Output

PGM AB Mix Selects output from PGM AB Mixer as the Preview Output

PGM DVE o/p Selects output from the PGM DVE as the Preview Output

PGM DSK1 o/p Selects output from PGM DSK1 as the Preview Output

PGM DSK2 o/p Selects output from PGM DSK2 as the Preview Output

PGM DSK3 o/p Selects output from PGM DSK3 as the Preview Output

Clean Output

Program o/p Selects a copy of PGM OUT as the Clean Feed Output

SDI A Selects a copy of SDI A as the Clean Feed Output

SDI B Selects a copy of SDI B as the Clean Feed Output

SDI C Selects a copy of SDI C as the Clean Feed Output

SDI D Selects a copy of SDI D as the Clean Feed Output

PGM AB Mix Selects a copy of the program AB mix output as the Clean Feed Output

PGM DVE o/p Selects a copy of PGM DVE output as the Clean Feed Output. The output seen with the PGM 
DVE output depends on the current DVE Configuration.

PGM DSK1 o/p Selects output from PGM DSK1 as the Clean Feed Output

PGM DSK2 o/p Selects output from PGM DSK2 as the Clean Feed Output

PGM DSK3 o/p Selects output from PGM DSK3 as the Clean Feed Output

Store 1 Fill Selects a copy of DSK 1 store fill as the Clean Feed Output
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Store 1 Key Selects a copy of DSK 1 store key as the Clean Feed Output

Store 2 Fill Selects a copy of DSK 2 store fill as the Clean Feed Output

Store 2 Key Selects a copy of DSK 2 store key as the Clean Feed Output

Store 3 Fill Selects a copy of DSK 3 store fill as the Clean Feed Output

Store 3 Key Selects a copy of DSK 3 store key as the Clean Feed Output

Store 4 Fill Selects a copy of DSK 4 store fill as the Clean Feed Output

Store 4 Key Selects a copy of DSK 4 store key as the Clean Feed Output

SDI Fill-1 Selects a copy of SDI Fill-1 as the Clean Feed Output

SDI Key-1 Selects a copy of SDI Key-1 as the Clean Feed Output

SDI Fill-2 Selects a copy of SDI Fill-2 as the Clean Feed Output

SDI Key-2 Selects a copy of SDI Key-2 as the Clean Feed Output

Monitor Output

Program o/p Selects a copy of PGM OUT as the Monitor Output

Preview o/p Selects a copy of PVW OUT as the Monitor Output

SDI A Selects a copy of SDI A as the Monitor Output

SDI B Selects a copy of SDI B as the Monitor Output

SDI C Selects a copy of SDI C as the Monitor Output

SDI D Selects a copy of SDI D as the Monitor Output

PGM AB Mix Selects a copy of the program AB mix output as the Monitor Output

PVW AB Mix Selects a copy of the preview AB mix output as the Monitor Output

PGM DVE o/p Selects a copy of PGM DVE output as the Monitor Output. The output seen with the PGM DVE 
output depends on the current DVE Configuration.

PGM DSK1 o/p Selects output from PGM DSK1 as the Monitor Output

PGM DSK2 o/p Selects output from PGM DSK2 as the Monitor Output

PGM DSK3 o/p Selects output from PGM DSK3 as the Monitor Output

Store 1 Fill Selects a copy of DSK 1 store fill as the Monitor Output

Store 1 Key Selects a copy of DSK 1 store key as the Monitor Output

Store 2 Fill Selects a copy of DSK 2 store fill as the Monitor Output

Store 2 Key Selects a copy of DSK 2 store key as the Monitor Output

Store 3 Fill Selects a copy of DSK 3 store fill as the Monitor Output

Store 3 Key Selects a copy of DSK 3 store key as the Monitor Output

Store 4 Fill Selects a copy of DSK 4 store fill as the Monitor Output

Store 4 Key Selects a copy of DSK 4 store key as the Monitor Output

SDI Fill-1 Selects a copy of SDI Fill-1 as the Monitor Output

SDI Key-1 Selects a copy of SDI Key-1 as the Monitor Output

SDI Fill-2 Selects a copy of SDI Fill-2 as the Monitor Output

SDI Key-2 Selects a copy of SDI Key-2 as the Monitor Output

Colour 1 Selects a copy of Color field 1 as the Monitor Output

Colour 2 Selects a copy of Color field 2 as the Monitor Output

Colour 3 Selects a copy of Color field 3 as the Monitor Output

Colour 4 Selects a copy of the V-fade color as the Monitor Output

Pattern 1 Selects a copy of Test Pattern 1 as the Monitor Output

Pattern 2 Selects a copy of Test Pattern 2 as the Monitor Output

PGM DVE1 Selects a copy of program DVE Input 1 as the Monitor Output

PGM DVE2 Selects a copy of program DVE Input 2 as the Monitor Output

PVW DVE1 Selects a copy of preview DVE Input 1 as the Monitor Output

PVW DVE2 Selects a copy of preview DVE Input 2 as the Monitor Output

Audio

AB Mixer

Cut A/B Cuts the audio AB mixer between the A/B inputs

Cut To A Cuts the audio AB mixer to the A input

Cut To B Cuts the audio AB mixer to the B input
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Fade A/B Fades the audio AB mixer between the A/B inputs over its fade duration

Fade To A Fades the audio AB mixer to the A input over its fade duration

Fade To B Fades the audio AB mixer to the B input over its fade duration

Set Rate Selects the fade rate duration for the audio AB mixer used by the front panel and automation

FTS Fader

Toggle Silence Alternatively fades between Program Output and silence

Fade To Sil Fades down the Program Output to silence

Fade From Sil Fades up the Program Output from silence

Set Rate Selects the fade rate duration for the fade-to-silence used by the front panel and automation

Voice-Overs

Voice-Over 1–8 Repeat for voice-overs 1–8

Toggle Vo Fades up/down the voice-over over its fade duration

Fade Up Vo Fades up the voice-over over its fade duration

Fade Down Vo Fades down the voice-over over its fade duration

Set Rate Selects the voice-over fade rate duration used by the front panel and automation

Duck Selects the background audio level attenuation during voice-overs

Preset Selects the level of the voice-over audio 

Gains

Load Preset Loads a gain preset to be used with this voice-over

Save Preset Saves the current gain settings as a new preset

Shuffles

Load Preset Loads a shuffle preset to be used with this voice-over

Save Preset Saves the current shuffle settings as a new preset 

Easyplay

Stream 1–4 Repeats for streams 1–4

Queue 1

Easyplay Load Loads an Easyplay audio clip into the appropriate queue of this stream

Easyplay Start Plays the Easyplay audio clip

Easyply Stop Stops playing the Easyplay audio clip

Eplay Unload Unloads the Easyplay audio clip

Queue 2

Easyplay Load Loads an Easyplay audio clip into the appropriate queue of this stream

Easyplay Start Plays the Easyplay audio clip

Easyply Stop Stops playing the Easyplay audio clip

Eplay Unload Unloads the Easyplay audio clip

Queue 3

Easyplay Load Loads an Easyplay audio clip into the appropriate queue of this stream

Easyplay Start Plays the Easyplay audio clip

Easyply Stop Stops playing the Easyplay audio clip

Eplay Unload Unloads the Easyplay audio clip

Queue 4

Easyplay Load Loads an Easyplay audio clip into the appropriate queue of this stream

Easyplay Start Plays the Easyplay audio clip

Easyply Stop Stops playing the Easyplay audio clip

Eplay Unload Unloads the Easyplay audio clip

Input Mux

Program Select Selects an input for the Audio Input Program Multiplexor

Preset Select Selects an input for the Audio Input Preset Multiplexor

Output Mux

Program Selset Selects an input for the Audio Output Program Multiplexor

Preview Select Selects an input for the Audio Output Preset Multiplexor
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Clean Selset Selects an input for the Audio Output Clean Feed Multiplexor

Monitor Select Selects an input for the Audio Output Monitor Multiplexor

Meter Select Selects an input for the Audio Output Meter Multiplexor

Input Buses

PGM Input

Gains

Load Preset Loads a gain preset for the Audio Input Program Gain

Save Preset Saves a gain preset for the Audio Input Program Gain

Shuffles

Load Preset Loads a shuffle preset for the Audio Input Program Shuffler

Save Preset Saves a shuffle preset for the Audio Input Program Shuffler

PST Input

Gains

Load Preset Loads a gain preset for the Audio Input Preset Gain

Save Preset Saves a gain preset for the Audio Input Preset Gain

Shuffles

Load Preset Loads a shuffle preset for the Audio Input Preset Shuffler

Save Preset Saves a shuffle preset for the Audio Input Preset Shuffler

Output Buses

PGM Output

Gains

Load Preset Loads a gain preset for the Audio Output Program Gain

Save Preset Saves a gain preset for the Audio Output Program Gain

Shuffles

Load Preset Loads a shuffle preset for the Audio Output Program Shuffler

Save Preset Saves a shuffle preset for the Audio Output Program Shuffler

MD Preset

Processor 1 Selects Metadata preset 1 to be loaded into the internal Metadata sources

Processor 2 Selects Metadata preset 2 to be loaded into the internal Metadata sources

Processor 3 Selects Metadata preset 3 to be loaded into the internal Metadata sources

Processor 4 Selects Metadata preset 4 to be loaded into the internal Metadata sources

Legacy Shuffles

A-Input

Channel 1 Select the legacy shuffle mapping for input bunch 1 of the A Input

Channel 2 Select the legacy shuffle mapping for input bunch 2 of the A Input

Channel 3 Select the legacy shuffle mapping for input bunch 3 of the A Input

Channel 4 Select the legacy shuffle mapping for input bunch 4 of the A Input

Voice-Over

Channel 1 Select the legacy shuffle mapping for input bunch 1 of the VO1 Input

Channel 2 Select the legacy shuffle mapping for input bunch 2 of the VO1 Input

Channel 3 Select the legacy shuffle mapping for input bunch 3 of the VO1 Input

Channel 4 Select the legacy shuffle mapping for input bunch 4 of the VO1 Input

B-Input

Channel 1 Select the legacy shuffle mapping for input bunch 1 of the B Input

Channel 2 Select the legacy shuffle mapping for input bunch 2 of the B Input

Channel 3 Select the legacy shuffle mapping for input bunch 3 of the B Input

Channel 4 Select the legacy shuffle mapping for input bunch 4 of the B Input

GPI Output

GPI Out 0 On Sets GPI Output 0 on

GPI Out 0 Off Sets GPI Output 0 off

GPI Out 1 On Sets GPI Output 1 on

GPI Out 1 Off Sets GPI Output 1 off
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GPI Out 2 On Sets GPI Output 2 on

GPI Out 2 Off Sets GPI Output 2 off

GPI Out 3 On Sets GPI Output 3 on

GPI Out 3 Off Sets GPI Output 3 off

GPI Out 4 On Sets GPI Output 4 on

GPI Out 4 Off Sets GPI Output 4 off

GPI Out 5 On Sets GPI Output 5 on

GPI Out 5 Off Sets GPI Output 5 off

GPI Out 6 On Sets GPI Output 6 on

GPI Out 6 Off Sets GPI Output 6 off

GPI Out 7 On Sets GPI Output 7 on

GPI Out 7 Off Sets GPI Output 7 off

GPI Out 8 On Sets GPI Output 8 on

GPI Out 8 Off Sets GPI Output 8 off

GPI Out 9 On Sets GPI Output 9 on

GPI Out 9 Off Sets GPI Output 9 off

GPI Out 10 On Sets GPI Output 10 on

GPI Out 10 Off Sets GPI Output 10 off

GPI Out 11 On Sets GPI Output 11 on

GPI Out 11 Off Sets GPI Output 11 off

GPI Out 12 On Sets GPI Output 12 on

GPI Out 12 Off Sets GPI Output 12 off

GPI Out 13 On Sets GPI Output 13 on

GPI Out 13 Off Sets GPI Output 13 off

GPI Out 14 On Sets GPI Output 14 on

GPI Out 14 Off Sets GPI Output 14 off

GPI Out 15 On Sets GPI Output 15 on

GPI Out 15 Off Sets GPI Output 15 off

Trigger Macro

<macro name> Sub-menus depend on the user-defined macro names. Selecting a macro causes it to be triggered.

Miscellaneous

Emer To Air Switches Emergency-to-Air on

Emer From Air Switches Emergency-to-Air off

EAS On EAS text is cut up to reveal the emergency alert text

EAS Off EAS text is cut down to hide the emergency alert text

Setup

Audio Setup

Audio Metering

Meters 1 – 4 Displays four audio metering channels on the front panel

Meters 5 – 8 Displays four audio metering channels on the front panel

Meters 9 – 12 Displays four audio metering channels on the front panel

Meters 13 – 16 Displays four audio metering channels on the front panel

Meters 17 – 20 Displays four audio metering channels on the front panel

Meters 21 – 24 Displays four audio metering channels on the front panel

Meters 25 – 28 Displays four audio metering channels on the front panel

Meters 29 – 32 Displays four audio metering channels on the front panel

Meters 33 – 36 Displays four audio metering channels on the front panel

Meters 37 – 40 Displays four audio metering channels on the front panel

Meters 41 – 44 Displays four audio metering channels on the front panel

Meters 45 – 48 Displays four audio metering channels on the front panel

Meters 1 & 2 Displays two audio metering channels on the front panel
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Meters 3 & 4 Displays two audio metering channels on the front panel

Meters 5 & 6 Displays two audio metering channels on the front panel

Meters 7 & 8 Displays two audio metering channels on the front panel

Meters 9 & 10 Displays two audio metering channels on the front panel

Meters 11 & 12 Displays two audio metering channels on the front panel

Meters 13 & 14 Displays two audio metering channels on the front panel

Meters 15 & 16 Displays two audio metering channels on the front panel

Meters 17 & 18 Displays two audio metering channels on the front panel

Meters 19 & 20 Displays two audio metering channels on the front panel

Meters 21 & 22 Displays two audio metering channels on the front panel

Meters 23 & 24 Displays two audio metering channels on the front panel

Meters 25 & 26 Displays two audio metering channels on the front panel

Meters 27 & 28 Displays two audio metering channels on the front panel

Meters 29 & 30 Displays two audio metering channels on the front panel

Meters 31 & 32 Displays two audio metering channels on the front panel

Meters 33 & 34 Displays two audio metering channels on the front panel

Meters 35 & 36 Displays two audio metering channels on the front panel

Meters 37 & 38 Displays two audio metering channels on the front panel

Meters 39 & 40 Displays two audio metering channels on the front panel

Meters 41 & 42 Displays two audio metering channels on the front panel

Meters 43 & 44 Displays two audio metering channels on the front panel

Meters 45 & 46 Displays two audio metering channels on the front panel

Meters 47 & 48 Displays two audio metering channels on the front panel

Follow Video

A/B Mix Selects whether the audio A/B mixer follows video A/B mixer. If the video transition type is set 
as V-Fade then the audio will transition through silence at the half way point of the mix.

Fade-To-Black Selects whether audio silence follows video fade-to-black of DSK 4 (the most downstream 
keyer)

Select Mixfile Selects whether the Audio Graph is to be used for the audio engine and if not, which legacy 
mixfile will be used. There is a set of standard (pre-defined) mixfiles that is stored in /etc/mixes. 
Custom mixfiles are stored in /home/mixes. The Imagestore 750 must be restarted for the setting 
to take effect.

Delays

Delay Bank 1 Sets the delay of audio bank 1 

Delay Bank 2 Sets the delay of audio bank 2

Delay Bank 3 Sets the delay of audio bank 3

Delay Bank 4 Sets the delay of audio bank 4

Delay Bank 5 Sets the delay of audio bank 5

Delay Bank 6 Sets the delay of audio bank 6

Easyplay

Stream 1–4 Repeats for streams 1–4

Play Follow Mode

Off No association between Easyplay and any video layer or voice-over. The Easyplay stream is 
driven independently by automation.

PGM Keyers Easyplay follows video layer cuts/fades, loads/unloads from PGM keyers

PST Keyers Easyplay follows video layer cuts/fades, loads/unloads from PST keyers

Assoc VO Queue 1 Easyplay queue follows the position of the associated voice-over. Playing the Easyplay stream 
will not drive the voice-over if this mode is selected

Assoc VO Queue 2 See “Assoc VO Queue 1” (above)

Assoc VO Queue 3 See “Assoc VO Queue 1” (above)

Assoc VO Queue 4 See “Assoc VO Queue 1” (above)

Load Follow Mode

Off Easyplay stream queues are loaded explicitly
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PGM Keyers Easyplay stream queues are loaded automatically following store loads of video media files. This 
is done by filename association

Assoc Voiceover

No Association No association between this Easyplay stream and any voice-over

Voiceover 1 PGM Association between this Easyplay stream and PGM voice-over 1

Voiceover 1 PST Association between this Easyplay stream and PST voice-over 1

Voiceover 2 PGM Association between this Easyplay stream and PGM voice-over 2

Voiceover 2 PST Association between this Easyplay stream and PST voice-over 2

Voiceover 3 PGM Association between this Easyplay stream and PGM voice-over 3

Voiceover 3 PST Association between this Easyplay stream and PST voice-over 3

Voiceover 4 PGM Association between this Easyplay stream and PGM voice-over 4

Voiceover 4 PST Association between this Easyplay stream and PST voice-over 4

Voiceover 5 PGM Association between this Easyplay stream and PGM voice-over 5

Voiceover 5 PST Association between this Easyplay stream and PST voice-over 5

Voiceover 6 PGM Association between this Easyplay stream and PGM voice-over 6

Voiceover 6 PST Association between this Easyplay stream and PST voice-over 6

Voiceover 7 PGM Association between this Easyplay stream and PGM voice-over 7

Voiceover 7 PST Association between this Easyplay stream and PST voice-over 7

Voiceover 8 PGM Association between this Easyplay stream and PGM voice-over 8

Voiceover 8 PST Association between this Easyplay stream and PST voice-over 8

Network

Hostname Sets the Hostname on the network

IP Address Sets the IP Address on the network

Network Mask Sets the Network Mask on the network. The mask number is set for Class B addresses and should 
only modified in consultation with your IT department.

Gateway Add Sets the Gateway Server on the network. The factory default option is disabled and should only 
modified in consultation with your IT department.

NTP Server Sets the Network Time Protocol server IP Address on the network. This option allows the clock 
in the Imagestore 750 to be set from a Network Time Protocol server located on the network. The 
clock is checked once every 1024 seconds; however if the clocks are seen to be drifting then the 
update period will be automatically reduced to a minimum of 64 seconds.

NIC Bonding Sets whether the NIC is “Bonded” or “Independent”. Independent NIC allows a separate IP 
addresses for automation and media.

2nd IP Address Sets the secondary IP Address used for media, if the NIC is set as “independent”

2nd Net Mask Sets the secondary Network Mask used for media, if the NIC is set as “independent”

2nd Gateway Sets the secondary Gateway Server used for media, if the NIC is set as “independent”

Logging

Logging Level

Errors Only Selects a logging level where only errors are listed in log files

Media/Keying Selects a logging level where only errors, media operations and keyer transitions are listed in log 
files

Verbose Selects a logging level where errors and all valid automation commands are listed in log files

Verbose+Oxsox Selects a logging level where errors, all valid automation commands and all OxSox commands 
are listed in log files

Logging Server Selects a server to be used for logging if required

Local Logging

Disabled Switches local logging on the unit itself off

Enabled Switches local logging on the unit itself on

GPI

GPI Inputs

GPI In 0 On Defines macro to action when GPI IN 0 switches on

GPI In 0 Of Defines macro to action when GPI IN 0 switches off

GPI In 1 On Defines macro to action when GPI IN 1 switches on
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GPI In 1 Off Defines macro to action when GPI IN 1 switches off

GPI In 2 On Defines macro to action when GPI IN 2 switches on

GPI In 2 Off Defines macro to action when GPI IN 2 switches off

GPI In 3 On Defines macro to action when GPI IN 3 switches on

GPI In 3 Off Defines macro to action when GPI IN 3 switches off

GPI In 4 On Defines macro to action when GPI IN 4 switches on

GPI In 4 Off Defines macro to action when GPI IN 4 switches off

GPI In 5 On Defines macro to action when GPI IN 5 switches on

GPI In 5 Off Defines macro to action when GPI IN 5 switches off

GPI In 6 On Defines macro to action when GPI IN 6 switches on

GPI In 6 Off Defines macro to action when GPI IN 6 switches off

GPI In 7 On Defines macro to action when GPI IN 7 switches on

GPI In 7 Off Defines macro to action when GPI IN 7 switches off

GPI In 8 On Defines macro to action when GPI IN 8 switches on

GPI In 8 Of Defines macro to action when GPI IN 8 switches off

GPI In 9 On Defines macro to action when GPI IN 9 switches on

GPI In 9 Off Defines macro to action when GPI IN 9 switches off

GPI In 10 On Defines macro to action when GPI IN 10 switches on

GPI In 10 Off Defines macro to action when GPI IN 10 switches off

GPI In 11 On Defines macro to action when GPI IN 11 switches on

GPI In 11 Off Defines macro to action when GPI IN 11 switches off

GPI In 12 On Defines macro to action when GPI IN 12 switches on

GPI In 12 Off Defines macro to action when GPI IN 12 switches off

GPI In 13 On Defines macro to action when GPI IN 13 switches on

GPI In 13 Off Defines macro to action when GPI IN 13 switches off

GPI In 14 On Defines macro to action when GPI IN 14 switches on

GPI In 14 Off Defines macro to action when GPI IN 14 switches off

GPI In 15 On Defines macro to action when GPI IN 15 switches on

GPI In 15 Off Defines macro to action when GPI IN 15 switches off

GPI Outputs

GPI Out 0 On Selects an event that will trigger GPI OUT 0 to switch on

GPI Out 0 Off Selects an event that will trigger GPI OUT 0 to switch off

GPI Out 1 On Selects an event that will trigger GPI OUT 1 to switch on

GPI Out 1 Off Selects an event that will trigger GPI OUT 1 to switch off

GPI Out 2 On Selects an event that will trigger GPI OUT 2 to switch on

GPI Out 2 Off Selects an event that will trigger GPI OUT 2 to switch off

GPI Out 3 On Selects an event that will trigger GPI OUT 3 to switch on

GPI Out 3 Off Selects an event that will trigger GPI OUT 3 to switch off

GPI Out 4 On Selects an event that will trigger GPI OUT 4 to switch on

GPI Out 4 Off Selects an event that will trigger GPI OUT 4 to switch off

GPI Out 5 On Selects an event that will trigger GPI OUT 5 to switch on

GPI Out 5 Off Selects an event that will trigger GPI OUT 5 to switch off

GPI Out 6 On Selects an event that will trigger GPI OUT 6 to switch on

GPI Out 6 Off Selects an event that will trigger GPI OUT 6 to switch off

GPI Out 7 On Selects an event that will trigger GPI OUT 7 to switch on

GPI Out 7 Off Selects an event that will trigger GPI OUT 7 to switch off

GPI Out 8On Selects an event that will trigger GPI OUT 8 to switch on

GPI Out 8 Off Selects an event that will trigger GPI OUT 8 to switch off

GPI Out 9 On Selects an event that will trigger GPI OUT 9 to switch on

GPI Out 9 Off Selects an event that will trigger GPI OUT 9 to switch off

GPI Out 10 On Selects an event that will trigger GPI OUT 10 to switch on

GPI Out 10 Off Selects an event that will trigger GPI OUT 10 to switch off
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GPI Out 11 On Selects an event that will trigger GPI OUT 11 to switch on

GPI Out 11 Off Selects an event that will trigger GPI OUT 11 to switch off

GPI Out 12 On Selects an event that will trigger GPI OUT 12 to switch on

GPI Out 12 Off Selects an event that will trigger GPI OUT 12 to switch off

GPI Out 13 On Selects an event that will trigger GPI OUT 13 to switch on

GPI Out 13 Off Selects an event that will trigger GPI OUT 13 to switch off

GPI Out 14 On Selects an event that will trigger GPI OUT 14 to switch on

GPI Out 14 Off Selects an event that will trigger GPI OUT 14 to switch off

GPI Out 15 On Selects an event that will trigger GPI OUT 15 to switch on

GPI Out 15 Off Selects an event that will trigger GPI_OUT_15ccccc to switch off

Show GPI IPs Shows current state of GPI inputs/output pins

Timecode

Timecode Source

LTC Selects LTC as the timeout source

VITC Selects VITC as the timeout source

Timecde Status “LTC” or “VITC” if valid timecode is present; otherwise “BAD-Internl”

“DF” for dropframe; “ND” for no dropframe

“Fwd” or “Bwd” shows LTC direction

Timecde Time “Ext” if valid external time code; “Int” if using internal clock. Timecode time is then shown.

Date/Time

Date Sets the date (internal Real Time Clock date only). Preserved until next restart

Time Sets the time (internal Real Time Clock time only). Preserved until next restart

Time Zone Sets the time zone from GMT (+/-)

Serial Comms

Serial Ports

COM 1

Baud Rate Sets Baud rate for COM 1 (1200, 9600, 19200, 38400, 57600, 115200)

Protocol Sets protocol for COM 1 (Oxtel Automation, Oxtel Slave, Presmaster Automation, ENDEC 
1882, TFT EAS 911T, RCP Classic, ST61XX Thermometer)

Serial Type Sets serial type for COM 1 (RS-232, RS-422)

COM 2

Baud Rate See “COM 1” (above)

Protocol See “COM 1” (above)

Serial Type See “COM 1” (above)

COM 3

Baud Rate See “COM 1” (above)

Protocol See “COM 1” (above)

Serial Type See “COM 1” (above)

COM 4

Baud Rate See “COM 1” (above)

Protocol See “COM 1” (above)

Serial Type See “COM 1” (above)

RS232 A

Baud Rate Reserved for future use

Protocol Reserved for future use

Serial Type Reserved for future use

RS232 B

Baud Rate Reserved for future use

Protocol Reserved for future use

Serial Type Reserved for future use
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Serial Level

Strict Enforces strict serial communications from automation. The STX must always alternate between 
STX0 and STX1. If no ACK is received the message must be sent again with the same type of 
STX.

Relaxed Allows relaxed serial communications from automation. The STX does not need to alternate 
between STX0 and STX1. Either value is always valid.

Video Standard

625 Line Selects 625i / 50 as the next video standard

525 Line Selects 525i / 59.94 as the next video standard

1080i/59.94 Selects 1080i / 59.94 as the next video standard

1080i/50 Selects 1080i / 50 as the next video standard

720p/59.94 Selects 720p / 59.94 as the next video standard

720p/50 Selects 720p / 50 as the next video standard

Reference

Offset

Lines/Samples Sets the Output Reference Offset in Lines and Samples

Lines/us Sets the Output Reference Offset in Lines and microseconds (μs)

Stores

Stores Memory Sets the memory allocation for each available store. The system will need to be restarted for a 
new store allocation to take effect.

Video Delay

PGM Input Program input (post-A/B mix) delay in frames. Select 1 frame of delay when using a DVE in 
interlaced video standards and 2 frames of delay when using DVE in progressive video 
standards. When bypassing an external graphics device (such as Intuition XG) add further frames 
to compensate for the delay through this device.

PVW Input Preview input (post-A/B mix) delay in frames. See “PGM Input” (above)

PGM Output Program output delay in frames.

PVW Output Preview output delay in frames.

CLF Output Clean feed output delay in frames.

Slave

Keyer Assign

None Disables automatic keyer management

DSK 1 Assigns DSK 1 for automatic keyer management

DSK 2 Assigns DSK 2 for automatic keyer management

DSK 3 Assigns DSK 3 for automatic keyer management

DSK 4 Assigns DSK 4 for automatic keyer management

Keyer Follow Up

Disabled The assigned keyer cut-up does not follow slave layer activity

Enabled The assigned keyer cut-up follows the overall slave layers, so that the assigned keyer is cut up 
when one or more slave layers have been cut or faded up.

Keyer Follow Down

Disabled The assigned keyer cut-down does not follow slave layer activity

Enabled The assigned keyer cut-down follows the overall slave layers, so that the assigned keyer is cut 
down when all slave layers have been cut or faded down.

Keyer Status

Keyer Status Displays Co-Processor layers for automatic keyer management

Fill&Key Input

Fill-1/Key-1 Routes Fill-1/Key-1 inputs to the assigned keyer during automatic keyer management.

Fill-2/Key-2 Routes Fill-2/Key-2 inputs to the assigned keyer during automatic keyer management.

Fill-3/Key-3 Routes Fill-3/Key-3 inputs to the assigned keyer during automatic keyer management.

Slave Address The slave IP address to use for command forwarding (if enabled) and media information. This is 
an alternative to command forwarding using a COM port.

Network Forward
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Disabled Disables slave command forwarding via the slave IP address.

Enabled Enables slave command forwarding via the slave IP address.

Slave type

Int-XG Dictates how store load/cue information is interpreted by the Imagestore 750

Not Int-XG Dictates how store load/cue information is interpreted by the Imagestore 750

Miscellaneous

Closed Cap

Disabled Allows keyed graphics to overwrite Closed Caption information in the active picture for NTSC

Enabled Preserves Closed Caption information in active picture for NTSC

Send Wakeup Sends a wake-up packet to all Oxtel protocol connections

File Ops The File operations are used for basic library management via USB. Network transfer will often 
be preferred for management of image and sound files.

Load Image Loads all .oxt or .oxa images from the inserted USB media to the hard disk image library.

Erase Image Erases an image from hard storage

Load Audio Loads all .oxe, .oxw, or .wav sound files from the inserted USB media to the hard disk sound 
library.

Erase Audio Erases a sound file from hard storage

Conf To USB Saves the active configuration file (config.xml) and GPI setup file (gpi.xml) to the inserted USB 
media. 

Conf From USB Copies a new configuration file (config.xml) and GPI setup file (gpi.xml) from the inserted USB 
media. If a configuration file is successfully copied from USB, then a restart is advised. 

Diags Save Copies the diagnostics file to the loaded media, including the log file from the current session 
(messages) and log file from the previous session (messages.old)

Load Licences Copies new licence codes (syscodes.txt) from the inserted USB device, which enable software 
options on the Imagestore 750 after a restart.

Load Mixfile Copies all .mix custom mixfiles from the inserted USB media to the hard disk mixfile library.

Erase Mixfile Erases a custom mixfile from hard disk.

Active Preview

Disabled Switches off active preview mode for Presmaster

Enabled Switches on active preview mode for Xpanel, Branding RCP or iMC panels

Self Tests

DSK 1

Image Border Displays a test pattern showing 4-pixel width colored borders

Animation Fill Loads a test animation and then runs the animation. Shows a continuously repeating progress 
bar, and is used to verify correct installation of the store memory modules. Unload the self test 
animation after completing the test.

DSK 2

Image Border See “DSK 1” above

Animation Fill See “DSK 1” above

DSK 3

Image Border See “DSK 1” above

Animation Fill See “DSK 1” above

DSK 4

Image Border See “DSK 1” above

Animation Fill See “DSK 1” above

EAS

Severity 1 Displays an EAS scrolling banner displaying ‘A Primary Entry Point System has issued an 
Emergency Action Notification for the United States beginning at 1:27 pm and ending at 2:27 
pm (IMST)’ at severity level 1

Severity 2 Displays an EAS scrolling banner displaying ‘The Civil Authorities have issued a Severe 
Thunderstorm Watch for San Francisco, CA beginning at 1:31 pm and ending at 2:31 pm 
(IMST)’ at severity level 2

Severity 3 Displays an EAS displaying ‘A Broadcast station or cable system has issued a Required Weekly 
Test for Snohomish, WA beginning at 1:26 pm and ending at 2:26 pm (IMST) at severity level 3
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Prod Tests Enters Production Mode in which all functions of the Imagestore 750 halt. Warning: this must 
NOT be used when the output is live on air. The production tests are not recommended for 
general use; they are for hardware diagnosis only.

Soft Restart Causes the software to restart. Use this, for example, after changing a setting that requests a 
restart (e.g. video standard). The system settings are restored after the restart depending on the 
Active Configuration

Hard Restart Causes the hardware to reboot. A hard restart takes longer than a soft restart. The system settings 
are restored after the restart depending on the Active Configuration

Factory Reset Resets the unit to the factory default configuration. Use this option with extreme care as all 
custom set parameters will be removed.

Safe Shutdown Prepares the unit to be powered off. Use this command before removing power cables.

Test

Test Pattern

Off Switches off the test pattern signal for PGM OUT and PVW OUT

On Switches on the test pattern signal for PGM OUT and PVW OUT

Config Alarms

Ext Reference

Unlocked

Alarm Level Sets alarm level for ‘External Reference Unlocked’

Trap Enable Enables or disables the trap for this alarm

Mismatch

Alarm Level Sets alarm level for ‘External Reference Mismatch’

Trap Enable Enables or disables the trap for this alarm

A

Video Loss

Alarm Level Sets alarm level for ‘SDI A Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘SDI A Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘SDI A Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

B

Video Loss

Alarm Level Sets alarm level for ‘SDI B Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘SDI B Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘SDI B Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

C

Video Loss

Alarm Level Sets alarm level for ‘SDI C Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘SDI C Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘SDI C Video Input Timing’

Trap Enable Enables or disables the trap for this alarm
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 Video Loss

Alarm Level Sets alarm level for ‘SDI D Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘SDI D Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘SDI D Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

Fill-1

Video Loss

Alarm Level Sets alarm level for ‘Fill-1 Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘Fill-1 Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘Fill-1 Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

Key-1

 Video Loss

Alarm Level Sets alarm level for ‘Key-1 Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘Key-1 Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘Key-1 Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

Fill-2

Video Loss

Alarm Level Sets alarm level for ‘Fill-2 Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘Fill-2 Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘Fill-2 Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

Key-2

Video Loss

Alarm Level Sets alarm level for ‘Key-2 Video Loss’

Trap Enable Enables or disables the trap for this alarm

Video Mismatch

Alarm Level Sets alarm level for ‘Key-2 Video Mismatch’

Trap Enable Enables or disables the trap for this alarm

Input Timing

Alarm Level Sets alarm level for ‘Key-2 Video Input Timing’

Trap Enable Enables or disables the trap for this alarm

Overall Timing
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Alarm Level Sets alarm level for overall input timing

Trap Enable Enables or disables the trap for this alarm

Embed Audio Ip

Audio Feed 1

Channel 1–16 Repeats for channels 1–16

Type Change

Alarm Level Sets alarm level for audio type change on this embedded audio feed and channel

Expected Type Sets the expected audio type on this embedded audio feed and channel as PCM or Non-PCM

Trap Enable Enables or disables the trap for this alarm

Audio Loss

Alarm Level Sets alarm level for audio loss on this embedded audio feed and channel

Trap Enable Enables or disables the trap for this alarm

Audio Feed 2

Channel 1–16 Repeats for channels 1–16

Type Change

Alarm Level Sets alarm level for audio type change on this embedded audio feed and channel

Expected Type Sets the expected audio type on this embedded audio feed and channel as PCM or Non-PCM

Trap Enable Enables or disables the trap for this alarm

Audio Loss

Alarm Level Sets alarm level for audio loss on this embedded audio feed and channel

Trap Enable Enables or disables the trap for this alarm

Audio Feed 3

Channel 1–16 Repeats for channels 1–16

Type Change

Alarm Level Sets alarm level for audio type change on this embedded audio feed and channel

Expected Type Sets the expected audio type on this embedded audio feed and channel as PCM or Non-PCM

Trap Enable Enables or disables the trap for this alarm

Audio Loss

Alarm Level Sets alarm level for audio loss on this embedded audio feed and channel

Trap Enable Enables or disables the trap for this alarm

Audio Feed 4

Channel 1–16 Repeats for channels 1–16

Type Change

Alarm Level Sets alarm level for audio type change on this embedded audio feed and channel

Expected Type Sets the expected audio type on this embedded audio feed and channel as PCM or Non-PCM

Trap Enable Enables or disables the trap for this alarm

Audio Loss

Alarm Level Sets alarm level for audio loss on this embedded audio feed and channel

Trap Enable Enables or disables the trap for this alarm

AES Audio Ip

Pair 1–16 Repeats for pairs 1–16

Channel 1

Type Change

Alarm Level Sets alarm level for audio type change on this embedded audio feed and channel

Expected Type Sets the expected audio type on this embedded audio feed and channel as PCM or Non-PCM

Trap Enable Enables or disables the trap for this alarm

Audio Loss

Alarm Level Sets alarm level for audio loss on this embedded audio feed and channel

Trap Enable Enables or disables the trap for this alarm

Channel 2

Type Change

Alarm Level Sets alarm level for audio type change on this embedded audio feed and channel
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Expected Type Sets the expected audio type on this embedded audio feed and channel as PCM or Non-PCM

Trap Enable Enables or disables the trap for this alarm

Audio Loss

Alarm Level Sets alarm level for audio loss on this embedded audio feed and channel

Trap Enable Enables or disables the trap for this alarm

Temp Fail

Alarm Level Sets alarm level for temperature failure

Trap Enable Enables or disables the trap for this alarm

Voltage Fail

Alarm Level Sets alarm level for voltage failure

Trap Enable Enables or disables the trap for this alarm

PSU A

PSU Fail

Alarm Level Sets alarm level for power supply A failure

Trap Enable Enables or disables the trap for this alarm

PSU B

PSU Fail

Alarm Level Sets alarm level for power supply B failure

Trap Enable Enables or disables the trap for this alarm

Fan Fail

Alarm Level Sets alarm level for fan failure

Trap Enable Enables or disables the trap for this alarm

Slave Connection

Alarm Level Sets alarm level for slave connection failure

Trap Enable Enables or disables the trap for this alarm

Router Connection

Alarm Level Sets alarm level for router connection failure

Trap Enable Enables or disables the trap for this alarm

Network Link

Alarm Level Sets alarm level for network link failure

Trap Enable Enables or disables the trap for this alarm

Disk Usage

Alarm Level Sets alarm level for high disk usage

Trap Enable Enables or disables the trap for this alarm

Video FTB

Alarm Level Sets alarm level for most downstream keyer FTB

Trap Enable Enables or disables the trap for this alarm

Audio FTS

Alarm Level Sets alarm level for audio FTS

Trap Enable Enables or disables the trap for this alarm

GPIO

Line 0–15 Repeats for lines 0–15

Direction Change

Alarm Level Sets alarm level for GPIO line direction change

Trap Enable Enables or disables the trap for this alarm

Status Change

Alarm Level Sets alarm level for GPIO line status change

Trap Enable Enables or disables the trap for this alarm

User Presets

Import Imports a configuration file (requires restart)

Export Exports the active configuration
235



Page Intentionally blank

Last Shows the name of the last configuration file that was imported

Erase Erases a configuration file

Options Displays the enabled options

Version Displays the software version
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GPI Event Types
Appendix B lists GPI event types.

GPI Output Event Description

> None < No event is selected

Ext Ref Unlocked External reference is unlocked

Ext Ref Locked External reference is locked

Ext Ref Mismatch External reference mismatch with output video standard

Ext Ref Match External reference matches output video standard

A Video Loss SDI A video loss

A Video Present SDI A video present

A Video Mismatch SDI A video mismatch with output video standard

A Video Match SDI A video matches output video standard

A Video Timing Out Of Range SDI A timing is out of range (< –1 line with respect to PGM 
OUT)

A Video Timing In Range SDI A timing is within range

B Video Loss SDI B video loss

B Video Present SDI B video present

B Video Mismatch SDI B video mismatch with output video standard

B Video Match SDI B video matches output video standard

B Video Timing Out Of Range SDI B timing is out of range (< –1 line with respect to PGM 
OUT)

B Video Timing In Range SDI B timing is within range

C Video Loss SDI C video loss

C Video Present SDI C video present

C Video Mismatch SDI C video mismatch with output video standard

C Video Match SDI C video matches output video standard

C Video Timing Out Of Range SDI C timing is out of range (< –1 line with respect to PGM 
OUT)

C Video Timing In Range SDI C timing is within range

D Video Loss SDI D video loss

D Video Present SDI D video present

D Video Mismatch SDI D video mismatch with output video standard

D Video Match SDI D video matches output video standard

D Video Timing Out Of Range SDI D timing is out of range (< –1 line with respect to PGM 
OUT)

D Video Timing In Range SDI D timing is within range
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Fill-1 Video Loss SDI Fill 1 video loss

Fill-1 Video Present SDI Fill 1 video present

Fill-1 Video Mismatch SDI Fill 1 video mismatch with output video standard

Fill-1 Video Match SDI Fill 1 video matches output video standard

Fill-1 Video Timing Out Of Range SDI Fill 1 timing is out of range (< –1 line with respect to 
PGM OUT)

Fill-1 Video Timing In Range SDI Fill 1 timing is within range

Key-1 Video Loss SDI Key 1 video loss

Key-1 Video Present SDI Key 1 video present

Key-1 Video Mismatch SDI Key 1 video mismatch with output video standard

Key-1 Video Match SDI Key 1 video matches output video standard

Key-1 Video Timing Out Of Range SDI Key 1 timing is out of range (< –1 line with respect to 
PGM OUT)

Key-1 Video Timing In Range SDI Key 1 timing is within range

Fill-2 Video Loss SDI Fill 2 video loss

Fill-2 Video Present SDI Fill 2 video present

Fill-2 Video Mismatch SDI Fill 2 video mismatch with output video standard

Fill-2 Video Match SDI Fill 2 video matches output video standard

Fill-2 Video Timing Out Of Range SDI Fill 2 timing is out of range (< –1 line with respect to 
PGM OUT)

Fill-2 Video Timing In Range SDI Fill 2 timing is within range

Key-2 Video Loss SDI Key 2 video loss

Key-2 Video Present SDI Key 2 video present

Key-2 Video Mismatch SDI Key 2 video mismatch with output video standard

Key-2 Video Match SDI Key 2 video matches output video standard

Key-2 Video Timing Out Of Range SDI Key 2 timing is out of range (< –1 line with respect to 
PGM OUT)

Key-2 Video Timing In Range SDI Key 2 timing is within range

Overall Video Timing Out Of Range At least one of the “Video Timing Out Of Range” values is 
true 

Overall Video Timing In Range None of the “Video Timing Out Of Range” values is true

Temperature Failure FPGA temperature Š 80°C

Temperature OK FPGA temperature < 80°C

Voltage Failure At least one of the voltages supplies are out of range

Voltage OK All voltages are within range

PSU A Failure Power supply A has failed

PSU A OK Power supply A has not failed

PSU B Failure Power supply B has failed

PSU B OK Power supply B has not failed

Fans Failure At least one of the fan speeds is out of range
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Fans OK All fan speeds are within range

Slave Connection Missing Slave connection is missing

Slave Connection OK Slave connection is OK

Router Connection Missing Router connection is missing

Router Connection OK Router connection is OK

Network Interface Down The network interface is down

Network Interface Up The network interface is up

Disk Usage High Disk capacity Š 80%

Disk Usage OK Disk capacity < 80%

Mixer At A AB Mixer is at A

Mixer At B AB Mixer is at B

DSK1 FTB Off DSK1 Fade-to-Black is Off

DSK1 FTB On DSK1 Fade-to-Black is On

DSK2 FTB Off DSK2 Fade-to-Black is Off

DSK2 FTB On DSK2 Fade-to-Black is On

DSK3 FTB Off DSK3 Fade-to-Black is Off

DSK3 Fey On DSK3 Fade-to-Black is On

DSK4 Fey Off DSK4 Fade-to-Black is Off

DSK4 Fey On DSK4 Fade-to-Black is On

DSK1 Key Off DSK1 Keyer is Off

DSK1 Key On DSK1 Keyer is On

DSK2 Key Off DSK2 Keyer is Off

DSK2 Key On DSK2 Keyer is On

DSK3 Key Off DSK3 Keyer is Off

DSK3 Key On DSK3 Keyer is On

DSK4 Key Off DSK4 Keyer is Off

DSK4 Key On DSK4 Keyer is On

DSK1 Tmr 0 DSK1 Bugclock is at zero

DSK1 Tmr Non 0 DSK1 Bugclock is not at zero

DSK2 Tmr 0 DSK2 Bugclock is at zero

DSK2 Tmr Non 0 DSK2 Bugclock is not at zero

DSK3 Tmr 0 DSK3 Bugclock is at zero

DSK3 Tmr Non 0 DSK3 Bugclock is not at zero

DSK4 Tmr 0 DSK4 Bugclock is at zero

DSK4 Tmr Non 0 DSK4 Bugclock is not at zero

DSK1 Img Busy DSK1 image load is incomplete

DSK1 Img Ready DSK1 image load is complete

DSK2 Img Busy DSK2 image load is incomplete

DSK2 Img Ready DSK2 image load is complete
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DSK3 Img Busy DSK3 image load is incomplete

DSK3 Img Ready DSK3 image load is complete

DSK4 Img Busy DSK4 image load is incomplete

DSK4 Img Ready DSK4 image load is complete

DVE (PGM) Enabled DVE (PGM) is enabled

DVE (PGM) Disabled DVE (PGM) is disabled

DVE (PGM) Run DVE (PGM) is running

DVE (PGM) Stop DVE (PGM) is stopped

DVE (PVW) Enabled DVE (PVW) is enabled

DVE (PVW) Disabled DVE (PVW) is disabled

DVE (PVW) Run DVE (PVW) is running

DVE (PVW) Stop DVE (PVW) is stopped

EAS Running Emergency Alert System (EAS) text strap is running

EAS Stopped Emergency Alert System (EAS) text strap is stopped

Audio AB At A Audio A/B Mixer is at A

Audio AB At B Audio A/B Mixer is at B

Follow AB Off Audio A/B mix follows video A/B mix is off

Follow AB On Audio A/B mix follows video A/B mix is on

Audio FTS Off Audio silence is off

Audio FTS On Audio silence is on

VO1 Begin Off Voice-over 1 starting to fade off

VO1 Begin On Voice-over 1 starting to fade on

VO2 Begin Off Voice-over 2 starting to fade off

VO2 Begin On Voice-over 2 starting to fade on

VO1 At Off Voice-over 1 completed fade off

VO1 At On Voice-over 1 completed fade on

VO2 At Off Voice-over 2 completed fade off

VO2 At On Voice-over 2 completed fade on

Follow FTB Off Audio silence follows video fade-to-black is off

Follow FTB On Audio silence follows video fade-to-black is on

Embed Audio Loss Feed 1 Channel 1 Loss of embedded audio on this feed and channel 

Embed Audio Present Feed 1 Channel 1 Presence of embedded audio on this feed and channel 

… Repeat for Feed 1 Channels 2 to 16

Embed Audio Loss Feed 2 Channel 1 Loss of embedded audio on this feed and channel 

Embed Audio Present Feed 2 Channel 1 Presence of embedded audio on this feed and channel 

… Repeat for Feed 2 Channels 2 to 16

Embed Audio Loss Feed 3 Channel 1 Loss of embedded audio on this feed and channel 

Embed Audio Present Feed 3 Channel 1 Presence of embedded audio on this feed and channel 

… Repeat for Feed 3 Channels 2 to 16
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Embed Audio Loss Feed 4 Channel 1 Loss of embedded audio on this feed and channel 

Embed Audio Present Feed 4 Channel 1 Presence of embedded audio on this feed and channel 

 … Repeat for Feed 4 Channels 2 to 16

Embed Audio Unexpected Type Feed 1 Channel 1 Unexpected audio type on this embedded feed and chan-
nel

Embed Audio Expected Type Feed 1 Channel 1 Expected audio type on this embedded feed and channel

… Repeat for Feed 1 Channels 2 to 16

Embed Audio Unexpected Type Feed 2 Channel 1 Unexpected audio type on this embedded feed and chan-
nel

Embed Audio Expected Type Feed 2 Channel 1 Expected audio type on this embedded feed and channel

… Repeat for Feed 2 Channels 2 to 16

Embed Audio Unexpected Type Feed 3 Channel 1 Unexpected audio type on this embedded feed and chan-
nel

Embed Audio Expected Type Feed 3 Channel 1 Expected audio type on this embedded feed and channel

… Repeat for Feed 3 Channels 2 to 16

Embed Audio Unexpected Type Feed 4 Channel 1 Unexpected audio type on this embedded feed and chan-
nel

Embed Audio Expected Type Feed 4 Channel 1 Expected audio type on this embedded feed and channel

… Repeat for Feed 4 Channels 2 to 16

AES Audio Loss Pair 1 Channel 1 Loss of AES audio on this pair and channel 1

AES Audio Present Pair 1 Channel 1 Presence of AES audio on this pair and channel 1

AES Audio Loss Pair 1 Channel 2 Loss of AES audio on this pair and channel 2

AES Audio Present Pair 1 Channel 2 Presence of AES audio on this pair and channel 2

… Repeat for AES pairs 2 to 16

AES Audio Unexpected Type Pair 1 Channel 1 Unexpected audio type on this AES pair and channel 1

AES Audio Expected Type Pair 1 Channel 1 Expected audio type on this AES pair and channel 1

AES Audio Unexpected Type Pair 1 Channel 2 Unexpected audio type on this AES pair and channel 2

AES Audio Expected Type Pair 1 Channel 2 Expected audio type on this AES pair and channel 2

… Repeat for AES pairs 2 to 16
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Imagestore 750 Hardware Revisions
Appendix C makes a brief statement about Imagestore 750 versions.

The Imagestore 750 hardware platform underwent a hardware maintenance revision at the end 
of September 2011. 

The internal CPU module was replaced with a more modern one; although the form, fit, and 
function of the Imagestore 750 are unchanged and there are no new product features (since 
version 4.1).

Such revisions of the Imagestore 750 are designated “IS-750 R2”, which is evident on the user 
front panel and on the serial number plate (on the side of the Imagestore 750, at the rear).

The IS-750 R2 units require software release 4.2.1, or later revisions, to operate. This software will 
work on both IS-750 R2 and earlier Imagestore 750s.

Warning: Do not down-grade IS-750 R2 units to software earlier than 4.2.1. 
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Glossary 
ADC Analog-to-digital converter

AES Audio Engineering Society

CGT Clip, gain, and transparency

DAC Digital-to-analog converter

DSK Downstream keyer (as opposed to an upstream keyer)

EAS Emergency Alert System

EBU European Broadcasting Union

FIFO First in, first out (usually refers to a data buffer)

FTB Fade to black

Gb/s Gigabits per second (109 bits per second)

GHz Gigahertz (109 cycles per second)

GPI General-purpose interface 

HD-SDI High-definition serial digital interface (SMPTE 292M)

HDTV High-definition television

Hz Hertz (cycles per second)

JPEG Joint Photographic Experts Group

kbps kilobits per second (103 bits per second)

kHz kilohertz (103 cycles per second)

LTC Linear (longitudinal) time code

Mb/s Megabits per second (106 bits per second)

MHz Megahertz (106 cycles per second)

mV Millivolt (10–3 volt)

NTSC National Television Standards Committee; color TV system used in the USA, Canada, Mexico and 
Japan

PAL Phase Alternate Line

PCB Printed circuit board

PGM Program (bus)

PLL Phase-locked loop

PST Preset (bus)

PVW Preview (bus)

RCP Remote control panel

RS-422,  
RS-232

Two serial data communication standards 
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SDI Serial digital interface

SD-SDI Standard-definition serial digital interface

SMPTE Society of Motion Picture and Television Engineers

SPL Sound pressure level

TARGA An image file format developed by Truevision Inc.

VITC Vertical-interval time code
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Contact Us
Miranda Technical Support
For technical assistance, please contact the Miranda Technical Support center nearest you:

Corporate Head Office
Miranda Technologies Inc.
3499 Douglas-B.-Floreani, St-Laurent, Quebec, Canada  H4S 2C6
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
Web: www.miranda.com

Americas
Office hours: 9:00 a.m. – 9:00 p.m. (EST)
Telephone: 1-800-224-7882
Fax: +1 514 335 1614
E-mail: support@miranda.com

Asia
Office hours: 9:00 a.m. – 5:00 p.m. (GMT+8)
Telephone: +852 2539 6987
Fax: +852 2539 0804
E-mail: asiatech@miranda.com

Europe, Middle East, Africa, UK
Office hours: 9:00 a.m. – 6:00 p.m. (GMT)
Telephone: +44 118 952 3444
Fax: +44 118 952 3401
E-mail: eurotech@miranda.com

China
Telephone: +86 10 5873 1814
E-mail: asiatech@miranda.com

France
Office hours: 9:00 a.m. – 5:00 p.m. (GMT+1)
Telephone: +33 1 55 86 87 88
Fax: +33 1 55 86 00 29
E-mail: eurotech@miranda.com

EMERGENCY After Hours (Global)
Toll Free: 1-800-224-7882 (US and Canada)
Telephone: +1 514 333 1772
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